• Apple, Mac, Mac OS, MacBook, and iMac are trademarks of Apple Inc. registered in the U.S. and other countries.
• App Store is a service mark of Apple Inc.
• iOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license.
• Microsoft, Windows, Windows Vista, Internet Explorer, .NET Framework and PowerPoint are either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries.
• MicroSaver is a registered trademark of Kensington Computer Products Group, a division of ACCO Brands.
• Virtual Remote Tool uses WinI2C/DDC library, © Nicomsoft Ltd.
• The terms HDMI and HDMI High-Definition Multimedia Interface, and the HDMI Logo are trademarks or registered trademarks of HDMI Licensing LLC in the United States and other countries.
• HDBaseT™ is a trademark of HDBaseT Alliance.
• DLP is a trademark of Texas Instruments.
• Trademark PJLink is a trademark applied for trademark rights in Japan, the United States of America and other countries and areas.
• Wi-Fi®, Wi-Fi Alliance®, Wi-Fi Protected Access®, Wi-Fi Direct® are registered trademarks of the Wi-Fi Alliance®.
• WPA™, WPA2™, Wi-Fi Protected Setup™, Miracast™ are trademarks of the Wi-Fi Alliance®.
• Blu-ray is a trademark of Blu-ray Disc Association
• CRESTRON and ROOMVIEW are registered trademarks of Crestron Electronics, Inc. in the United States and other countries.
• Ethernet is either a registered trademark or trademark of Fuji Xerox Co., Ltd.
• Google Play and Android are trademarks of Google Inc.
• Other product names and company logos mentioned in this user's manual may be the trademarks or registered trademarks of their respective holders.
• GPL/LGPL Software Licenses
  The product includes software licensed under GNU General Public License (GPL), GNU Lesser General Public License (LGPL), and others.
  For more information on each software, see “readme.pdf” inside the “about GPL&LGPL” folder on the supplied CD-ROM.

NOTES
(1) The contents of this user's manual may not be reprinted in part or whole without permission.
(2) The contents of this user's manual are subject to change without notice.
(3) Great care has been taken in the preparation of this user's manual; however, should you notice any questionable points, errors or omissions, please contact us.
(4) Notwithstanding article (3), NEC will not be responsible for any claims on loss of profit or other matters deemed to result from using the Projector.
Important Information

Safety Cautions

Precautions
Please read this manual carefully before using your NEC projector and keep the manual handy for future reference.

CAUTION

To turn off main power, be sure to remove the plug from power outlet. The power outlet socket should be installed as near to the equipment as possible, and should be easily accessible.

CAUTION

TO PREVENT SHOCK, DO NOT OPEN THE CABINET. THERE ARE HIGH-VOLTAGE COMPONENTS INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

This symbol warns the user that uninsulated voltage within the unit may be sufficient to cause electrical shock. Therefore, it is dangerous to make any kind of contact with any part inside of the unit.

This symbol alerts the user that important information concerning the operation and maintenance of this unit has been provided. The information should be read carefully to avoid problems.

WARNING: TO PREVENT FIRE OR SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE. DO NOT USE THIS UNIT’S PLUG WITH AN EXTENSION CORD OR IN AN OUTLET UNLESS ALL THE PRONGS CAN BE FULLY INSERTED.

DOC Compliance Notice (for Canada only)
This Class B digital apparatus complies with Canadian ICES-003.

Machine Noise Information Regulation - 3. GPSGV,
The highest sound pressure level is less than 70 dB (A) in accordance with EN ISO 7779.

Disposing of your used product

EU-wide legislation as implemented in each Member State requires that used electrical and electronic products carrying the mark (left) must be disposed of separately from normal household waste. This includes projectors and their electrical accessories. When you dispose of such products, please follow the guidance of your local authority and/or ask the shop where you purchased the product.

After collecting the used products, they are reused and recycled in a proper way. This effort will help us reduce the wastes as well as the negative impact to the human health and the environment at the minimum level.

The mark on the electrical and electronic products only applies to the current European Union Member States.

For EU: The crossed-out wheeled bin implies that used batteries should not be put to the general household waste! There is a separate collection system for used batteries, to allow proper treatment and recycling in accordance with legislation.

According the EU directive 2006/66/EC, the battery can’t be disposed improperly. The battery shall be separated to collect by local service.
WARNING TO CALIFORNIA RESIDENTS:
Handling the cables supplied with this product will expose you to a chemical known to the State of California to cause birth defects or other reproductive harm. WASH HANDS AFTER HANDLING.

RF Interference (for USA only)

WARNING
The Federal Communications Commission does not allow any modifications or changes to the unit EXCEPT those specified by NEC Display Solutions of America, Inc. in this manual. Failure to comply with this government regulation could void your right to operate this equipment. This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation.
If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio / TV technician for help.

For UK only: In UK, a BS approved power cord with moulded plug has a Black (five Amps) fuse installed for use with this equipment. If a power cord is not supplied with this equipment please contact your supplier.

Important Safeguards
These safety instructions are to ensure the long life of your projector and to prevent fire and shock. Please read them carefully and heed all warnings.

⚠️ Installation

• Do not place the projector in the following conditions:
  - Outdoors
  - on an unstable cart, stand, or table.
  - near water, baths, or damp rooms.
  - in direct sunlight, near heaters, or heat radiating appliances.
  - in a dusty, smoky or steamy environment.
  - on a sheet of paper or cloth, rugs or carpets.
• Do not install and store the projector in the below circumstances. Failure to do so may cause of malfunction.
  - In powerful magnetic fields.
  - In corrosive gas environment.
• If you wish to have the projector installed on the ceiling:
  - Do not attempt to install the projector yourself.
  - The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk of bodily injury.
  - In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance with any local building codes.
  - Please consult your dealer for more information.
**WARNING**

- Do not cover the lens with the lens cap or equivalent while the projector is on. Doing so can lead to melting of the cap due to the heat emitted from the light output.

- Do not place any objects, which are easily affected by heat, in front of the projector lens. Doing so could lead to the object melting from the heat that is emitted from the light output.

- Do not spray flammable gas to get rid of dust and dirt that accumulate on the lens and the filters. Doing so could cause a fire.

---

**Place the projector in a horizontal position**

The tilt angle of the projector should not exceed 4 degrees, nor should the projector be installed in any way other than the desktop and ceiling mount, otherwise lamp life could decrease dramatically.

---

**Fire and Shock Precautions**

- Ensure that there is sufficient ventilation and that vents are unobstructed to prevent the build-up of heat inside your projector. Allow at least 4 inches (10cm) of space between your projector and a wall.

- Do not try to touch the exhaust vents on the right side (when seen from the front) as it can become heated while the projector is turned on and immediately after the projector is turned off. Parts of the projector may become temporarily heated if the projector is turned off with the POWER button. Use caution when picking up the projector.

- Prevent foreign objects such as paper clips and bits of paper from falling into your projector. Do not attempt to retrieve any objects that might fall into your projector. Do not insert any metal objects such as a wire or screwdriver into your projector. If something should fall into your projector, disconnect it immediately and have the object removed by a qualified service personnel.

- Do not place any objects on top of the projector.

- Do not touch the power plug during a thunderstorm. Doing so can cause electrical shock or fire.

- The projector is designed to operate on a power supply of 100-240V AC 50/60 Hz. Ensure that your power supply fits this requirement before attempting to use your projector.

- Do not look into the lens while the projector is on. Serious damage to your eyes could result.

- Keep any items such as magnifying glass out of the light path of the projector. The light being projected from the lens is extensive, therefore any kind of abnormal objects that can redirect light coming out of the lens, can cause unpredictable outcome such as fire or injury to the eyes.

- Do not place any objects, which are easily affected by heat, in front of a projector exhaust vent. Doing so could lead to the object melting or getting your hands burned from the heat that is emitted from the exhaust vent.
Important Information

- Do not splash water over the projector. Doing so can cause electrical shock or fire. If the projector gets wet, turn off the projector, unplug the power cord and have the projector serviced by a qualified service personnel.
- Handle the power cord carefully. A damaged or frayed power cord can cause electric shock or fire.
  - Do not use any power cord other than the one supplied with the projector.
  - Do not bend or tug the power cord excessively.
  - Do not place the power cord under the projector, or any heavy object.
  - Do not cover the power cord with other soft materials such as rugs.
  - Do not heat the power cord.
  - Do not handle the power plug with wet hands.
- Turn off the projector, unplug the power cord and have the projector serviced by a qualified service personnel under the following conditions:
  - When the power cord or plug is damaged or frayed.
  - If liquid has been spilled into the projector, or if it has been exposed to rain or water.
  - If the projector does not operate normally when you follow the instructions described in this user’s manual.
  - If the projector has been dropped or the cabinet has been damaged.
  - If the projector exhibits a distinct change in performance, indicating a need for service.
- Disconnect the power cord and any other cables before carrying the projector.
- Turn off the projector and unplug the power cord before cleaning the cabinet or replacing the lamp.
- Turn off the projector and unplug the power cord if the projector is not to be used for an extended period of time.
- When using a LAN cable:
  For safety, do not connect to the terminal for peripheral device wiring that might have excessive voltage.

⚠️ CAUTION
- Do not use the tilt-foot for purposes other than originally intended. Misuses such as gripping the tilt-foot or hanging on the wall can cause damage to the projector.
- Do not send the projector in the soft case by parcel delivery service or cargo shipment. The projector inside the soft case could be damaged.
- Select [HIGH] in Fan mode if you continue to use the projector for consecutive days. (From the menu, select [SETUP] → [OPTIONS(1)] → [FAN MODE] → [HIGH].)
- Do not turn off the AC power for 60 seconds after the lamp is turned on and while the POWER indicator is blinking blue. Doing so could cause premature lamp failure.

Remote Control Precautions
- Handle the remote control carefully.
- If the remote control gets wet, wipe it dry immediately.
- Avoid excessive heat and humidity.
- Do not short, heat, or take apart batteries.
- Do not throw batteries into fire.
- If you will not be using the remote control for a long time, remove the batteries.
- Ensure that you have the batteries' polarity (+/−) aligned correctly.
- Do not use new and old batteries together, or use different types of batteries together.
- Dispose of used batteries according to your local regulations.

Note for Canadian Environmental Protection Act, 1999
The lamp(s) in this product contains mercury. Please dispose according to your local authority law.

FOR MORE INFORMATION, CONTACT:
NEC Display Solutions of America, Inc.
500 Park Boulevard, Suite 1100, Itasca, Illinois 60143-1248
TELEPHONE 800-836-0655
www.necdisplay.com
Important Information

Note for US Residents
The lamp in this product contains mercury. Please dispose according to Local, State or Federal Laws.

Lamp Replacement

- Use the specified lamp for safety and performance.
- To replace the lamp, follow all instructions provided on page 118.
- Be sure to replace the lamp when the message [THE LAMP HAS REACHED THE END OF ITS USABLE LIFE. PLEASE REPLACE THE LAMP.] appears. If you continue to use the lamp after the lamp has reached the end of its usable life, the lamp bulb may shatter, and pieces of glass may be scattered in the lamp case. Do not touch them as the pieces of glass may cause injury.
- If this happens, contact your dealer for lamp replacement.

A Lamp Characteristic

The projector has a discharge lamp for special purposes as a light source. A lamp has a characteristic that its brightness gradually decreases with age. Also repeatedly turning the lamp on and off will increase the possibility of its lower brightness.

The actual lamp life may vary depending upon the individual lamp, the environmental conditions and usage.

⚠️ CAUTION:
- DO NOT TOUCH THE LAMP immediately after it has been used. It will be extremely hot. Turn the projector off and then disconnect the power cord. Allow at least one hour for the lamp to cool before handling.
- When removing the lamp from a ceiling-mounted projector, make sure that no one is under the projector. Glass fragments could fall if the lamp has been burned out.

About High Altitude mode

- Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 4000 feet/1200 meters or higher.
- Using the projector at altitudes approximately 4000 feet/1200 meters or higher without setting to [HIGH ALTITUDE] can cause the projector to overheat and the protector could shut down. If this happens, wait a couple minutes and turn on the projector.
- Using the projector at altitudes less than approximately 4000 feet/1200 meters and setting to [HIGH ALTITUDE] can cause the lamp to overcool, causing the image to flicker. Switch [FAN MODE] to [AUTO].
- Using the projector at altitudes approximately 4000 feet/1200 meters or higher can shorten the life of optical components such as the lamp.

About Copyright of original projected pictures:

Please note that using this projector for the purpose of commercial gain or the attraction of public attention in a venue such as a coffee shop or hotel and employing compression or expansion of the screen image with the following functions may raise concern about the infringement of copyrights which are protected by copyright law. [ASPECT RATIO], [KEYSTONE], Magnifying feature and other similar features.

Turkish RoHS information relevant for Turkish market

EEE Yönetmeliğine Uygundur.

This device is not intended for use in the direct field of view at visual display workplaces. To avoid incommoding reflections at visual display workplaces this device must not be placed in the direct field of view.
Important Information

Power management function
The projector has power management functions. To reduce power consumption, the power management functions (1 and 2) are factory preset as shown below. To control the projector from an external device via a LAN or serial cable connection, use the on-screen menu to change the settings for 1 and 2.

1. **STANDBY MODE (Factory preset: NORMAL)**
   To control the projector from an external device, select [NETWORK STANDBY] for [STANDBY MODE].

   **NOTE:**
   - When [NORMAL] is selected for [STANDBY MODE], the following terminals and functions will not work: MONITOR OUT terminal, AUDIO OUT terminal, LAN functions, Mail Alert function, DDC/CI (Virtual Remote Tool)

2. **AUTO POWER OFF (Factory preset: 60 min.)**
   To control the projector from an external device, select [OFF] for [AUTO POWER OFF].

   **NOTE:**
   - When [1:00] is selected for [AUTO POWER OFF], you can enable the projector to automatically turn off in 60 minutes if there is no signal received by any input or if no operation is performed.

**Health precautions to users viewing 3D images**
Before viewing, be sure to read health care precautions that may be found in the user’s manual included with your LCD shutter eyeglasses or your 3D compatible content such as DVDs, video games, computer’s video files and the like. To avoid any adverse symptoms, heed the following:

- Do not use LCD shutter eyeglasses for viewing any material other than 3D images.
- Allow a distance of 2 m/7 feet or greater between the screen and a user. Viewing 3D images from too close a distance can strain your eyes.
- Avoid viewing 3D images for a prolonged period of time. Take a break of 15 minutes or longer after every hour of viewing.
- If you or any member of your family has a history of light-sensitive seizures, consult a doctor before viewing 3D images.
- While viewing 3D images, if you get sick such as nausea, dizziness, queasiness, headache, eyestrain, blurry vision, convulsions, and numbness, stop viewing them. If symptoms still persist, consult a doctor.
- View 3D images from the front of the screen. Viewing from an angle may cause fatigue or eyestrain.

**Model Number of Wireless LAN unit**
Wireless LAN unit is an optional item.
To find the appropriate model to your area, please visit the company website:
# Table of Contents

## Important Information

1. **Introduction** ........................................................................................................................................... i

### 1. Introduction

1. What's in the Box? ................................................................................................................................. 1
2. Introduction to the Projector
   - General ........................................................................................................................................... 2
   - Installation......................................................................................................................................... 2
   - Videos .............................................................................................................................................. 2
   - Network ........................................................................................................................................... 2
   - Energy-saving ................................................................................................................................. 3
   - About this user's manual ................................................................................................................. 3
3. Part Names of the Projector
   - Front .............................................................................................................................................. 4
   - Mounting the lens cap strap ............................................................................................................. 4
   - Rear .................................................................................................................................................. 5
   - Controls/Indicators ........................................................................................................................... 6
   - Terminal Panel Features .................................................................................................................. 7
4. Part Names of the Remote Control
   - Battery Installation .......................................................................................................................... 8
   - Remote Control Precautions ........................................................................................................... 9
   - Operating Range for Wireless Remote Control ............................................................................... 9

## 2. Projecting an Image (Basic Operation)

1. Flow of Projecting an Image .................................................................................................................. 10
2. Connecting Your Computer/Connecting the Power Cord ................................................................... 11
3. Turning on the Projector
   - Note on Startup screen (Menu Language Select screen) .................................................................. 13
4. Selecting a Source
   - Selecting the computer or video source ........................................................................................... 14
5. Adjusting the Picture Size and Position
   - Adjusting the vertical position of a projected image (Lens shift) ....................................................... 17
   - Focus ............................................................................................................................................... 19
   - Zoom ................................................................................................................................................ 19
   - Adjusting the tilt (Tilt foot) ............................................................................................................. 20
6. Correcting Keystone Distortion [KEYSTONE] .................................................................................... 21
7. Optimizing Computer Signal Automatically
   - Adjusting the Image Using Auto Adjust ......................................................................................... 23
8. Turning Up or Down Volume ................................................................................................................ 23
9. Turning off the Projector ....................................................................................................................... 24
10. When Moving the Projector .................................................................................................................. 25

## 3. Convenient Features

1. Turning off the Image and Sound .......................................................................................................... 26
2. Freezing a Picture .................................................................................................................................. 26
3. Magnifying a Picture .............................................................................................................................. 27
4. Changing Eco Mode/Checking Energy-Saving Effect
   - Using Eco Mode [ECO MODE] ......................................................................................................... 28
   - Checking Energy-Saving Effect [CARBON METER] ....................................................................... 29
4. Using On-Screen Menu ................................................................. 37
   ① Using the Menus ........................................................................ 37
       Menu Elements ......................................................................... 38
   ② List of Menu Items .................................................................... 39
   ③ Menu Descriptions & Functions [SOURCE] ............................. 42
       HDMI1 and HDMI2 ................................................................. 42
       COMPUTER ............................................................................. 42
       VIDEO ...................................................................................... 42
       HDBaseT ................................................................................. 42
       APPS ......................................................................................... 42
   ④ Menu Descriptions & Functions [ADJUST] ............................... 43
       [PICTURE] .................................................................................. 43
       [IMAGE OPTIONS] .................................................................... 46
   ⑤ Menu Descriptions & Functions [SETUP] ................................. 50
       [GENERAL] ............................................................................. 50
       [MENU] ..................................................................................... 53
       [INSTALLATION] ...................................................................... 55
       [OPTIONS(1)] .......................................................................... 59
       [OPTIONS(2)] .......................................................................... 61
       [3D] ............................................................................................ 64
   ⑥ Menu Descriptions & Functions [INFO.] ................................. 66
       [USAGE TIME] .......................................................................... 66
       [SOURCE(1)] .......................................................................... 67
       [SOURCE(2)] .......................................................................... 67
       [HDBaseT] ............................................................................... 67
       [WIRED LAN] ........................................................................... 67
       [WIRELESS LAN] ...................................................................... 67
       [VERSION(1)] .......................................................................... 67
       [VERSION(2)] .......................................................................... 67
       [OTHERS] .................................................................................. 67
   ⑦ Menu Descriptions & Functions [RESET] ................................. 68
       Returning to Factory Default [RESET] ........................................ 68

5. Installation and Connections ....................................................... 69
   ① Setting Up the Screen and the Projector ................................ 69
       Tables of screen sizes and dimensions ..................................... 71
       Example of installation on a desktop ....................................... 72
       Lens shifting range ................................................................. 73
   ② Making Connections ............................................................... 75
       Connecting Your Computer ..................................................... 75
       Connecting an External Monitor .............................................. 77
       Connecting Your DVD Player or Other AV Equipment .......... 78
       Connecting Component Input ................................................ 79
       Connecting HDMI Input ......................................................... 80
Connecting your document camera ................................................................. 81
Connecting to a Wired LAN ................................................................. 82
Connecting to a Wireless LAN (Optional: NP05LM series) .............. 83
Connecting to a HDBaseT transmission device (sold commercially) ... 86

6. APPS MENU ......................................................................................... 88
   ❶ What can you do with the APPS MENU? ........................................ 88

7. User Supportware ............................................................................... 92
   ❶ Software Included on CD-ROM ......................................................... 92
   ❷ Projecting Your Computer’s Screen Image from the Projector over a LAN (Image
       Express Utility Lite) ................................................................. 93
       Starting Image Express Utility Lite from a USB Memory or SD Card ...... 96
   ❸ Projecting an Image from an Angle (Geometric Correction Tool in Image Express
       Utility Lite) ............................................................................... 98
       What you can do with GCT ....................................................... 98
       Projecting an Image from an Angle (GCT) .................................. 98
   ❹ Controlling the Projector over a LAN (PC Control Utility Pro 4/Pro 5) .... 101
   ❼ Using the Computer Cable (VGA) to Operate the Projector (Virtual Remote Tool) ... 106
   ❽ Projecting photos or documents saved on the smartphone over a wireless LAN
       (Wireless Image Utility) ............................................................ 112

8. Maintenance ......................................................................................... 113
   ❶ Cleaning the Filters ....................................................................... 113
   ❷ Cleaning the Lens ......................................................................... 116
   ❸ Cleaning the Cabinet ...................................................................... 117
   ❹ Replacing the Lamp and the Filters ................................................ 118

9. Appendix ............................................................................................... 125
   ❶ Troubleshooting ............................................................................ 125
       Indicator Messages ..................................................................... 125
       Common Problems & Solutions .................................................. 127
       If there is no picture, or the picture is not displayed correctly ....... 128
   ❷ Specifications ............................................................................... 129
   ❸ Cabinet Dimensions .................................................................... 131
   ❹ Attaching the Optional Cable Cover (NP09CV) ................................ 132
       Attaching the cable cover ......................................................... 132
       Removing the cable cover ....................................................... 133
   ❺ Pin assignments and signal names of main terminals .................... 134
   ❻ Compatible Input Signal List ......................................................... 136
   ❼ PC Control Codes and Cable Connection ........................................ 137
   ❽ Update the Software .................................................................... 138
   ❾ Troubleshooting Check List ............................................................ 140
   ❿ REGISTER YOUR PROJECTOR! (for residents in the United States, Canada, and
       Mexico) ...................................................................................... 142
1. Introduction

What’s in the Box?
Make sure your box contains everything listed. If any pieces are missing, contact your dealer. Please save the original box and packing materials if you ever need to ship your projector.

Projector

Remote control (7N901122)

Batteries (AAA x 2)

Power cord (US: 7N080240/7N080243) (EU: 7N080027/7N080029)

Computer cable (VGA) (7N520089)

Lens cap strap

- Important Information (7N8N6981)
- Quick Setup Guide (7N8N6991)

NEC Projector CD-ROM
User’s manual (PDF) and the utility software (7N952322)

For North America only
Limited warranty
For customers in Europe:
You will find our current valid Guarantee Policy on our Web Site: www.nec-display-solutions.com
Introduction to the Projector

This section introduces you to your new projector and describes the features and controls.

General

- Single-chip DLP projector with high resolution and high brightness

<table>
<thead>
<tr>
<th>Model name</th>
<th>DMD panel</th>
<th>Resolution</th>
<th>Aspect ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>P502H/P452H</td>
<td>0.65 type</td>
<td>1920 x 1080 pixels</td>
<td>16:9</td>
</tr>
<tr>
<td>P502W/P452W</td>
<td>0.65 type</td>
<td>1280 x 800 pixels</td>
<td>16:10</td>
</tr>
</tbody>
</table>

- Lamp life up to 5000 hours

Using in Eco Mode allows you to prolong the projector’s lamp life up to 5000 hours (up to 3000 hours in ECO MODE OFF).

- 20 W built-in speaker for an integrated audio solution /mic input supported

Powerful 20 watt monaural speaker provides volume need for large rooms a dynamic or condenser mic can be used.

Installation

- Lens shift mechanism for adjusting the position of the projected image easily

The position of the projected image is moved by turning the two dials on the projector cabinet top, one for the vertical direction and another for the horizontal direction.

Videos

- Wide range of input terminals (HDMI × 2, HDBaseT, etc.)

The projector is equipped with a variety of input terminals: HDMI (× 2), Computer (analog), Video, HDBaseT, etc. HDMI input terminal on this product supports HDCP. HDBaseT is a connection standard for home appliances that is established by the HDBaseT Alliance.

- Supports HDMI 3D format

This projector can be used to watch videos in 3D using commercially-available active shutter-type 3D eyewear and 3D emitters that support Xpand 3D.

Network

- Equips the feature of APPS MENU that can utilize the network.

The APPS MENU provides various functions as VIEWER, REMOTE DESKTOP CONNECTION, IMAGE EXPRESS UTILITY, Miracast, NETWORK SETTINGS (Wired LAN/Wireless LAN), and PROGRAM TIMER.

- Convenient utility software (User Supportware) provided as standard

The five utility software stored in the enclosed NEC Projector CD-ROM (Image Express Utility Lite (For Windows/OS X), Virtual Remote Tool, PC Control Utility Pro 4 (for Windows) and PC Control Utility Pro 5 (for OS X)) can be used.

- CRESTRON ROOMVIEW compatible

This projector supports CRESTRON ROOMVIEW, allowing multiple devices connected to the network to be managed from a computer or controller.
Energy-saving

- 0.26 W (100-130 V AC)/0.33 W (200-240 V AC) in standby condition with energy saving technology
  Selecting [NORMAL] for [STANDBY MODE] from the menu can put the projector in power-saving mode.
  NORMAL: 0.26 W (100-130 V AC)/0.33 W (200-240 V AC)
  NETWORK STANDBY: 2.7 W (100-130 V AC)/2.7 W (200-240 V AC)

- “ECO MODE” for low power consumption and “CARBON METER” display
  The power-saving is effective when the [ECO MODE] is set is converted into the amount of reductions of CO₂ emissions and this is indicated on the confirmation message displayed when the power is turned off and at [INFO.] on the on-screen menu (CARBON METER).

About this user’s manual

The fastest way to get started is to take your time and do everything right the first time. Take a few minutes now to review the user’s manual. This may save you time later on. At the beginning of each section of the manual you’ll find an overview. If the section doesn’t apply, you can skip it.
Part Names of the Projector

Front

Mounting the lens cap strap

1. Insert the tip of the strap into the lens cap mount hole and pass the knot through.

2. Insert the knot into the strap mount hole (large) on the bottom of the projector, then press it into the narrow (small) hole.
1. Introduction

Rear

- Remote Sensor (→ page 9)
- Connection for cable cover (Left/Right) Screw holes (→ page 132)
- Terminals (→ page 7)
- AC Input
  - Connect the supplied power cord's three-pin plug here, and plug the other end into an active wall outlet. (→ page 11)
- Monaural Speaker
- Intake Vent (→ page 113)
- Indicators (→ page 6)
- Controls (→ page 6)
- Built-in Security Slot ( )*  
  - Attach an anti-theft device. The security chain opening accepts security wires or chains up to 0.18 inch/4.6 mm in diameter.
- Intake Vent Filter (→ page 113, 123)

* This security slot supports the MicroSaver® Security System.
**Controls/Indicators**

1. **POWER** Button  
   (→ page 12, 24)

2. **POWER** Indicator  
   (→ page 11, 12, 24, 125)

3. **STATUS** Indicator  
   (→ page 125)

4. **LAMP** Indicator  
   (→ page 125)

5. **ECO** Button  
   (→ page 28)

6. **SOURCE** Button  
   (→ page 14)

7. **AUTO ADJ.** Button  
   (→ page 23)

8. **MENU** Button  
   (→ page 37)

9. ▲▼◀▶ / Volume Buttons ◄► / Keystone Button ◄  
   (→ page 13, 21, 23, 37)

10. **ENTER** Button  
    (→ page 37)

11. **EXIT** Button  
    (→ page 37)
Terminal Panel Features

1. COMPUTER IN/ Component Input Terminal (Mini D-Sub 15 Pin)  
   (→ page 75, 79, 81)
2. COMPUTER AUDIO IN Mini Jack (Stereo Mini)  
   (→ page 75, 79)
3. HDMI 1 IN Terminal (Type A)  
   (→ page 75, 76, 80)
4. HDMI 2 IN Terminal (Type A)  
   (→ page 75, 76, 80)
5. MONITOR OUT (COMP.) Terminal (Mini D-Sub 15 Pin)  
   (→ page 77)
6. AUDIO OUT Mini Jack (Stereo Mini)  
   (→ page 77)
7. VIDEO IN Terminal (RCA)  
   (→ page 78, 81)
8. VIDEO AUDIO IN L/MONO, R (RCA)  
   (→ page 78)
9. Ethernet/HDBaseT Port (RJ-45)  
   (→ page 82, 86)
10. LAN Port (RJ-45)  
    (→ page 82, 87)
11. USB (Wireless LAN) Port  
    (→ page 85)
12. USB Port (Type A)  
    (→ page 89)
13. 3D SYNC Terminal (Mini DIN 3 Pin)  
    (→ page 35)
14. PC CONTROL [PC CONTROL] Port (D-Sub 9 Pin)  
    (→ page 137)  
    Use this port to connect a PC or control system.  
    This enables you to control the projector using 
    serial communication protocol. If you are writing your 
    own program, typical PC control codes are on page 137.
15. SERVICE Port (USB Type B)  
    (for service purpose only)
16. REMOTE Connector (Stereo Mini)  
    Use this connector for wired remote control of the 
    projector using the NEC remote control for PX750U/ 
    PH1000U/PH1400U/PX602UL/PH1202HL series.  
    Connect the projector and optional remote control 
    using a commercially available wired remote control 
    cable.

NOTE:
- When a remote control cable is connected to the REMOTE 
  connector, infrared remote control operations cannot be 
  performed.
- When [HDBaseT] is selected in the [REMOTE SENSOR] 
  and the projector is connected to a commercially-available 
  transmission device that supports HDBaseT, remote control 
  operations in infra-red cannot be carried out if transmission 
  of remote control signals has been set up in the transmission 
  device. However, remote control using infrared rays can be 
  carried out when the power supply of the transmission device 
  is switched off.
1. Infrared Transmitter
   (→ page 9)
2. POWER ON Button
   (→ page 12)
3. POWER STANDBY Button
   (→ page 24)
4. SOURCE Button
   (→ page 14)
5. COMPUTER 1 Button
   (→ page 14)
6. COMPUTER 2 Button
   (This button does not work in this series of projectors)
7. AUTO ADJ. Button
   (→ page 23)
8. HDMI 1 Button
   (→ page 14)
9. HDMI 2 Button
   (→ page 14)
10. DisplayPort Button
    (This button does not work in this series of projectors)
11. VIDEO Button
    (→ page 14)
12. HDBaseT Button
    (→ page 14)
13. USB-B Button
    (This button does not work in this series of projectors)
14. APPS Button
    (→ page 14, 88)
15. ID SET Button
    (→ page 57)
16. Numeric Keypad Button/
    CLEAR Button
    (→ page 57)
17. FREEZE Button
    (→ page 26)
18. AV-MUTE Button
    (→ page 26)
19. MENU Button
    (→ page 37)
20. EXIT Button
    (→ page 37)
21. ▲▼◀▶ Button
    (→ page 37)
22. ENTER Button
    (→ page 37)
23. D-ZOOM (+)(–) Button
    (→ page 27)
24. MOUSE L-CLICK Button*
    (This button does not work in this series of projectors)
25. MOUSE R-CLICK Button*
    (This button does not work in this series of projectors)
26. PAGE ▽△ Button
    (→ page 89)
27. ECO Button
    (→ page 28)
28. KEYSTONE Button
    (→ page 21)
29. PICTURE Button
    (→ page 43, 45)
30. VOL. (+)(–) Button
    (→ page 23)
31. ASPECT Button
    (→ page 48)
32. FOCUS/ZOOM Button
    (This button does not work in this series of projectors)
33. HELP Button
    (→ page 66)
Battery Installation
1. Press firmly and slide the battery cover off.
2. Install new batteries (AAA). Ensure that you have the batteries’ polarity (+/−) aligned correctly.
3. Slip the cover back over the batteries until it snaps into place. Do not mix different types of batteries or new and old batteries.

Remote Control Precautions
• Handle the remote control carefully.
• If the remote control gets wet, wipe it dry immediately.
• Avoid excessive heat and humidity.
• Do not short, heat, or take apart batteries.
• Do not throw batteries into fire.
• If you will not be using the remote control for a long time, remove the batteries.
• Ensure that you have the batteries’ polarity (+/−) aligned correctly.
• Do not use new and old batteries together, or use different types of batteries together.
• Dispose used batteries according to your local regulations.

Operating Range for Wireless Remote Control

• The infrared signal operates by line-of-sight up to a distance of about 23 feet/7 m and within a 60-degree angle of the remote sensor on the projector cabinet.
• The projector will not respond if there are objects between the remote control and the sensor, or if strong light falls on the sensor. Weak batteries will also prevent the remote control from properly operating the projector.
2. Projecting an Image (Basic Operation)

This section describes how to turn on the projector and to project a picture onto the screen.

1. Flow of Projecting an Image

Step 1
• Connecting your computer / Connecting the power cord (→ page 11)

Step 2
• Turning on the projector (→ page 12)

Step 3
• Selecting a source (→ page 14)

Step 4
• Adjusting the picture size and position (→ page 16)
• Correcting keystone distortion [KEYSTONE] (→ page 21)

Step 5
• Adjusting a picture and sound
  - Optimizing a computer signal automatically (→ page 23)
  - Turning up or down volume (→ page 23)

Step 6
• Making a presentation

Step 7
• Turning off the projector (→ page 24)

Step 8
• When Moving the Projector (→ page 25)
2. Projecting an Image (Basic Operation)

2 Connecting Your Computer/Connecting the Power Cord

1. **Connect your computer to the projector.**
   
   This section will show you a basic connection to a computer. For information about other connections, see “5. Installation and Connections” on page 69.

   Connect the computer cable (VGA) between the projector’s COMPUTER IN terminal and the computer’s port (mini D-Sub 15 Pin). Turn two thumb screws of both terminals to fix the computer cable (VGA).

2. **Connect the supplied power cord to the projector.**

   First connect the supplied power cord’s three-pin plug to the AC IN of the projector, and then connect the other plug of the supplied power cord in the wall outlet.

   The projector’s power indicator will flash for a few seconds and then will light red* (standby mode).

   * This will apply for both indicators when [NORMAL] is selected for [STANDBY MODE]. See the Power Indicator section. (→ page 125)

   ![Diagram of connecting computer and power cord](image)

   - **To wall outlet ←**
   - **Make sure that the prongs are fully inserted into both the AC IN and the wall outlet.**

---

**CAUTION:**
Parts of the projector may become temporarily heated if the projector is turned off with the POWER button. Be careful to handle the projector.
3 Turning on the Projector

1. Remove the lens cap.
   With the lens cap’s stopper pressed up, pull forward and off.

2. Press the (POWER) button on the projector cabinet or the POWER ON button on the remote control.
   The POWER indicator lights blue and the image is projected on the screen.
   TIP:
   • When the message “PROJECTOR IS LOCKED! ENTER YOUR PASSWORD.” is displayed, it means that the [SECURITY] feature is turned on. (→ page 31)

After you turn on your projector, ensure that the computer or video source is turned on.

NOTE: When no input signal is present, the no-signal guidance is displayed (factory menu setting).

(→ page 125)
2. Projecting an Image (Basic Operation)

Note on Startup screen (Menu Language Select screen)
When you first turn on the projector, you will get the Startup menu. This menu gives you the opportunity to select one of the 30 menu languages.

To select a menu language, follow these steps:

1. Use the ▲, ▼, ◀ or ▶ button to select one of the 30 languages from the menu.

2. Press the ENTER button to execute the selection.

After this has been done, you can proceed to the menu operation.
If you want, you can select the menu language later.  
(→ [LANGUAGE] on page 39 and 52)

NOTE:
• Keep the lens cap off the lens while the projector’s power is on.
  If the lens cap is on, it could be warped due to high temperature.
• If one of the following things happens, the projector will not turn on.
  - If the internal temperature of the projector is too high, the projector detects abnormal high temperature. In this condition the projector will not be turned to protect the internal system. If this happens, wait for the projector’s internal components to cool down.
  - When the lamp reaches its end of usable life, the projector will not turn on. If this happens, replace the lamp.
  - If the STATUS indicator lights orange with the power button pressed, it means that the [CONTROL PANEL LOCK] is turned on. Cancel the lock by turning it off. (→ page 55)
  - If the lamp fails to light, and if the LAMP indicator flashes on and off in a cycle of six times, wait a full minute and then turn on the power.
• While the POWER indicator is blinking blue in short cycles, the power cannot be turned off by using the power button.
• Immediately after turning on the projector, screen flicker may occur. This is normal. Wait 3 to 5 minutes until the lamp lighting is stabilized.
• When the projector is turned on, it may take some time before the lamp light becomes bright.
• If you turn on the projector immediately after the lamp is turned off or when the temperature is high, the fans run without displaying an image for some time and then the projector will display the image.
2. Projecting an Image (Basic Operation)

4 Selecting a Source

Selecting the computer or video source

NOTE: Turn on the computer or video source equipment connected to the projector.

Detecting the Signal Automatically

Press the SOURCE button once. The projector will search for the available input source and display it. The input source will change as follows:

[HDMI1] → [HDMI2] → [COMPUTER] → [VIDEO] → [HDBaseT] → [APPS]

- With the SOURCE screen displayed, you can press the SOURCE button a few times to select the input source.

TIP: If no input signal is present, the input will be skipped.

Using the Remote Control

Press any one of the COMPUTER 1, HDMI1, HDMI2, VIDEO, HDBaseT, or APPS buttons.
Selecting Default Source
You can so that it will be displayed each time the projector is turned on.

1. **Press the MENU button.**
   The menu will be displayed.

2. **Press the ▶ button twice to select [SETUP] and the ▼ button or the ENTER button to select [GENERAL].**

3. **Press the ▶ button four times to select [OPTIONS(2)].**

4. **Press the ▼ button five times to select [DEFAULT SOURCE SELECT] and press the ENTER button.**

   ![Menu Screen]

   The [DEFAULT SOURCE SELECT] screen will be displayed.
   (→ page 63)

5. **Select a source as the default source, and press the ENTER button.**

6. **Press the EXIT button a few times to close the menu.**

7. **Restart the projector.**
   The source you selected in step 5 will be projected.

**TIP:**
- When the projector and computer are connected and the projector is in standby, it is possible to turn on the projector’s power and project the computer’s screen automatically by detecting the computer signals or HDMI signals issued from the computer. ([AUTO POWER ON] → page 62)
- On Windows notebook computer, it can switch to enable/disable the external output by the combination of Fn key and one of function key.
## Adjusting the Picture Size and Position

Use the lens shift dial, the adjustable tilt foot lever, the zoom lever/zoom ring and the focus ring to adjust the picture size and position.  
*In this chapter drawings and cables are omitted for clarity.*

<table>
<thead>
<tr>
<th>Adjusting the projected image’s vertical and horizontal position [Lens shift]</th>
<th>Adjusting the focus [Focus ring]</th>
</tr>
</thead>
<tbody>
<tr>
<td>(→ page 17)</td>
<td>(→ page 19)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Finely adjusting the size of an image [Zoom lever]</th>
<th>Adjusting the projected image’s height and horizontal tilt [Tilt foot]</th>
</tr>
</thead>
<tbody>
<tr>
<td>(→ page 19)</td>
<td>(→ page 20)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Correcting the keystone distortion [Keystone]</th>
</tr>
</thead>
<tbody>
<tr>
<td>(→ page 21)</td>
</tr>
</tbody>
</table>
CAUTION
Perform the adjustment from behind or from the side of the projector. Adjusting from the front could expose your eyes to strong light which could injure them.

1. Turn the lens shift dials clockwise or counterclockwise.
   Vertical dial
   Turn this clockwise or counterclockwise to adjust the projection position in the vertical direction.
   Horizontal dial
   Turn this clockwise or counterclockwise to adjust the projection position in the horizontal direction.

NOTE:
- The dials can be turned more than one full turn, but the projection position cannot be moved more than the range indicated on the following page. Do not force to turn the dials. Doing so may damage the dials.
- If the lens is shifted to the maximum in the diagonal direction, the edges of the screen will be dark or shaded.
- The vertical shift adjustment must be finished with an image shifted upward. If you finish the vertical shift adjustment with an image shifted down, the zoom/focus adjustments or strong shaking may cause a projected image to slightly shift down.
TIP:
- The diagram below shows the lens shift adjustment range ([ORIENTATION]: [DESKTOP FRONT]).
- For the lens shift adjustment range regarding the [CEILING FRONT] projection, see page 73.

[P502H/P452H]

Description of symbols: V indicates vertical (height of the projected image), H indicates horizontal (width of the projected image).
Focus
Use the FOCUS ring to obtain the best focus.

**NOTE:**
- Recommend to perform the focus adjustment after leaving the projector under the state the TEST PATTERN has been projected for over 30 minutes. Please refer page 58 about the TEST PATTERN.

Zoom
Turn the zoom lever clockwise and counterclockwise.
2. Projecting an Image (Basic Operation)

Adjusting the tilt (Tilt foot)

Adjusting the left and right tilt.

1. **Turn the left and right tilt feet to adjust.**

   The tilt feet lengthen and shorten when turned.
   The height of the projected image is adjusted by turning the left and right tilt feet.
   If the projected image is tilted, turn one of the tilt feet to adjust the image so that it is level.
   - If the projected image is distorted, see “6 Correcting Keystone Distortion [KEYSTONE]” (→ page 21).
   - The tilt feet can be lengthened by a maximum of 18 mm.
   - The tilt feet can be used to tilt the projector by a maximum of 4°.

---

**NOTE:**

- Do not use the tilt feet for any purpose other than adjusting the projector’s projection angle.
- Handling the tilt feet improperly, such as carrying the projector by grasping the tilt foot or hooking it onto a wall using the tilt feet, could damage the projector.
Correcting Keystone Distortion [KEYSTONE]

When the projector is not exactly perpendicular to the screen, keystone distortion occurs. To overcome it, you can use the “Keystone” function, a digital technology that can adjust for keystone-type distortion, resulting in a crisp, square image. The following procedure explains how to use the [KEYSTONE] screen from the menu to correct trapezoidal distortions.

When the projector is placed diagonally to the screen,
When the projector is set up at an angle in relation to the screen, adjust the Horizontal option of the Keystone menu so that the top and bottom of sides of the projected image are parallel.

1. When APPS is not selected as source and the menu is not displayed on, press the ▼ button on the projector cabinet.
   The Keystone screen will be displayed on the screen.
   • Press the KEYSTONE button when using the remote control.
   • See page 22 for [RESET].

2. Press the ▼ button to select [VERTICAL] and then use the ◀ or▶ so that the left and right sides of the projected image are parallel.
   * Adjust the vertical keystone distortion.

3. Align the left (or right) side of the screen with the left (or right) side of the projected image.
   • Use the shorter side of the projected image as the base.
   • In the right example, use the left side as the base.
4. **Press the ▲ button to select [HORIZONTAL] and then use the ◄ or ► so that the top and bottom sides of the projected image are parallel.**
   - Adjust the horizontal keystone distortion.

5. **Repeat steps 2 and 4 to correct keystone distortion.**

6. **After completing Keystone correction, press the EXIT button.**
   The Keystone screen will disappear.
   - To perform Keystone correction again, press the ▼ button to display the Keystone screen and repeat above steps 1 to 6.

To return the keystone adjustments to default:

1. **Press the ▼ button to select [RESET] and press the ENTER button.**

2. **Press the ◄ or ► button to select [YES] and press the ENTER button.**

   The adjustments will be reset.
   - When resetting, the [HORIZONTAL] and [VERTICAL] adjustment values are also reset.
   - The KEYSTONE feature can cause an image to be slightly blurred because the correction is made electronically.
7 Optimizing Computer Signal Automatically

Adjusting the Image Using Auto Adjust

Optimizing a computer image automatically. (COMPUTER)

Press the AUTO ADJ. button to optimize a computer image automatically.
This adjustment may be necessary when you connect your computer for the first time.

[Poor picture]  [Normal picture]

NOTE:
Some signals may take time to display or may not be displayed correctly.
• If the Auto Adjust operation cannot optimize the computer signal, try to adjust [HORIZONTAL], [VERTICAL], [CLOCK], and [PHASE] manually. (→ page 46, 47)

8 Turning Up or Down Volume

Sound level from the speaker or audio output can be adjusted.

TIP: When no menus appear, the ◀ and ▶ buttons on the projector cabinet work as a volume control.

NOTE:
• Volume control is not available with the ◀ or ▶ button when an image is magnified by using the D-ZOOM (+) button, when the menu is displayed, or when the APPS is displayed.

TIP: The [BEEP] sound volume cannot be adjusted. To turn off the [BEEP] sound, from the menu, select [SETUP] → [OPTIONS (1)] → [BEEP] → [OFF].
2. Projecting an Image (Basic Operation)

9 Turning off the Projector

To turn off the projector:

1. **First, press the (POWER) button on the projector cabinet or the STANDBY button on the remote control.**
   
   The confirmation message will be displayed.
   
   • The confirmation message displayed when the power is turned off indicates the amount of CO₂ reduction this session and lamp life remaining (→ page 29).

2. **Secondly, press the ENTER button or press the (POWER) or the STANDBY button again.**
   
   The lamp and the power are turned off and the cooling fan stops to rotate, the projector goes into the STANDBY MODE. When in standby mode, the POWER indicator will light red and the STATUS indicator will turn off when [NORMA XL] is selected for [STANDBY MODE].

3. **Mount the lens cap.**
   
   Put the top side of the lens cap to the right position on the cabinet and push in the bottom side. The stopper is secured to the projector.

   ![](image)

   **CAUTION:**
   
   Parts of the projector may become temporarily heated if the projector is turned off with the POWER button. Be careful to handle the projector.

   **NOTE:**
   
   • While the POWER indicator is blinking blue in short cycles, the power cannot be turned off by using the power button.
   
   • You cannot run off the power for 60 seconds immediately after turning it on and displaying an image.
   
   • Wait for about 10 seconds to turn off the power after making adjustment or change on each setting and close its menu. If the power is turned off during this period, the adjustment and change may be reset at default setting.
   
   • Do not disconnect the power cord while the cooling fan remains to rotate. It may be cause of malfunction.
When Moving the Projector
Preparation: Make sure that the projector is turned off.

1. If the separately sold cable cover is mounted, remove it.
   (→ page 132)

2. Unplug the power cord.

3. Disconnect any other cables.
   - Remove the USB memory if it is inserted into the projector.
3. Convenient Features

1 Turning off the Image and Sound
Press the AV-MUTE button to turn off the image and sound for a short period of time. Press again to restore the image and sound.

NOTE:
- Even though the image is turned off, the menu still remains on the screen.

2 Freezing a Picture
Press the FREEZE button. If the image of a DVD player, etc., is being projected, the video switches to a still image. Press the FREEZE button again to resume the video.

NOTE: The image is frozen but the original video is still playing back.
3 Magnifying a Picture

You can enlarge the picture up to four times.

NOTE:
• The maximum magnification may be less than four times depending on the signal.

To do so:

1. Press the D-ZOOM (+) button to magnify the picture.
   To move the magnified image, use the ▲,▼,◀ or ▶ button.

2. Press the ▲▼◀▶ button.
   The area of the magnified image will be moved

3. Press the D-ZOOM (−) button.
   Each time the D-ZOOM (−) button is pressed, the image is reduced.

NOTE:
• The image will be magnified or demagnified at the center of the screen.
• Displaying the menu will cancel the current magnification.
3. Convenient Features

4. Changing Eco Mode/Checking Energy-Saving Effect

Using Eco Mode [ECO MODE]

The ECO MODE (NORMAL and ECO) increases lamp life, while lowering power consumption and cutting down on CO₂ emissions.

Four brightness modes of the lamp can be selected: [OFF], [AUTO ECO], [NORMAL] and [ECO] modes.

<table>
<thead>
<tr>
<th>[ECO MODE]</th>
<th>Description</th>
<th>Status of LAMP indicator</th>
</tr>
</thead>
<tbody>
<tr>
<td>[OFF]</td>
<td>The lamp brightness is 100%.</td>
<td><img src="image" alt="Off" /></td>
</tr>
<tr>
<td>[AUTO ECO]</td>
<td>Lamp power consumption will be controlled between [OFF] and [ECO] automatically according to picture level. NOTE: A bright gradation may be less visible depending on the image.</td>
<td><img src="image" alt="Steady Green light" /></td>
</tr>
<tr>
<td>[NORMAL]</td>
<td>Lamp power consumption. (approx. 80% brightness) The lamp life will extend by lowering the lamp power.</td>
<td><img src="image" alt="Steady Green light" /></td>
</tr>
<tr>
<td>[ECO]</td>
<td>Lamp power consumption (approx. 60% brightness). The lamp life will extend longer than the one on NORMAL mode by controlling power appropriate for the lamp. The maximum power becomes equivalent to the power in NORMAL.</td>
<td><img src="image" alt="Steady Green light" /></td>
</tr>
</tbody>
</table>

To turn on the [ECO MODE], do the following:

1. Press the ECO Button on the remote control to display [ECO MODE] screen.
2. Press the ECO button again to select a mode you wish.
   - Each time the ECO button is pressed, the choices will be changed:
     
     OFF → AUTO ECO → NORMAL → ECO → OFF

TIP:
- The leaf symbol at the bottom of the menu shows the current selection of ECO mode.

NOTE:
- The ECO MODE and DYNAMIC CONTRAST features control the lamp power. Some pictures may become extremely bright when using both ECO MODE and DYNAMIC CONTRAST features to control the lamp power. To avoid this phenomena, turn off the ECO MODE and DYNAMIC CONTRAST.
- Immediately after the menu item is selected for [ECO MODE], the screen may flicker. This is not malfunction.
- Using the projector in the [AUTO ECO], [NORMAL], or [ECO] mode for [ECO MODE] may cause poor halftones depending on the projected image.
- When [ECO] has been set for [ECO MODE], the fan noise may change in a certain cycle.
- The [ECO MODE] can be changed by using the menu.
  Select [SETUP] → [GENERAL] → [ECO MODE].
- The lamp life remaining and lamp hours used can be checked in [USAGE TIME]. Select [INFO.] → [USAGE TIME].
- The projector is always in [NORMAL] for 90 seconds after the lamp is turned on and while the POWER indicator is blinking green. The lamp condition will not be affected even when [ECO MODE] is changed.
- After a lapse of 1 minute from when the projector displays no-signal guidance, a blue, black or logo screen, [ECO MODE] will automatically switch to [ECO].
- If the projector is overheated in [OFF] mode, there may be a case where the [ECO MODE] automatically changes to [NORMAL] mode to protect the projector. When the projector is in [NORMAL] mode, the picture brightness decreases. When the projector comes back to normal temperature, the [ECO MODE] returns to [OFF] mode.
- Thermometer symbol [ ] indicates the [ECO MODE] is automatically set to [NORMAL] mode because the internal temperature is too high.
3. Convenient Features

Checking Energy-Saving Effect [CARBON METER]

This feature will show energy-saving effect in terms of CO₂ emission reduction (kg) when the projector’s [ECO MODE] is set. This feature is called as [CARBON METER].

There are two messages: [TOTAL CARBON SAVINGS] and [CARBON SAVINGS-SESSION]. The [TOTAL CARBON SAVINGS] message shows the total amount of CO₂ emission reduction from the time of shipment up to now. You can check the information on [USAGE TIME] from [INFO.] of the menu. (→ page 66)

The [CARBON SAVINGS-SESSION] message shows the amount of CO₂ emission reduction between the time of changing to ECO MODE immediately after the time of power-on and the time of power-off. The [CARBON SAVINGS-SESSION] message will be displayed in the [POWER OFF/ ARE YOU SURE?] message at the time of power-off.

TIP:
• The formula as shown below is used to calculate the amount of CO₂ emission reduction.

Amount of CO₂ emission reduction = (Power consumption in [OFF] for [ECO MODE] – Power consumption in [ECO MODE]) × CO₂ conversion factor.* When the image is turned off with the AV-MUTE button, the amount of CO₂ emission reduction will also increase.

* Calculation for amount of CO₂ emission reduction is based on an OECD publication “CO₂ Emissions from Fuel Combustion, 2008 Edition”.
• The [TOTAL CARBON SAVINGS] is calculated based on savings recorded in 15 minutes intervals.
• This formula will not apply to the power consumption which is not affected by whether [ECO MODE] is turned on or off.
3. Convenient Features

5 Preventing the Unauthorized Use of the Projector [SECURITY]

A keyword can be set for your projector using the Menu to avoid operation by an unauthorized user. When a keyword is set, turning on the projector will display the Keyword input screen. Unless the correct keyword is entered, the projector cannot project an image.

- The [SECURITY] setting cannot be cancelled by using the [RESET] of the menu.

To enable the Security function:

1. **Press the MENU button.**
   The menu will be displayed.
2. **Press the ► button twice to select [SETUP] and press the ▼ button or the ENTER button to select [GENERAL].**
3. **Press the ► button to select [INSTALLATION].**
4. **Press the ▼ button three times to select [SECURITY] and press the ENTER button.**

![Menu Screen]

The OFF/ON menu will be displayed.

5. **Press the ▼ button to select [ON] and press the ENTER button.**

![Security Setting]

The [SECURITY KEYWORD] screen will be displayed.

6. **Type in a combination of the four ▲▼◀▶ buttons and press the ENTER button.**

   **NOTE:** A keyword must be 4 to 10 digits in length.

![Keyword Input]

The [CONFIRM KEYWORD] screen will be displayed.
3. Convenient Features

7. Type in the same combination of ▲▼◀▶ buttons and press the ENTER button.

8. Select [YES] and press the ENTER button.

To turn on the projector when [SECURITY] is enabled:

1. **Press the POWER button.**
   The projector will be turned on and display a message to the effect that the projector is locked.

2. **Press the MENU button.**

3. **Type in the correct keyword and press the ENTER button.** The projector will display an image.

**NOTE:** The security disable mode is maintained until the main power is turned off or unplugging the power cord.
To disable the SECURITY function:

1. **Press the MENU button.**
   The menu will be displayed.

2. **Select [SETUP] → [INSTALLATION] → [SECURITY] and press the ENTER button.**

   ![Menu screenshot](image)

   The OFF/ON menu will be displayed.

3. **Select [OFF] and press the ENTER button.**

   ![Security OFF menu screenshot](image)

   The SECURITY KEYWORD screen will be displayed.

4. **Type in your keyword and press the ENTER button.**
   When the correct keyword is entered, the SECURITY function will be disabled.

   **NOTE:** If you forget your keyword, contact your dealer. Your dealer will provide you with your keyword in exchange for your request code. Your request code is displayed in the Keyword Confirmation screen. In this example [K992-45L8-JNGJ-4XU9-1YAT-EEA2] is a request code.
3. Convenient Features

3 Viewing 3D Images
The projector provides 3D images to a user wearing commercially available LCD shutter eyeglasses.

⚠️ CAUTION

Health precautions
Before viewing, be sure to read health care precautions that may be found in the user's manual included with your LCD shutter eyeglasses or your 3D compatible content such as DVDs, video games, computer's video files and the like. To avoid any adverse symptoms, heed the following:
• Do not use LCD shutter eyeglasses for viewing any material other than 3D images.
• Allow a distance of 2 m/7 feet or greater between the screen and a user. Viewing 3D images from too close a distance can strain your eyes.
• Avoid viewing 3D images for a prolonged period of time. Take a break of 15 minutes or longer after every hour of viewing.
• If you or any member of your family has a history of light-sensitive seizures, consult a doctor before viewing 3D images.
• While viewing 3D images, if you get sick such as nausea, dizziness, queasiness, headache, eyestrain, blurry vision, convulsions, and numbness, stop viewing them. If symptoms still persist, consult a doctor.
• View 3D images from the front of the screen. Viewing from an angle may cause fatigue or eyestrain.

LCD shutter eyeglasses (recommended)
• Use commercially available DLP® Link or other method compatible LCD shutter eyeglasses.

Steps for viewing 3D images on the projector
1. Connect the projector to your video equipment.
2. Turn on the projector, display the on-screen menu, and then select [ON] for the 3D mode.
   For the operating procedure to turn on the 3D mode, refer to “On-screen menu for 3D images” on the following page.
3. Play your 3D compatible content and use the projector to display the image.
4. Put on your LCD shutter eyeglasses to view 3D images.
   Also refer to the user's manual accompanied with your LCD shutter eyeglasses for more information.

On-screen menu for 3D images
Follow the steps to display the 3D menu.
1. Press the MENU button.
   The on-screen menu will be displayed.
2. Press the ▶ button twice.
   The [SETUP] menu will be displayed.
3. Press the ▼ button once, and then press the ▶ button five times.
3. Convenient Features

The [3D] menu will be displayed

4. Press the ▼ button to select a signal and press the ENTER button.
The 3D (DETAIL SETTINGS) screen will be displayed.

5. Press the ▼ button to [GLASSES] and press the ENTER button.
The [GLASSES] setting screen will be displayed.

6. Press the ▼ button to select a compatible eyeglass method and press the ENTER button.
Set other 3D-related menu options such as [FORMAT] and [L/R INVERT] as necessary.
When switched to a 3D image, the 3D viewing cautions message screen appears (by factory default). For details, see page 54.

7. Press either △ or ▼ button to select [3D] and press the ENTER button.
The setting screen for 3D mode will be displayed on.

8. Press the ▼ button to select [ON] and press the ENTER button.
The selected signal will be changed in 3D mode.

Selecting input connected to a source of 3D images [HDMI1/HDMI2/COMPUTER/VIDEO/HDBaseT]
This function switches the 3D mode between ON and OFF for each input.

NOTE:
To confirm that the supported 3D signal is accepted, use either way of the following:
- Make sure that [3D] is displayed in the top right of the screen after the source is selected.
- Display [INFO.] → [SOURCE(2)] → [3D SIGNAL] and make sure that “SUPPORTED” is displayed.
3. Convenient Features

To view 3D images, see page 33.
Select [HDMI1], [HDMI2], [COMPUTER], [VIDEO], or [HDBaseT].

NOTE:
- The maximum distance for viewing 3D images is 10 m/394 inches from the screen surface under the following restrictions:
  - Brightness on the projector: 2000 lumens or greater
  - Screen gain: 1
  - Viewing position: Facing straight towards the screen center
  - Outside light: None
  - LCD shutter eyeglasses: DLP® Link compatible 3D eyeglasses
- If 3D content is played back on your computer and the performance is poor it may be caused by the CPU or graphics chip. In this case you may have difficulty seeing the 3D images as they were intended. Check to see if your computer meets the requirements provided in your user’s manual included with your 3D content.
- The DLP® Link compatible LCD shutter eyeglasses allow you to view 3D images by receiving synch signals, which are included in left eye and right eye images, reflected from the screen. Depending on environments or conditions such as the ambient brightness, screen size or viewing distance, the LCD shutter eyeglasses may fail to receive synch signals, causing poor 3D images.
- When the 3D mode is enabled, the Keystone correction range will be narrower.
- When the 3D mode is enabled, the following settings are invalid.
  [WALL COLOR], [PRESET], [REFERENCE], [COLOR TEMPERATURE]
- Refer to the [SOURCE(2)] screen under the [INFO.] menu for information on whether the input signal is 3D compatible.
- Signals other than those listed in “Compatible Input Signal List” on page 136 will be out of range or will be displayed in 2D.

Using a 3D emitter
This projector can be used to watch videos in 3D using commercially-available active shutter-type 3D eyewear. In order to synchronize the 3D video and eyewear, a commercially-available 3D emitter needs to be connected to the projector (on the projector side).
The 3D eyewear receives information from the 3D emitter and performs opening and closing on the left and right.

3D eyewear and 3D emitter preparations
Please use an active shutter-type 3D eyewear that conforms with the VESA standard.
A commercially-available RF type made by Xpand is recommended.

3D eyewear............ Xpand X105-RF-X2
3D emitter............. Xpand AD025-RF-X1

Connect your 3D emitter to the 3D SYNC terminal of the projector.

NOTE:
- Use an active shutter 3D eyewear (compliance with VESA)
- Check the operating conditions described in the user manual of the Blu-ray player.
- Please connect the DIN terminal of the 3D emitter to the 3D SYNC of the projector.
- The 3D eyewear allows videos to be viewed in 3D by receiving synchronized optical signals output from the 3D emitter. As a result, the 3D image quality may be affected by conditions such as the brightness of the surroundings, screen size, viewing distance, etc.
- When playing a 3D video software on a computer, the 3D image quality may be affected if the computer CPU and graphics chip performance are low. Please check the required operating environment of the computer that is stated in the operating manual attached to the 3D video software.
### Troubleshooting on viewing 3D images

If images will not be displayed in 3D or 3D images appear as 2D, check the following table. Also refer to the user’s manual accompanied with your 3D content or LCD shutter eyeglasses.

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>• The content you are playing back is not compatible with 3D.</td>
<td>• Play back a content compatible with 3D.</td>
</tr>
<tr>
<td>• The 3D mode was turned off for the selected source.</td>
<td>• Use the projector’s menu to turn on 3D mode for the selected source. (→ page 64)</td>
</tr>
<tr>
<td>• You are not using our recommended LCD shutter eyeglasses.</td>
<td>• Use our recommended LCD shutter eyeglasses. (→ page 33)</td>
</tr>
<tr>
<td>• If the shutter of your LCD shutter eyeglasses cannot synchronize with the currently projected source, the following are possible causes:</td>
<td></td>
</tr>
<tr>
<td>- Your LCD shutter eyeglasses are not switched on.</td>
<td>• Switch on your LCD shutter eyeglasses.</td>
</tr>
<tr>
<td>- The battery in the LCD shutter eyeglasses ran down.</td>
<td>• Recharge the battery or replace it.</td>
</tr>
<tr>
<td>- The correct eyeglass method is not selected.</td>
<td>• Change the eyeglass method for 3D by using the menu. (→ page 64)</td>
</tr>
<tr>
<td>- The viewing distance between the viewer and the screen is too far.</td>
<td>• Move closer to the screen until the viewer gets 3D images.</td>
</tr>
<tr>
<td>- There are bright light sources or other projectors near the viewer.</td>
<td>• Or use the projector’s menu to select [NON-INVERT] for [L/R INVERT].</td>
</tr>
<tr>
<td>• If your computer is not set for 3D viewing, the following are possible causes:</td>
<td></td>
</tr>
<tr>
<td>- Your computer does not meet the requirements for 3D viewing.</td>
<td>• Check to see if your computer meets the requirements provided in your user’s manual included with your 3D content.</td>
</tr>
<tr>
<td>- Your computer is not set for 3D output.</td>
<td>• Set your computer for 3D output.</td>
</tr>
<tr>
<td>For using a 3D emitter:</td>
<td></td>
</tr>
<tr>
<td>- There is an obstacle between the optical receiver of the 3D eyewear and the 3D emitter.</td>
<td>• Please remove the obstacle.</td>
</tr>
<tr>
<td>- The 3D format of the 3D video contents is not supported.</td>
<td>• Please check with the company selling the 3D video contents.</td>
</tr>
</tbody>
</table>
4. Using On-Screen Menu

Using the Menus

NOTE: The on-screen menu may not be displayed correctly while interlaced motion video image is projected.

1. Press the MENU button on the remote control or the projector cabinet to display the menu.

2. Press the ▶ buttons on the remote control or the projector cabinet to display the submenu.

3. Press the ENTER button on the remote control or the projector cabinet to highlight the top item or the first tab.

4. Use the ▲▼ buttons on the remote control or the projector cabinet to select the item you want to adjust or set.
   You can use the ▶ buttons on the remote control or the projector cabinet to select the tab you want.

5. Press the ENTER button on the remote control or the projector cabinet to display the submenu window.

6. Adjust the level or turn the selected item on or off by using the ▲▼▶ buttons on the remote control or the projector cabinet.
   Changes are stored until adjusted again.

7. Repeat steps 2-6 to adjust an additional item, or press the EXIT button on the remote control or the projector cabinet to quit the menu display.

NOTE: When a menu or message is displayed, several lines of information may be lost, depending on the signal or settings.

8. Press the MENU button to close the menu.
   To return to the previous menu, press the EXIT button.
Menu Elements

Menu windows or dialog boxes typically have the following elements:

- **Highlight** 
  Indicates the selected menu or item.

- **Solid triangle** 
  Indicates further choices are available. A highlighted triangle indicates the item is active.

- **Tab** 
  Indicates a group of features in a dialog box. Selecting on any tab brings its page to the front.

- **Radio button** 
  Use this round button to select an option in a dialog box.

- **Source** 
  Indicates the currently selected source.

- **Off Timer remaining time** 
  Indicates the remaining countdown time when the [OFF TIMER] is preset.

- **Slide bar** 
  Indicates settings or the direction of adjustment.

- **ECO mode symbol** 
  Indicates ECO MODE is set.

- **Key Lock symbol** 
  Indicates the [CONTROL PANEL LOCK] is enabled.

- **Thermometer symbol** 
  Indicates the projector is in the state of the [FORCED ECO MODE].

- **High Altitude symbol** 
  Indicates the [FAN MODE] is set to [HIGH ALTITUDE] mode.

- **Wireless symbol** 
  Indicates the wireless LAN connection is enabled.

- **Menu mode** 
  Indicates the [ADVANCED] menu or [BASIC] menu.
## List of Menu Items

Some menu items are not available depending on the input source. The below listed menu items are on the advanced menu. The mark (B) is added to the items on the basic menu. Refer to 88 pages about the APPS MENU.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Default Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOURCE</td>
<td>HDMI1 (B) *</td>
</tr>
<tr>
<td></td>
<td>HDMI2 (B) *</td>
</tr>
<tr>
<td></td>
<td>COMPUTER (B) *</td>
</tr>
<tr>
<td></td>
<td>VIDEO (B) *</td>
</tr>
<tr>
<td></td>
<td>HDBaseT (B) *</td>
</tr>
<tr>
<td></td>
<td>APPS (B) *</td>
</tr>
<tr>
<td>ADJUST</td>
<td>PRESET * 1–8</td>
</tr>
<tr>
<td></td>
<td>DETAIL SETTINGS</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>GAMMA CORRECTION*1</td>
</tr>
<tr>
<td></td>
<td>SCREEN SIZE*2</td>
</tr>
<tr>
<td></td>
<td>COLOR TEMPERATURE</td>
</tr>
<tr>
<td></td>
<td>COLOR ENHANCEMENT</td>
</tr>
<tr>
<td></td>
<td>DYNAMIC CONTRAST</td>
</tr>
<tr>
<td></td>
<td>CONTRAST</td>
</tr>
<tr>
<td></td>
<td>BRIGHTNESS</td>
</tr>
<tr>
<td></td>
<td>SHARPNESS</td>
</tr>
<tr>
<td></td>
<td>COLOR</td>
</tr>
<tr>
<td></td>
<td>HUE</td>
</tr>
<tr>
<td></td>
<td>RESET</td>
</tr>
<tr>
<td>IMAGE OPTIONS</td>
<td>CLOCK *</td>
</tr>
<tr>
<td></td>
<td>PHASE *</td>
</tr>
<tr>
<td></td>
<td>HORIZONTAL *</td>
</tr>
<tr>
<td></td>
<td>VERTICAL *</td>
</tr>
<tr>
<td></td>
<td>OVERSCAN AUTO</td>
</tr>
<tr>
<td></td>
<td>ASPECT RATIO</td>
</tr>
<tr>
<td></td>
<td>NOISE REDUCTION</td>
</tr>
<tr>
<td>SETUP</td>
<td>GENERAL</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ECO SETTINGS</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CLOSED CAPTION</td>
</tr>
<tr>
<td></td>
<td>OFF TIMER (B)</td>
</tr>
<tr>
<td></td>
<td>TOOLS (B)</td>
</tr>
<tr>
<td></td>
<td>LANGUAGE (B)</td>
</tr>
</tbody>
</table>

* The asterisk (*) indicates that the default setting varies depending on the signal.

*1 The [GAMMA CORRECTION] item is available when an item other than [DICOM SIM.] is selected for [REFERENCE].

*2 The [SCREEN SIZE] item is available when [DICOM SIM.] is selected for [REFERENCE].
## 4. Using On-Screen Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Default</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SETUP</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SOURCE DISPLAY</td>
<td>ON</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>ID DISPLAY</td>
<td>ON</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>ECO MESSAGE</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>DISPLAY TIME</td>
<td>AUTO 45 SEC</td>
<td>MANUAL, AUTO 5 SEC, AUTO 15 SEC, AUTO 45 SEC</td>
</tr>
<tr>
<td>BACKGROUND</td>
<td>BLUE</td>
<td>BLUE, BLACK, LOGO</td>
</tr>
<tr>
<td>3D CAUTION MESSAGE</td>
<td>ON</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>FILTER MESSAGE</td>
<td>OFF</td>
<td>OFF, 100H, 500H, 1000H, 2000H</td>
</tr>
<tr>
<td><strong>INSTALLATION</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ORIENTATION</td>
<td>DESKTOP FRONT</td>
<td>DESKTOP FRONT, CEILING REAR, DESKTOP REAR, CEILING FRONT</td>
</tr>
<tr>
<td>CONTROL PANEL LOCK</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>SECURITY</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>COMMUNICATION SPEED</td>
<td>38400bps, 48000bps, 96000bps, 192000bps, 38400bps</td>
<td>38400bps, 48000bps, 96000bps, 192000bps, 38400bps</td>
</tr>
<tr>
<td>SERIAL PORT</td>
<td>PC CONTROL</td>
<td>PC CONTROL, HDBaseT</td>
</tr>
<tr>
<td>REMOTE SENSOR</td>
<td>ALL</td>
<td>ALL, FRONT/BACK, FRONT, BACK, HDBaseT</td>
</tr>
<tr>
<td>CONTROL ID</td>
<td>1</td>
<td>1–254</td>
</tr>
<tr>
<td><strong>TEST PATTERN</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NETWORK SETTINGS</td>
<td>In APPS MENU</td>
<td></td>
</tr>
<tr>
<td><strong>OPTIONS(1)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FAN MODE</td>
<td>AUTO</td>
<td>AUTO, HIGH, HIGH ALTITUDE</td>
</tr>
<tr>
<td>WXGA MODE</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>HDMI SETTINGS</td>
<td>HDMI1 VIDEO LEVEL</td>
<td>AUTO, AUTO, NORMAL, ENHANCED</td>
</tr>
<tr>
<td>HDMI2 VIDEO LEVEL</td>
<td>AUTO</td>
<td>AUTO, AUTO, NORMAL, ENHANCED</td>
</tr>
<tr>
<td>HDBaseT VIDEO LEVEL</td>
<td>AUTO</td>
<td>AUTO, AUTO, NORMAL, ENHANCED</td>
</tr>
<tr>
<td>AUDIO SELECT</td>
<td>HDMI1 HDMI2 HDBaseT</td>
<td>HDMI1, HDMI2, HDBaseT, COMPUTER</td>
</tr>
<tr>
<td>BEEP</td>
<td>ON</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>OPTIONS(2)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>STANDBY MODE</td>
<td>NORMAL</td>
<td>NORMAL, NETWORK STANDBY</td>
</tr>
<tr>
<td>DIRECT POWER ON</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>AUTO POWER ON</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>AUTO POWER OFF</td>
<td>1:00</td>
<td>OFF, 0:05, 0:10, 0:15, 0:20, 0:30, 1:00</td>
</tr>
<tr>
<td>DEFAULT SOURCE SELECT</td>
<td>LAST</td>
<td>LAST, AUTO, HDMI1, HDMI2, COMPUTER, VIDEO, HDBaseT, APPS</td>
</tr>
<tr>
<td>CARBON CONVERT</td>
<td>$</td>
<td>$, €, JPY, RMB¥</td>
</tr>
<tr>
<td>CURRENCY CONV</td>
<td>$</td>
<td>$, €, JPY, RMB¥</td>
</tr>
<tr>
<td><strong>3D</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HDMI1 GLASSES</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>HDMI1 FORMAT</td>
<td>AUTO</td>
<td>AUTO, FRAME PACKING, SIDE BY SIDE, TOP AND BOTTOM, FRAME SEQUENTIAL</td>
</tr>
<tr>
<td>HDMI1 L/R INVERT</td>
<td>NON-INVERT</td>
<td>NON-INVERT, INVERT</td>
</tr>
<tr>
<td>HDMI2 GLASSES</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>HDMI2 FORMAT</td>
<td>AUTO</td>
<td>AUTO, FRAME PACKING, SIDE BY SIDE, TOP AND BOTTOM, FRAME SEQUENTIAL</td>
</tr>
<tr>
<td>HDMI2 L/R INVERT</td>
<td>NON-INVERT</td>
<td>NON-INVERT, INVERT</td>
</tr>
<tr>
<td>COMPUTER GLASSES</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>COMPUTER FORMAT</td>
<td>AUTO</td>
<td>AUTO, FRAME PACKING, SIDE BY SIDE, TOP AND BOTTOM, FRAME SEQUENTIAL</td>
</tr>
<tr>
<td>COMPUTER L/R INVERT</td>
<td>NON-INVERT</td>
<td>NON-INVERT, INVERT</td>
</tr>
<tr>
<td>VIDEO GLASSES</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>VIDEO FORMAT</td>
<td>AUTO</td>
<td>AUTO, FRAME PACKING, SIDE BY SIDE, TOP AND BOTTOM, FRAME SEQUENTIAL</td>
</tr>
<tr>
<td>VIDEO L/R INVERT</td>
<td>NON-INVERT</td>
<td>NON-INVERT, INVERT</td>
</tr>
<tr>
<td>HDBaseT GLASSES</td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td>HDBaseT FORMAT</td>
<td>AUTO</td>
<td>AUTO, FRAME PACKING, SIDE BY SIDE, TOP AND BOTTOM, FRAME SEQUENTIAL</td>
</tr>
<tr>
<td>HDBaseT L/R INVERT</td>
<td>NON-INVERT</td>
<td>NON-INVERT, INVERT</td>
</tr>
</tbody>
</table>

* The asterisk (*) indicates that the default setting varies depending on the signal.*
### 4. Using On-Screen Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Default</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>INFO</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>USAGE TIME (B)</td>
<td>LAMP LIFE REMAINING (B)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LAMP HOURS USED (B)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>FILTER HOURS USED (B)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>TOTAL CARBON SAVINGS (B)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>TOTAL COST SAVINGS (B)</td>
<td></td>
</tr>
<tr>
<td><strong>SOURCE(1) (B)</strong></td>
<td>RESOLUTION</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HORIZONTAL FREQUENCY</td>
<td></td>
</tr>
<tr>
<td></td>
<td>VERTICAL FREQUENCY</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SYNC TYPE</td>
<td>SEPARATE SYNC, COMPOSITE SYNC, SYNC ON GREEN, SYNC ON VIDEO</td>
</tr>
<tr>
<td></td>
<td>SYNC POLARITY</td>
<td>INTERLACE, NON-INTERLACE</td>
</tr>
<tr>
<td></td>
<td>SCAN TYPE</td>
<td></td>
</tr>
<tr>
<td><strong>SOURCE(2) (B)</strong></td>
<td>SIGNAL TYPE</td>
<td>RGB, VIDEO, YUV, NTSC, NTSC3.58, NTSC4.43, PAL, PAL-M, PAL-N, PAL60, SECAM</td>
</tr>
<tr>
<td></td>
<td>BIT DEPTH</td>
<td>8[bits], 10[bits], 12[bits]</td>
</tr>
<tr>
<td></td>
<td>VIDEO LEVEL</td>
<td>FULL, ENHANCED, DEFAULT</td>
</tr>
<tr>
<td></td>
<td>3D SIGNAL</td>
<td>SUPPORTED, NOT SUPPORTED</td>
</tr>
<tr>
<td><strong>HDBaseT</strong></td>
<td>SIGNAL QUALITY</td>
<td>NORMAL, WARNING, ABNORMAL</td>
</tr>
<tr>
<td></td>
<td>OPERATION MODE</td>
<td>HDBaseT, ETHERNET, LOW POWER, DISCONNECT</td>
</tr>
<tr>
<td></td>
<td>LINK STATUS</td>
<td>NO LINK, HDBaseT, LOW POWER, ETHERNET</td>
</tr>
<tr>
<td></td>
<td>HDMI STATUS</td>
<td>NO HDMI, HDMI ON, HDCP ON</td>
</tr>
<tr>
<td><strong>Wired Lan</strong></td>
<td>IP ADDRESS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SUBNET MASK</td>
<td></td>
</tr>
<tr>
<td></td>
<td>GATEWAY</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MAC ADDRESS</td>
<td></td>
</tr>
<tr>
<td><strong>Wireless Lan</strong></td>
<td>IP ADDRESS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SUBNET MASK</td>
<td></td>
</tr>
<tr>
<td></td>
<td>GATEWAY</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MAC ADDRESS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SSID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NETWORK TYPE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SECURITY</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CHANNEL</td>
<td></td>
</tr>
<tr>
<td><strong>VERSION(1) (B)</strong></td>
<td>FIRMWARE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DATA</td>
<td></td>
</tr>
<tr>
<td><strong>VERSION(2) (B)</strong></td>
<td>FIRMWARE2</td>
<td></td>
</tr>
<tr>
<td><strong>Others (B)</strong></td>
<td>PROJECTOR NAME</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HOST NAME</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MODEL NO</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SERIAL NUMBER</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LAN UNIT TYPE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CONTROL ID (when [CONTROL ID] is set)</td>
<td></td>
</tr>
<tr>
<td><strong>Reset</strong></td>
<td>CURRENT SIGNAL</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ALL DATA</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CLEAR LAMP HOURS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CLEAR FILTER HOURS</td>
<td></td>
</tr>
</tbody>
</table>

* The asterisk (*) indicates that the default setting varies depending on the signal.
Menu Descriptions & Functions [SOURCE]

HDMI1 and HDMI2
Selects the HDMI compatible equipment connected to your HDMI 1 IN or HDMI 2 IN terminal.

COMPUTER
Selects the computer connected to your COMPUTER input terminal signal.

NOTE: When the component input signal is connected to the COMPUTER IN terminal, select [COMPUTER].

VIDEO
Selects what is connected to your VIDEO input-VCR, DVD player or document camera.

HDBaseT
Projects the signal transmitted from the terminals supported HDBaseT. (→ page 86)

APPS
Display the APPS MENU or the function in the APPS MENU that was used last time.
4. Using On-Screen Menu

4 Menu Descriptions & Functions [ADJUST]

[PICTURE]

[PRESET]
This function allows you to select optimized settings for your projected image. You can adjust neutral tint for yellow, cyan or magenta.
There are eight factory presets optimized for various types of images. You can also use [DETAIL SETTINGS] to set user adjustable settings to customize each gamma or color.
Your settings can be stored in [PRESET 1] to [PRESET 8].
- HIGH-BRIGHT. Recommended for use in a brightly lit room.
- PRESENTATION. Recommended for making a presentation using a PowerPoint file.
- VIDEO. Recommended for typical TV program viewing.
- MOVIE. Recommended for movies.
- GRAPHIC. Recommended for graphics.
- sRGB. Standard color values
- NATURAL. Well-balanced setting of brightness and color
- DICOM SIM. Recommended for DICOM simulation format.

NOTE:
- The [DICOM SIM.] option is for training/reference only and should not be used for actual diagnosis.
- DICOM stands for Digital Imaging and Communications in Medicine. It is a standard developed by the American College of Radiology (ACR) and the National Electrical Manufacturers Association (NEMA).
- The standard specifies how digital image data can be moved from system to system.
[DETAIL SETTINGS]

Storing Your Customized Settings [REFERENCE]
This function allows you to store your customized settings in [PRESET 1] to [PRESET 8].
First, select a base preset mode from [REFERENCE], then set [GAMMA CORRECTION] and [COLOR TEMPERATURE].

- HIGH-BRIGHT. Recommended for use in a brightly lit room.
- PRESENTATION. Recommended for making a presentation using a PowerPoint file.
- VIDEO. Recommended for typical TV program viewing.
- MOVIE. Recommended for movies.
- GRAPHIC. Recommended for graphics.
- sRGB. Standard color values.
- NATURAL. Well-balanced setting of brightness and color
- DICOM SIM. Recommended for DICOM simulation format.

Selecting Gamma Correction Mode [GAMMA CORRECTION]
Each mode is recommended for:

- DYNAMIC. Creates a high-contrast picture.
- NATURAL. Natural reproduction of the picture.
- BLACK DETAIL. Emphasizes detail in dark areas of the picture.

NOTE: This function is not available when [DICOM SIM.] is selected for [DETAIL SETTINGS].

Selecting Screen Size for DICOM SIM [SCREEN SIZE]
This function will perform gamma correction appropriate for the screen size.

- LARGE. For screen size of 110".
- MEDIUM. For screen size of 90".
- SMALL. For screen size of 70".

NOTE: This function is available only when [DICOM SIM.] is selected for [DETAIL SETTINGS].

Adjusting Color Temperature [COLOR TEMPERATURE]
This option allows you to select the color temperature of your choice.

NOTE: When [PRESENTATION] or [HIGH-BRIGHT] is selected in [REFERENCE], this function is not available.

Enhancing the Color [COLOR ENHANCEMENT]
This allows you to adjust the color density of the image.
The color of the image will become deeper in the order of "LOW", "MEDIUM", AND "HIGH" as the displayed image will become darker.
With "OFF" selected, the COLOR ENHANCEMENT function will not work.

NOTE: This function is available only when [PRESENTATION] is selected [REFERENCE].

Adjusting Brightness and Contrast [DYNAMIC CONTRAST]
This function allows you to adjust the contrast ratio optically.
To increase the contrast ratio, select [ON].

NOTE:
- The [DYNAMIC CONTRAST] item cannot be selected in the following cases:
  - When [CONSTANT BRIGHTNESS] is functioned under the state [ECO MODE] has been set to [NORMAL] or [ECO] for [ECO SETTINGS].
  - When [ON] is selected for [3D] while images are projected.
- The ECO MODE and DYNAMIC CONTRAST features control the lamp power. Some pictures may become extremely bright when using both ECO MODE and DYNAMIC CONTRAST features to control the lamp power. To avoid this phenomena, turn off the ECO MODE and DYNAMIC CONTRAST.
4. Using On-Screen Menu

[CONTRAST]
Adjusts the intensity of the image according to the incoming signal.

[BRIGHTNESS]
Adjusts the brightness level or the back raster intensity.

[SHARPNESS]
Controls the detail of the image.

[COLOR]
Increases or decreases the color saturation level.

[HUE]
Varies the color level from +/- green to +/- blue. The red level is used as reference.

<table>
<thead>
<tr>
<th>Input signal</th>
<th>CONTRAST</th>
<th>BRIGHTNESS</th>
<th>SHARPNESS</th>
<th>COLOR</th>
<th>HUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPUTER/HDMI/HDBaseT (RGB)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>COMPUTER/HDMI/HDBaseT (COMPONENT)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>VIDEO</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>APPS, LAN</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

Yes = Adjustable, No = Not adjustable

[RESET]
The settings and adjustments for [PICTURE] will be returned to the factory settings with the exception of the following; Preset numbers and [REFERENCE] within the [PRESET] screen. The settings and adjustments under [DETAIL SETTINGS] within the [PRESET] screen that are not currently selected will not be reset.
4. Using On-Screen Menu

[IMAGE OPTIONS]

Adjusting Clock and Phase [CLOCK/PHASE]
This allows you to manually adjust CLOCK and PHASE.

CLOCK ................. Use this item to fine tune the computer image or to remove any vertical banding that might appear. This function adjusts the clock frequencies that eliminate the horizontal banding in the image. This adjustment may be necessary when you connect your computer for the first time.

PHASE ................. Use this item to adjust the clock phase or to reduce video noise, dot interference or cross talk. (This is evident when part of your image appears to be shimmering.) Use [PHASE] only after the [CLOCK] is complete.
4. Using On-Screen Menu

Adjusting Horizontal/Vertical Position [HORIZONTAL/VERTICAL]
Adjusts the image location horizontally and vertically.

- An image can be distorted during the adjustment of [CLOCK] and [PHASE]. This is not malfunction.
- The adjustments for [CLOCK], [PHASE], [HORIZONTAL], and [VERTICAL] will be stored in memory for the current signal. The next time you project the signal with the same resolution, horizontal and vertical frequency, its adjustments will be called up and applied.
  
  To delete adjustments stored in memory, from the menu, you select [RESET] → [CURRENT SIGNAL] or [ALL DATA] and reset the adjustments.

Selecting Overscan Percentage [OVERSCAN]
This allows you to set the appropriate overscan for an incoming signal.

  AUTO ................. Display an appropriately overscanned image (factory setting).
  OFF .................. Does not overscan the image.
  ON ................... Overscans the image.

*NOTE:
• The [OVERSCAN] item cannot be selected when VIDEO signals are used or when [NATIVE] is selected for [ASPECT RATIO].
Selecting Aspect Ratio [ASPECT RATIO]

The term “aspect ratio” refers to the ratio of width to height of a projected image. The projector automatically determines the incoming signal and displays it in its appropriate aspect ratio.

- This table shows typical resolutions and aspect ratios that most computers support.

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Aspect Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640 × 480</td>
</tr>
<tr>
<td>SVGA</td>
<td>800 × 600</td>
</tr>
<tr>
<td>XGA</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 × 768</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1440 × 900</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280 × 1024</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400 × 1050</td>
</tr>
<tr>
<td>UXGA</td>
<td>1600 × 1200</td>
</tr>
<tr>
<td>Full HD</td>
<td>1920 × 1080</td>
</tr>
<tr>
<td>WUXGA</td>
<td>1920 × 1200</td>
</tr>
</tbody>
</table>

Options | Function
---|---
AUTO | The projector will automatically determine the incoming signal and display it in its aspect ratio. (→ next page)
4:3 | The image is displayed in 4:3 aspect ratio.
16:9 | The image is displayed in 16:9 aspect ratio.
15:9 | The image is displayed in 15:9 aspect ratio.
16:10 | The image is displayed in 16:10 aspect ratio.
LETTERBOX | The image of a letterbox signal is stretched equally in the horizontal and vertical directions to fit the screen. Parts of the displayed image are cropped at the top and bottom edges and therefore not visible.
NATIVE | The projector displays the current image in its true resolution when the incoming computer signal has a lower resolution than the projector’s native resolution.

[Example] When the incoming signal with the resolution of 800 × 600 is displayed:

NOTE:
- When a non-computer signal is displayed, the [NATIVE] is not available.
- When a signal with a higher resolution than the projector’s native resolution is displayed, [NATIVE] is not available.
Sample image when the appropriate aspect ratio is automatically determined

[Computer signal]

<table>
<thead>
<tr>
<th>Aspect ratio of incoming signal</th>
<th>4:3</th>
<th>5:4</th>
<th>16:9</th>
<th>15:9</th>
<th>16:10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample image when the appropriate aspect ratio is automatically determined</td>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="image3.png" alt="Image" /></td>
<td><img src="image4.png" alt="Image" /></td>
<td><img src="image5.png" alt="Image" /></td>
</tr>
</tbody>
</table>

[Video signal]

<table>
<thead>
<tr>
<th>Aspect ratio of incoming signal</th>
<th>4:3</th>
<th>Letterbox</th>
<th>Squeeze</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample image when the aspect ratio is automatically determined</td>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
</tbody>
</table>

NOTE: To display a letterbox signal properly, select [LETTERBOX].
NOTE: To display a squeezed signal properly, select [16:9].

TIP:

- The term “letterbox” refers to a more landscape-oriented image when compared to a 4:3 image, which is the standard aspect ratio for a video source.
  
The letterbox signal has aspect ratios with the vista size “1.85:1” or cinema scope size “2.35:1” for movie film.
- The term “squeeze” refers to the compressed image of which aspect ratio is converted from 16:9 to 4:3.

Turning on Noise Reduction [NOISE REDUCTION]

This function allows you to select the level of noise reduction.
The projector is set to the optimized level for each signal at the factory.
Select your preference item for your signal when video noise is noticeable.
The options are [OFF], [LOW], [MEDIUM], and [HIGH].

NOTE: This feature is not available for the RGB signal. Noise reduction set to off gives best image quality by way of higher bandwidth.
Noise reduction set to on softens the image.
4. Using On-Screen Menu

5 Menu Descriptions & Functions [SETUP]

[GENERAL]

Correcting Keystone Distortion Manually [KEYSTONE]
You can correct horizontal or vertical keystone manually. [HORIZONTAL] and [VERTICAL] (simultaneously adjustable) correction can be selected.

NOTE:
• Some items are not available when one item is activated. Unavailable items are shown in grey.
• To change from one item to another item, reset the first item.
• Adjustment values will be overwritten. They will not be deleted even when the projector is turned off.
• Using [KEYSTONE] correction can cause the image to be slightly blurred because the correction is made electronically.

HORIZONTAL............ Corrects horizontal keystone distortion. (→ page 21)
VERTICAL................. Corrects vertical keystone distortion. (→ page 21)
RESET....................... Returns all the above items to the factory preset values.

TIP:
• The maximum adjustment range with [KEYSTONE] correction is ±25° in the horizontal direction, ±30° in the vertical direction.
  - Depending on input signal, the adjustable range may be narrower.
Using the Wall Color Correction [WALL COLOR]

This function allows for quick adaptive color correction in applications where the screen material is not white.

Setting various items related to lamp brightness [ECO SETTINGS]

This option allows you to decrease the power consumption or to prolong the lamp life by controlling the lamp brightness.

ECO MODE

The ECO MODE increases lamp life, while lowering power consumption and cutting down on CO2 emissions. Four brightness modes of the lamp can be selected: [OFF], [AUTO ECO], [NORMAL] and [ECO] modes. (→ page 28)

NOTE: The [OFF] item is automatically selected for [ECO MODE] when [ON] is selected [3D] while images are projected.

AUTO ECO OPTIONS

Set options when [AUTO ECO] is selected for [ECO MODE].

<table>
<thead>
<tr>
<th>AUTO DIM</th>
<th>OFF</th>
<th>The AUTO DIM feature will not work.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0:01, 0:03, 0:10, 0:20 (min.)</td>
<td>This option will automatically dim the lamp light when no input signal is present for a certain period time: 0:01, 0:03, 0:10, and 0:20 (minutes). When it reaches the preset time, the lamp brightness will decrease to about 30% immediately after the screen becomes dim for a moment. Changing images will return to its original brightness.</td>
</tr>
</tbody>
</table>

NORMAL OPTION

Set the option when [NORMAL] is selected for [ECO MODE].

CONSTANT BRIGHTNESS:

OFF ......................... The CONSTANT BRIGHTNESS feature will not work. The lamp brightness will gradually decrease over long periods of time.

ON ......................... The lamp brightness will increase according to the lamp use of time and will be kept at the lamp brightness equivalent to the brightness at NORMAL. After the lamp brightness reaches the maximum, the lamp brightness will gradually decrease over long periods of time.

ECO OPTION

Set the option when [ECO] is selected for [ECO MODE].

CONSTANT BRIGHTNESS:

OFF ......................... The CONSTANT BRIGHTNESS feature will not work. The lamp brightness will gradually decrease over long periods of time.

ON ......................... The lamp brightness will increase according to the lamp use of time and will be kept at the lamp brightness equivalent to the brightness at ECO. After the lamp brightness reaches the maximum, the lamp brightness will gradually decrease over long periods of time. The lamp brightness will be kept longer than at NORMAL.
4. Using On-Screen Menu

Setting Closed Caption [CLOSED CAPTION]
This option sets several closed caption modes that allow text to be superimposed on the projected image of Video or S-Video.

- OFF ................. This exits the closed caption mode.
- CAPTION 1-4 ....... Text is superimposed.
- TEXT 1-4 ............ Text is displayed.

NOTE:
- The closed caption is not available under the following conditions:
  - when messages or menus are displayed.
  - when an image is magnified, frozen, or muted.
- Portions of superimposed text or closed caption may be truncated. If that happens, try to place the superimposed text or closed caption within the screen.
- The projector does not support optional extended characters for closed captioning.

Using Off Timer [OFF TIMER]
1. Select your desired time between 30 minutes and 16 hours: OFF, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00.
2. Press the ENTER button on the remote control.
3. The remaining time starts counting down.
4. The projector will turn off after the countdown is complete.

NOTE:
- To cancel the preset time, set [OFF] for the preset time or turn off the power.
- When the remaining time reaches 3 minutes before the projector is turned off, the [THE PROJECTOR WILL TURN OFF WITHIN 3 MINUTES] message will be displayed on the bottom of the screen.

Display the tools menu [TOOLS]
This function displays the tools menu. (→ page 91)

Selecting Menu Language [LANGUAGE]
You can choose one of 30 languages for on-screen instructions.

NOTE: Your setting will not be affected even when [RESET] is done from the menu.
4. Using On-Screen Menu

[SELECTING MENU COLOR [COLOR SELECT]]
You can choose between two options for menu color: COLOR and MONOCHROME.

[TURNING ON / OFF SOURCE DISPLAY [SOURCE DISPLAY]]
This option turns on or off input name display such as HDMI1, HDMI2, COMPUTER, VIDEO, HDBaseT, APPS, to be displayed on the top right of the screen.
When no input signal is present, the no-signal guidance prompting you to check for an available input will be displayed at the center of the screen. When the [APPS] item is selected for [SOURCE], the no-signal guidance will not be displayed.

[TURNING ON / OFF CONTROL ID [ID DISPLAY]]
ID DISPLAY ........... This option turns on or off the ID number which is displayed when the ID SET button on the remote control is pressed.

[TURNING ON / OFF ECO MESSAGE [ECO MESSAGE]]
This option turns on or off the following messages when the projector is turned on.

The Eco Message prompts the user to save energy. When [OFF] is selected for [ECO MODE], you will get a message to prompt you to select [AUTO ECO], [NORMAL], or [ECO] for [ECO MODE].

When [AUTO ECO], [NORMAL], or [ECO] is selected for [ECO MODE]

To close the message, press any one of the buttons. The message will disappear if no button operation is done for 30 seconds.

When [OFF] is selected for [ECO MODE]

Pressing the ENTER button will display the [ECO MODE] screen. (→ page 28)
To close the message, press the EXIT button.

[SELECTING MENU DISPLAY TIME [DISPLAY TIME]]
This option allows you to select how long the projector waits after the last touch of a button to turn off the menu. The preset choices are [MANUAL], [AUTO 5 SEC], [AUTO 15 SEC], and [AUTO 45 SEC]. The [AUTO 45 SEC] is the factory preset.
4. Using On-Screen Menu

Selecting a Color or Logo for Background [BACKGROUND]
Use this feature to display a blue/black screen or logo when no signal is available. The default background is [BLUE].

NOTE:
• When [SOURCE DISPLAY] is turned on, the no-signal guidance prompting you to check for an available input will be displayed at the center of the screen regardless of its selection.
• Your setting will not be affected even when [RESET] is done from the menu.

[3D CAUTION MESSAGE]
This selects whether to display a caution message or not when switching to a 3D video.
The default condition when shipped from the factory is ON.

OFF ....................... The 3D caution message screen will not be displayed.
ON ....................... The 3D caution message screen will be displayed when switching to a 3D video. Press the ENTER button to cancel the message.

• The message will disappear automatically after 60 seconds or when other buttons are pressed. If it disappears automatically, the 3D caution message will be displayed again when switching to a 3D video.

Selecting Interval Time for Filter Message [FILTER MESSAGE]
This option allows you to select the time preference for displaying the filter cleaning message. Clean the filter when you get the message “PLEASE CLEAN THE FILTER.” (→ page 113)
Five options are available:
OFF, 100[H], 500[H], 1000[H], 2000[H]

NOTE: Your setting will not be affected even when [RESET] is done from the menu.
[INSTALLATION]

4. Using On-Screen Menu

Selecting Projector Orientation [ORIENTATION]
This reorients your image for your type of projection. The options are: desktop front projection, ceiling rear projection, desktop rear projection, and ceiling front projection.

Disabling the Cabinet Buttons [CONTROL PANEL LOCK]
This option turns on or off the CONTROL PANEL LOCK function.

NOTE:
• This CONTROL PANEL LOCK does not affect the remote control functions.
• How to release the CONTROL PANEL LOCK
  1. When the projector is projecting image or in the sleep mode, press and hold the SOURCE button on the projector cabinet for about 10 seconds. The CONTROL PANEL LOCK will be released.
  2. When the projector is in the standby mode, press and hold the POWER button on the projector cabinet. It enables to power on the projector. After checking the projector is projecting image, perform the previous step 1.

TIP: When the [CONTROL PANEL LOCK] is turned on, a key lock icon [🔒] will be displayed at the bottom right of the menu.
4. Using On-Screen Menu

Enabling Security [SECURITY]
This feature turns on or off the SECURITY function. Unless the correct keyword is entered, the projector cannot project an image. (→ page 30)

NOTE: Your setting will not be affected even when [RESET] is done from the menu.

Selecting Communication Speed [COMMUNICATION SPEED]
This feature sets the baud rate of the PC Control port (D-Sub 9P). It supports data rates from 4800 to 38400 bps. The default is 38400 bps. Select the appropriate baud rate for your equipment to be connected (depending on the equipment, a lower baud rate may be recommended for long cable runs).

NOTE: Your selected communication speed will not be affected even when [RESET] is done from the menu.

Selecting the serial port [SERIAL PORT]
This sets which terminal on the projector will receive the serial control signals for remotely controlling the projector from a commercially available HDBaseT transmission devices (control signals for turning the power on and off, etc.). There is no need to make this setting if not operating the projector by remote control (only sending video and audio).

- PC CONTROL........... Control signals (RS232C serial communications) are received at the PC CONTROL terminal.
- HDBaseT................. The video/audio and control signals (RS232C serial communications) are received at the Ethernet/HDBaseT port.

NOTE:
- When [HDBaseT] is set, it will not work when the projector is in the standby mode, regardless of whether [STANDBY MODE] (→ page 61) is set to [NORMAL] or [NETWORK STANDBY] (the power cannot be turned on). The methods below can be used to turn on the projector’s power when it is in the standby mode.
  - The projector can be operated by connecting the computer and projector by RS232C serial communications (on the projector, using the PC CONTROL terminal and the PC Control Utility application, with [STANDBY MODE] set to [NETWORK STANDBY]).
  - The projector can be operated by connecting the computer and projector over the network (on the projector, using the LAN port and PC Control Utility application, with [STANDBY MODE] set to [NETWORK STANDBY]).

TIP:
- When controlling the projector using the LAN port, this works with either setting.

Turning On or Off Remote Sensor [REMOTE SENSOR]
Set the remote control sensors on the projector’s front and rear panels and the HDBaseT remote control sensor. The options are: ALL, FRONT/BACK, FRONT, BACK, and HDBaseT.

NOTE:
- When [HDBaseT] is set, it will not work when the projector is in the standby mode, regardless of whether [STANDBY MODE] (→ page 61) is set to [NORMAL] or [NETWORK STANDBY] (the power cannot be turned on).

TIP:
- If the remote control system does not function when direct sunlight or strong illumination strikes the remote control sensor of the projector, change another option.
- Remote control by infrared rays is not available when the remote control cable is connected to the REMOTE terminal.
4. Using On-Screen Menu

Setting ID to the Projector [CONTROL ID]
You can operate multiple projectors separately and independently with the single remote control that has the CONTROL ID function. If you assign the same ID to all the projectors, you can conveniently operate all the projectors together using the single remote control. To do so, you have to assign an ID number to each projector.

CONTROL ID NUMBER ....... Select a number from 1 to 254 you wish to assign to your projector.
CONTROL ID ................. Select [OFF] to turn off the CONTROL ID setting and select [ON] to turn on the CONTROL ID setting.

NOTE:
• When [ON] is selected for [CONTROL ID], the projector cannot be operated by using the remote control that does not support the CONTROL ID function. (In this case the buttons on the projector cabinet can be used.)
• Your setting will not be affected even when [RESET] is done from the menu.
• Pressing and holding the ENTER button on the projector cabinet for 10 seconds will display the menu for canceling the Control ID.

Assigning or Changing the Control ID

1. Turn on the projector.
2. Press the ID SET button on the remote control. The CONTROL ID screen will be displayed.

If the projector can be operated with the current remote control ID, the [ACTIVE] will be displayed. If the projector cannot be operated with the current remote control ID, the [INACTIVE] will be displayed. To operate the inactive projector, assign the control ID used for the projector by using the following procedure (Step 3).
3. Press one of numeric keypad buttons while pressing and holding the ID SET button on the remote control.
   Example:
   To assign “3”, press the “3” button on the remote control.
   No ID means that all the projectors can be operated together with a single remote control. To set “No ID”, enter “000” or press the CLEAR button.
   TIP: The range of IDs is from 1 to 254.
4. Release the ID SET button.
   The updated CONTROL ID screen will be displayed.

NOTE:
• The IDs can be cleared in a few days after the batteries are run down or removed.
• Accidentally pressing any one of the buttons of the remote control will clear currently specified ID with batteries removed.
Using Test Pattern [TEST PATTERN]
Displays the test pattern for adjusting distortion on the screen and the focus at the time of the projector setup. Once the [TEST PATTERN] on the onscreen menu is selected, the pattern for adjustment will be displayed on. If you find distortion on the pattern, adjust the projector installation angle or correct distortion by pressing the KEYSTONE button on the remote. If the focus adjustment is required, control the focus lever. Press EXIT button to close the test pattern and return to the menu.

NOTE:
• Recommend to perform the focus adjustment after leaving the projector under the state the TEST PATTERN has been projected for over 30 minutes.

Setting the network [NETWORK SETTINGS]
This function display the network settings menu. (→ page 90)
4. Using On-Screen Menu

[OPTIONS(1)]

Selecting Fan Mode [FAN MODE]
Fan Mode is used to set the speed of the internal cooling fan.

AUTO ..................... The built-in fans automatically run at a variable speed according to the internal temperature.
HIGH ..................... The built-in fans run at a high speed.
HIGH ALTITUDE .... The built-in fans run at a high speed. Select this option when using the projector at altitudes approximately 4000 feet/1200 meters or higher.

NOTE:
• It is recommended that you select High speed mode if you use the projector non-stop for consecutive days.
• Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 4000 feet/1200 meters or higher.
• Using the projector at altitudes approximately 4000 feet/1200 meters or higher without setting to [HIGH ALTITUDE] can cause the projector to overheat and the protector could shut down. If this happens, wait a couple minutes and turn on the projector.
• Using the projector at altitudes approximately 4000 feet/1200 meters or higher can shorten the life of optical components such as the lamp.
• Your setting will not be affected even when [RESET] is done from the menu.

Enabling or Disabling WXGA Mode [WXGA MODE]
Selecting [ON] will give priority to WXGA (1280 × 768)/WUXGA (1920 × 1200) signals in recognizing an input signal. When [WXGA MODE] is set to [ON], XGA (1024 × 768)/UXGA (1600 × 1200) signals may not be recognized. In this case, select [OFF].
4. Using On-Screen Menu

Setting HDMI1, HDMI2, or HDBaseT [HDMI SETTINGS]
Make the settings for each video level when connecting HDMI equipment and Ethernet/HDBaseT terminal.

VIDEO LEVEL........ Select [AUTO] to automatically detect video level. If automatic detection may not work well, select [NORMAL] to disable the [ENHANCED] feature of your HDMI equipment or select [ENHANCED] to improve image contrast and increase detail in the dark areas.

Setting Audio [AUDIO SELECT]
Make the settings for each audio level when connecting HDMI equipment and Ethernet/HDBaseT terminal. Select between each equipment and computer.

HDMI1, HDMI2........ Select [HDMI1] or [HDMI2] to switch the HDMI 1 IN or HDMI 2 IN digital audio signal or select [COMPUTER] to switch the COMPUTER input audio signal.

HDBaseT.............. Select [HDBaseT] or [COMPUTER] to switch the source connected to the network.

Enabling Key Sound and Error Sound [BEEP]
This feature turns on or off the button sound or alarm when an error occurs or the following operations are performed.

- Displaying the main menu
- Switching sources
- Resetting data by using [RESET]
- Pressing POWER ON or STANDBY button
**4. Using On-Screen Menu**

**Selecting Power-saving in [STANDBY MODE]**
The projector has two standby modes: [NORMAL] and [NETWORK STANDBY]. The NORMAL mode is the mode that allows you to put the projector in the power-saving condition which consumes less power than the NETWORK STANDBY mode.

NORMAL.......................POWER indicator: Red light/STATUS indicator: Off
When [NORMAL] is selected, only the following buttons and feature will work:
- POWER buttons on the projector cabinet and the remote control, powering on from PC Control command, and AUTO POWER ON.

NETWORK STANDBY........POWER indicator: Orange light/STATUS indicator: Off
When [NETWORK STANDBY] is selected, the projector can be turned on over a wired LAN/wireless LAN connection and only the following buttons, terminals, and features will work:
- POWER buttons on the projector cabinet and the remote control, powering on from PC Control command, AUTO POWER ON, Operation by User Supportware, Network service, Program Timer.

**Important:**
- When [NETWORK STANDBY] is selected, [AUTO POWER OFF] will turn in grey and be disabled and [0:10] will be selected automatically for [AUTO POWER OFF].
- In the below conditions, setting of the [STANDBY MODE] is disabled and the projector will go into the SLEEP mode*.
  * Sleep mode refers the mode without functional restrictions by the [STANDBY MODE]. Power consumption in the SLEEP mode is relatively higher than the [NETWORK STANDBY] mode. The Status indicator turns on in Green.
  - When [STANDBY MODE] → [NETWORK STANDBY] is selected
  - When [NETWORK SERVICE] → [AMX SETTINGS] → [ENABLE] is selected
  - When [NETWORK SERVICE] → [CRESTRON SETTINGS] → [CRESTRON CONTROL] → [ENABLE] is selected
  - When [NETWORK SETTINGS] → [WIRELESS LAN] → Except for [DISABLE] and mounting the wireless LAN unit to the projector
  - When the signal is input to the computer; HDMI 1 IN or HDMI 2 IN terminals

**NOTE:**
- When an HDBaseT transmitter is connected to the Ethernet/HDBaseT port, if the projector is in the standby mode, the projector cannot be controlled (the power cannot be turned on), regardless of the [STANDBY MODE] setting.

**TIP:**
- Even when [NORMAL] is selected for [STANDBY MODE], power on or off can be done by using the PC CONTROL port.
- The power consumption in the standby mode will not be included in calculating CO₂ emission reduction.
- Your setting will not be affected even when [RESET] is done from the menu.

**Enabling Direct Power On [DIRECT POWER ON]**
Turns the projector on automatically when the power cord is inserted into an active power outlet. This eliminates the need to always use the POWER button on the remote control or projector cabinet.
Turning On the Projector By Applying Computer Signal [AUTO POWER ON]
When the projector is in Standby mode, applying a computer or HDMI signal from a computer connected to the COMPUTER IN input, HDMI1, or HDMI2 input will power on the projector and simultaneously project the image. This functionality eliminates the need to always use the POWER button on the remote control or the projector cabinet to power on the projector.
To use this function, first connect a computer to the projector and the projector to an active AC input.

NOTE:
- Disconnecting a computer signal from the computer will not power off the projector. We recommend using this function in combination of the AUTO POWER OFF function.
- This function will not be available under the following conditions:
  - when a component signal is applied to the COMPUTER IN terminal
  - when a Sync on Green RGB signal or composite sync signal is applied
- To enable the AUTO POWER ON after changing to the sleep mode turning off the projector, wait 5 seconds and input a computer or HDMI signal.
  If a computer or HDMI signal is still present when the projector is turned off, the AUTO POWER ON will not work and the projector remains in standby mode.

Enabling Power Management [AUTO POWER OFF]
When this option is selected you can enable the projector to automatically turn off (at the selected time: 5min., 10min., 15min., 20min., 30min., 60min.) in one of the below conditions.
- No signal is received.
- The thumbnail screen is displayed.
- No operation is performed.

NOTE:
- This item can be selected only when [NORMAL] is selected for [STANDBY MODE].
- When [NETWORK STANDBY] is selected, [AUTO POWER OFF] will turn grey in color and be disabled to select, [0:15] will be selected automatically.
Selecting Default Source [DEFAULT SOURCE SELECT]

You can set the projector to default to any one of its inputs each time the projector is turned on.

- **LAST** ................. Sets the projector to default to the previous or last active input each time the projector is turned on.
- **AUTO** ................. Searches for an active source in order of [HDMI1] → [HDMI2] → [COMPUTER] → [VIDEO] → [HDBaseT] → [APPS] and displays the first found source.
- **HDMI1** .................. Displays the digital source from the HDMI 1 IN terminal every time the projector is turned on.
- **HDMI2** .................. Displays the digital source from the HDMI 2 IN terminal every time the projector is turned on.
- **COMPUTER** ........... Displays the computer signal from the COMPUTER IN terminal every time the projector is turned on.
- **VIDEO** .................. Displays the Video source from the VIDEO IN terminal every time the projector is turned on.
- **HDBaseT** .............. Projects the signal transmitted from the terminals supported HDBaseT.
- **APPS** .................. Display the APPS MENU.

**NOTE:**
- [APPS] cannot be detected when [AUTO] is selected. For projecting image from APPS, select [APPS] or [LAST].

Setting carbon footprint factor [CARBON CONVERT]

Adjusts the carbon footprint factor in the carbon saving calculation. The initial setting is 0.505[kg-CO2/kWh] based on the CO2 Emissions from Fuel Combustion (2008 Edition) published by OECD.

Selecting your currency [CURRENCY]

Displays electricity pricing (available in 4 currency units).
- **$** .................. US Dollar
- **€** .................. EU Euro
- **JPY** ................. Japanese Yen
- **RMBY** ............... Chinese Yuan

Changing currency setting and currency convert setting [CURRENCY CONVERT]

Changes currency setting and currency convert setting for CARBON METER.

The initial setting are as follows:

- **US Dollar** .......... 0.11 [$/kWh]
- **EU Euro** .......... 0.19 [€/kWh]
- **Japanese Yen** ...... 20 [¥/kWh]
- **Chinese Yuan** ...... 0.48 [¥/kWh]

The initial settings for US dollar, EU Euro, and Japanese Yen are based on “Energy Prices and Taxes (second quarter 2010)” published by OECD.

The initial setting for Chinese Yuan is based on “Chinese Data File (2010)” published by JETRO.
4. Using On-Screen Menu

[3D]

Selecting input connected to a source of 3D images [HDMI1/HDMI2/COMPUTER/VIDEO/HDBaseT]

[3D]
This function switches the 3D mode between ON and OFF for each input.

ON .......................... Turns on the 3D mode for the selected input.

NOTE:
To confirm that the supported 3D signal is accepted, use either way of the following:
• Make sure that [3D] is displayed in the top right of the screen after the source is selected.
• Display [INFO.] → [SOURCE(2)] → [3D SIGNAL] and make sure that “SUPPORTED” is displayed.

OFF .......................... Turns off the 3D mode for the selected input.

[GLASSES]
Select 3D glasses method.
DLP® Link ............... For 3D eyeglasses (ones manufactured by XPAND are recommended) or DLP® Link compatible LCD shutter eyeglasses.
Others ..................... For other LCD shutter eyeglasses such as IR or wired LCD shutter types.

NOTE:
• When using crystal shutter glasses other than those using the DLP® Link method, it may not be possible to synchronize, depending on the glasses.
• This function will not work for VIDEO source.

[FORMAT]
Sets 3D format.
AUTO ......................... Automatically selects the appropriate format. The supported format is HDMI 3D only.
FRAME PACKING .......... Selects this format for the FRAME PACKING 3D image. FRAME PACKING is a format that stores the left and right eye images without compression.
SIDE BY SIDE ............. Selects this format for the SIDE BY SIDE 3D image. SIDE BY SIDE is a format that stores the left and right eye images displayed horizontally. Only the half of the horizontal resolution is supported.
TOP AND BOTTOM ........ Selects this format for the TOP AND BOTTOM 3D image. TOP AND BOTTOM is a format that stores the left and right eye images displayed vertically. Only the half of the vertical resolution is supported.
FRAME SEQUENTIAL ....... Selects this format for the FRAME SEQUENTIAL 3D image. FRAME SEQUENTIAL is a format that displays the left and right eye images alternately.

NOTE:
• This function will not work for VIDEO source.
• When 3D signals are input, operation is only possible when [GLASSES] is set to “DLP® Link”.
4. Using On-Screen Menu

[L/R INVERT]
Change the setting if you have difficulty seeing 3D images.

- NON-INVERT ........ Normal setting.
- INVERT ................ Changes the order of displaying the images for left eye and right eye.

NOTE:
- When [L/R INVERT] cannot be operated, the [L/R INVERT] screen will not be displayed even when the remote control’s video button is pressed.
### 4. Using On-Screen Menu

#### 6 Menu Descriptions & Functions [INFO.]
Displays the status of the current signal and lamp usage. This item has nine pages. The information included is as follows:

* **TIP:** Pressing the HELP button on the remote control will show the [INFO.] menu items.

#### [USAGE TIME]
- [LAMP LIFE REMAINING] (%)*
- [LAMP HOURS USED] (H)
- [FILTER HOURS USED] (H)
- [TOTAL CARBON SAVINGS] (kg-CO2)
- [TOTAL COST SAVINGS]($)

* The progress indicator shows the percentage of remaining bulb life.  
  The value informs you of the amount of lamp usage. When the remaining lamp time reaches 0, the LAMP LIFE REMAINING bar indicator changes from 0% to 100 Hours and starts counting down.  
  If the remaining lamp time reaches 0 hours, the projector will not turn on.

- The message to the effect that the lamp should be replaced will be displayed for one minute when the projector is turned on and when the POWER button on the projector or the STANDBY button on the remote control is pressed.  
  To dismiss this message, press any button on the projector or the remote control.

<table>
<thead>
<tr>
<th>Lamp life (H)</th>
<th>Brightness by mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF 3000H</td>
<td>AUTO ECO 3000H to 5000H</td>
</tr>
<tr>
<td>AUTO ECO 4000H</td>
<td>NORMAL 5000H</td>
</tr>
<tr>
<td>ECO 100%</td>
<td>OFF thru ECO Approx. 80%</td>
</tr>
<tr>
<td>NORMAL Approx. 60%</td>
<td>ECO Approx. 60%</td>
</tr>
</tbody>
</table>

- [TOTAL CARBON SAVINGS]
  This displays the estimated carbon saving information in kg. The carbon footprint factor in the carbon saving calculation is based on the OECD (2008 Edition). (→ page 29)
4. Using On-Screen Menu

[SOURCE(1)]
[RESOLUTION] [HORIZONTAL FREQUENCY]
[VERTICAL FREQUENCY] [SYNC TYPE]
[SYNC POLARITY] [SCAN TYPE]

[SOURCE(2)]
[SIGNAL TYPE] [VIDEO TYPE]
[BIT DEPTH] [VIDEO LEVEL]
[3D SIGNAL]

[HDBaseT]
[SIGNAL QUALITY] [OPERATION MODE]
[LINK STATUS] [HDMI STATUS]

[WIRELESS LAN]
[IP ADDRESS] [SUBNET MASK]
[GATEWAY] [MAC ADDRESS]

[WIRELESS LAN]
[IP ADDRESS] [SUBNET MASK]
[GATEWAY] [MAC ADDRESS]
[SSID] [NETWORK TYPE]
[SECURITY] [CHANNEL]
[atal LEVEL]

[VERSION(1)]

[VERSION(2)]
[FIRMWARE2] Version

[OTHERS]
[PROJECTOR NAME] [HOST NAME]
[MODEL NO.] [SERIAL NUMBER]
[LAN UNIT TYPE] [CONTROL ID] (when [CONTROL ID] is set)
4. Using On-Screen Menu

7 Menu Descriptions & Functions [RESET]

Returning to Factory Default [RESET]
The RESET feature allows you to change adjustments and settings to the factory preset for a (all) source(s) except the following:

[CURRENT SIGNAL]
 Resets the adjustments for the current signal to the factory preset levels. The items that can be reset are: [PRESET], [CONTRAST], [BRIGHTNESS], [COLOR], [HUE], [SHARPNESS], [ASPECT RATIO], [HORIZONTAL], [VERTICAL], [CLOCK], [PHASE], and [OVERSCAN].

[ALL DATA]
Reset all the adjustments and settings for all the signals to the factory preset. All items can be reset EXCEPT [LANGUAGE], [BACKGROUND], [FILTER MESSAGE], [ORIENTATION], [SERIAL PORT], [SECURITY], [COMMUNICATION SPEED], [CONTROL ID], [STANDBY MODE], [FAN MODE], [CARBON CONVERT], [CURRENCY], [CURRENTY CONVERT], [LAMP LIFE REMAINING], [LAMP HOURS USED], [FILTER HOURS USED], [TOTAL CARBON SAVINGS], [PROJECTOR NAME], [WIRED LAN], [WIRELESS LAN], [IMAGE EXPRESS UTILITY LITE], [NETWORK SERVICE], [DATE & TIME], [ADMINISTRATOR MODE], and [REMOTE DESKTOP CONNECTION].

Clearing Lamp Hour Meter [CLEAR LAMP HOURS]
Resets the lamp clock back to zero. Selecting this option displays submenu for a confirmation. Select [YES] and press the ENTER button.

NOTE: Elapsed time of the lamp use will not be affected even when [RESET] is done from the menu.

NOTE: The projector will turn off and go into standby mode when you continue to use the projector for another 100 hours after the lamp has reached the end of its life. In this condition you cannot clear the lamp hour meter on the menu. If this happens, press the HELP button on the remote control for 10 seconds to reset the lamp clock back to zero. Do this only after replacing the lamp.

Clearing the Filter Usage Hours [CLEAR FILTER HOURS]
Resets the filter usage back to zero. Selecting this option displays submenu for a confirmation. Select [YES] and press the ENTER button.

NOTE: Elapsed time of the filter use will not be affected even when [RESET] is done from the menu.
5. Installation and Connections

Setting Up the Screen and the Projector

Use this to get a general idea of what the screen size will be when set in a certain position, what size screen you will need, and what distance you will need to project images of the desired size.

The projection distance range at which focusing is possible is 0.79 m (for a 30 model) to 14.19 m (for a 300 model). Install within this range.

[P502H/P452H]

* The figures indicated for "height of screen from projector lens center" on the projection distance table are for a lens shift of 62% V.

[Reading the Table]
From the upper table on this page, to project wide images on a 150 screen, install at about 4.1 m from the front. Also, from the lower table we can see that about 2.1 m are required from the projector's lens center to the upper edge of the screen. Use this to see whether or not enough height can be provided from the projector to the ceiling and for installing the screen. The diagram shows the projection distance when the projector is installed horizontally. The projected image can be moved up and down, left and right using the lens shift function. (→ page 17)
* The figures indicated for “height of screen from projector lens center” on the projection distance table are for a lens shift of 59% V.

[Reading the Table]
From the upper table on this page, to project wide images on a 150 screen, install at about 4.1 m from the front. Also, from the lower table we can see that about 2.1 m are required from the projector’s lens center to the upper edge of the screen. Use this to see whether or not enough height can be provided from the projector to the ceiling and for installing the screen. The diagram shows the projection distance when the projector is installed horizontally. The projected image can be moved up and down, left and right using the lens shift function. (→ page 17)
## Tables of screen sizes and dimensions

### [P502H/P452H]

<table>
<thead>
<tr>
<th>Size (inches)</th>
<th>Screen width (inches)</th>
<th>Screen height (inches)</th>
<th>Screen size (diagonal)</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>26</td>
<td>15</td>
<td>66.4 (168.3)</td>
</tr>
<tr>
<td>40</td>
<td>35</td>
<td>20</td>
<td>88.6 (225.2)</td>
</tr>
<tr>
<td>50</td>
<td>44</td>
<td>25</td>
<td>110.7 (281.4)</td>
</tr>
<tr>
<td>60</td>
<td>52</td>
<td>29</td>
<td>132.8 (337.4)</td>
</tr>
<tr>
<td>80</td>
<td>70</td>
<td>39</td>
<td>177.1 (450.1)</td>
</tr>
<tr>
<td>100</td>
<td>87</td>
<td>49</td>
<td>221.4 (562.4)</td>
</tr>
<tr>
<td>120</td>
<td>105</td>
<td>59</td>
<td>265.7 (674.7)</td>
</tr>
<tr>
<td>150</td>
<td>131</td>
<td>74</td>
<td>332.1 (843.1)</td>
</tr>
<tr>
<td>200</td>
<td>174</td>
<td>98</td>
<td>442.8 (1124.4)</td>
</tr>
<tr>
<td>250</td>
<td>218</td>
<td>123</td>
<td>553.4 (1409.4)</td>
</tr>
<tr>
<td>300</td>
<td>261</td>
<td>147</td>
<td>664.1 (1686.4)</td>
</tr>
</tbody>
</table>

### [P502W/P452W]

<table>
<thead>
<tr>
<th>Size (inches)</th>
<th>Screen width (inches)</th>
<th>Screen height (inches)</th>
<th>Screen size (diagonal)</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>25</td>
<td>16</td>
<td>64.6 (164)</td>
</tr>
<tr>
<td>40</td>
<td>34</td>
<td>21</td>
<td>86.2 (219)</td>
</tr>
<tr>
<td>50</td>
<td>42</td>
<td>26</td>
<td>107.7 (273.5)</td>
</tr>
<tr>
<td>60</td>
<td>51</td>
<td>32</td>
<td>129.2 (328.3)</td>
</tr>
<tr>
<td>80</td>
<td>68</td>
<td>42</td>
<td>172.3 (437.5)</td>
</tr>
<tr>
<td>100</td>
<td>85</td>
<td>53</td>
<td>215.4 (547.5)</td>
</tr>
<tr>
<td>120</td>
<td>102</td>
<td>64</td>
<td>258.5 (657)</td>
</tr>
<tr>
<td>150</td>
<td>127</td>
<td>79</td>
<td>323.1 (820.9)</td>
</tr>
<tr>
<td>200</td>
<td>170</td>
<td>106</td>
<td>430.8 (1094.4)</td>
</tr>
<tr>
<td>250</td>
<td>212</td>
<td>132</td>
<td>538.5 (1365.5)</td>
</tr>
<tr>
<td>300</td>
<td>254</td>
<td>159</td>
<td>646.2 (1644.7)</td>
</tr>
</tbody>
</table>
Example of installation on a desktop

The diagram below shows an example of when the projector is used on a desktop.
Horizontal projection position: Equal distance to the left and right from the center of the lens
Vertical projection position: (see table below)

<table>
<thead>
<tr>
<th>Screen size (inches)</th>
<th>Throw distance L</th>
<th>Height H</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Wide</td>
<td>Tele</td>
</tr>
<tr>
<td></td>
<td>(inches)</td>
<td>(m)</td>
</tr>
<tr>
<td>30</td>
<td>31</td>
<td>0.79</td>
</tr>
<tr>
<td>40</td>
<td>42</td>
<td>1.07</td>
</tr>
<tr>
<td>50</td>
<td>53</td>
<td>1.34</td>
</tr>
<tr>
<td>60</td>
<td>64</td>
<td>1.62</td>
</tr>
<tr>
<td>80</td>
<td>86</td>
<td>2.17</td>
</tr>
<tr>
<td>100</td>
<td>107</td>
<td>2.72</td>
</tr>
<tr>
<td>120</td>
<td>129</td>
<td>3.28</td>
</tr>
<tr>
<td>150</td>
<td>162</td>
<td>4.11</td>
</tr>
<tr>
<td>200</td>
<td>216</td>
<td>5.49</td>
</tr>
<tr>
<td>250</td>
<td>270</td>
<td>6.87</td>
</tr>
<tr>
<td>300</td>
<td>325</td>
<td>8.25</td>
</tr>
</tbody>
</table>

[Note] Height from lens center to lower edge of screen (with tilt feet screwed in)
Lens shifting range
This projector is equipped with a lens shift function (→ page 17) for adjusting the image position using dials. Lens shifting is possible within the range shown below.

**NOTE:**
- In case lens shifted volume exceeds the below illustrated range, blur and shade may appear around ends of projected image.

Legend: V “Vertical” refers to the screen height and H “Horizontal” refers to the screen width. The lens shift range is expressed as a ratio of height and width, respectively.

**[P502H/P452H]**
Lens shifting range:
- Vertical direction: +62%, −0%
- Horizontal direction: ±25%

**[P502W/P452W]**
Lens shifting range:
- Vertical direction: +59%, −0%
- Horizontal direction: ±28%

* The lens shift range is the same for ceiling installation.
(Example) When using to project on a 150” screen

**[P502H/P452H]**
According to the “Table of screen sizes and dimensions” (→ page 71), \( H = 130.8”/332.1 \text{ cm}, V = 73.6”/186.8 \text{ cm} \).
Adjustment range in the vertical direction: the projected image can be moved upwards \( 0.62 \times 73.6”/186.8 \text{ cm} = 45.3”/115 \text{ cm} \) (when the lens is at the center position).
Adjustment range in the horizontal direction: the projected image can be moved to the left \( 0.25 \times 130.8”/332.1 \text{ cm} = 32.7”/83 \text{ cm} \), to the right approximately 32.7”/83 cm.

**[P502W/P452W]**
According to the “Table of screen sizes and dimensions” (→ page 71), \( H = 127.3”/323.1 \text{ cm}, V = 79.5”/201.9 \text{ cm} \).
Adjustment range in the vertical direction: the projected image can be moved upwards \( 0.59 \times 79.5”/201.9 \text{ cm} = 46.9”/119 \text{ cm} \) (when the lens is at the center position).
Adjustment range in the horizontal direction: the projected image can be moved to the left \( 0.28 \times 127.3”/323.1 \text{ cm} = 35.4”/90 \text{ cm} \), to the right approximately 35.4”/90 cm.

* Figures differ by several % because the calculation is approximate.

**WARNING**
* Installing your projector on the ceiling must be done by a qualified technician. Contact your NEC dealer for more information.
* Do not attempt to install the projector yourself,
  - Only use your projector on a solid, level surface. If the projector falls to the ground, you can be injured and the projector severely damaged.
  - Do not use the projector where temperatures vary greatly. The projector must be used at temperatures between 41°F (5°C) and 104°F (40°C) (Eco mode selected automatically at 95°F to 104°F/35°C to 40°C).
  - Do not expose the projector to moisture, dust, or smoke. This will harm the screen image.
  - Ensure that you have adequate ventilation around your projector so heat can dissipate. Do not cover the vents on the side or the front of the projector.

**Reflecting the Image**
Using a mirror to reflect your projector’s image enables you to enjoy a much larger image when a smaller space is required. Contact your NEC dealer if you need a mirror system. If you’re using a mirror system and your image is inverted, use the MENU and ▲▼◄► buttons on your projector cabinet or your remote control to correct the orientation. (→ page 55)
5. Installation and Connections

Making Connections

Connecting Your Computer

Computer cables and HDMI can be used to connect to a computer. The HDMI cable is not enclosed with the projector. Please get ready a suitable cable for the connection.

NOTE: Signals supported by Plug & Play (DDC2)

<table>
<thead>
<tr>
<th>INPUT</th>
<th>COMPUTER IN</th>
<th>HDMI 1 IN</th>
<th>HDMI 2 IN</th>
</tr>
</thead>
<tbody>
<tr>
<td>analog</td>
<td>digital</td>
<td>digital</td>
<td></td>
</tr>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

NOTE: For Mac, use a commercially available pin adapter (not supplied) to connect to your Mac's video port.

- Select the source name for its appropriate input terminal after turning on the projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI 1 IN</td>
<td>HDMI1</td>
<td>(HDMI 1*)</td>
</tr>
<tr>
<td>HDMI 2 IN</td>
<td>HDMI2</td>
<td>(HDMI 2*)</td>
</tr>
<tr>
<td>COMPUTER IN</td>
<td>COMPUTER</td>
<td>(COMPUTER 1)</td>
</tr>
</tbody>
</table>
5. Installation and Connections

NOTE: The projector is not compatible with video decoded outputs of the NEC ISS-6020 switcher.

NOTE: An image may not be displayed correctly when a Video source is played back via a commercially available scan converter. This is because the projector will process a video signal as a computer signal at the default setting. In that case, do the following.

* When an image is displayed with the lower and upper black portion of the screen or a dark image is not displayed correctly:
  - Project an image to fill the screen and then press the AUTO ADJ. button on the remote control or the projector cabinet.

Enabling the computer’s external display
Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projector. When using a PC compatible laptop, a combination of function keys will enable/disable the external display.

Usually, the combination of the “Fn” key along with one of the 12 function keys gets the external display to come on or off. For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through external display selections.

Cautions when using a DVI signal
- When the computer has a DVI output terminal, use a commercially available converter cable to connect the computer to the projector’s HDMI 1 IN or HDMI 2 IN terminal (only digital video signals can be input).

NOTE: When Viewing a DVI Digital Signal
- Turn off the power of the computer and projector before connecting.
- When a video deck is connected via a scan converter, etc., the display may not be correct during fast-forwarding and rewinding.
- Use a DVI-to-HDMI cable compliant with DDWG (Digital Display Working Group) DVI (Digital Visual Interface) revision 1.0 standard.
  - The cable should be within 197/5 m long.
- Turn off the projector and the PC before connecting the DVI-to-HDMI cable.
- To project a DVI digital signal: Connect the cables, turn the projector on, then select the HDMI input. Finally, turn on your PC. Failure to do so may not activate the digital output of the graphics card resulting in no picture being displayed. Should this happen, restart your PC.
- Do not disconnect the DVI-to-HDMI cable while the projector is running. If the signal cable has been disconnected and then reconnected, an image may not be correctly displayed. Should this happen, restart your PC.
- The COMPUTER video input terminals support Windows Plug and Play.
- A Mac signal adapter (commercially available) may be required to connect a Mac computer.
Connecting an External Monitor

You can connect a separate, external monitor to your projector to simultaneously view on a monitor the computer analog image you’re projecting.

NOTE:
- The AUDIO OUT mini jack does not support Headphone terminal.
- When audio equipment is connected, the projector speaker is disabled.
- The signal output from the MONITOR OUT (COMP.) of this projector is for projecting image on exclusive one display.
- When no signal is applied over 3 minutes in the condition of projector standby when NETWORK STANDBY is set in the Standby mode, output from the MONITOR OUT (COMP.) or AUDIO OUT terminal will be stopped. In this case pull out the computer cable and set it back after inputting video signal

Monitor out and sleep mode:
- The MONITOR OUT (COMP.) terminal will not work when [NORMAL] is selected for [STANDBY MODE].
- The MONITOR OUT (COMP.) terminal will work only in the sleep mode.
- Applying a signal from the COMPUTER IN terminal will put the projector in the sleep mode, which allows you to use the MONITOR OUT (COMP.) terminal and the AUDIO OUT mini jack.
- The sleep mode is one of the standby modes. The sleep mode cannot be selected from the menu.
- In the network standby mode, sound for the last viewed computer or video source will be heard.
- BNC-to- COMPUTER IN terminal converted signal will not be output in the standby mode and sleep mode.
Connecting Your DVD Player or Other AV Equipment

Connecting Video Input

- Select the source name for its appropriate input terminal after turning on the projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIDEO IN</td>
<td>VIDEO</td>
<td>(VIDEO)</td>
</tr>
</tbody>
</table>

**NOTE:** Refer to your VCR owner’s manual for more information about your equipment’s video output requirements.

**NOTE:** An image may not be displayed correctly when a Video source is played back in fast-forward or fast-rewind via a scan converter.
Connecting Component Input

Connection for component signal. Signal from the color difference signal output terminal on DVD players (DVD video output) and the YPbPr output terminal on the Hi-vision video can be projected. Recommend to connect the terminal for audio output on the DVD player to the audio components.

**NOTE:** Refer to your DVD player's owner's manual for more information about your DVD player's video output requirements.
Connecting HDMI Input
You can connect the HDMI output of your DVD player, hard disk player, Blu-ray player, or notebook type PC to the HDMI IN terminal of your projector.

- Select the source name for its appropriate input terminal after turning on the projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI 1 IN</td>
<td>HDMI1</td>
<td>(HDMI1*)</td>
</tr>
<tr>
<td>HDMI 2 IN</td>
<td>HDMI2</td>
<td>(HDMI2*)</td>
</tr>
</tbody>
</table>

- When connecting the HDMI 1 IN terminal (or HDMI 2 IN terminal) of the projector to the DVD player, the projector’s video level can be made settings in accordance with the DVD player’s video level. In the menu select [HDMI SETTINGS] → [VIDEO LEVEL] and make necessary settings.
- If the HDMI input sound cannot be heard, in the menu select [AUDIO SELECT] → [HDMI1] or [HDMI2]. (→ page 60)
Connecting your document camera

You can connect your document camera and project printed documents, etc.

- Select the source name for its appropriate input terminal after turning on the projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPUTER IN</td>
<td>📡 COMPUTER</td>
<td>(COMPUTER 1)</td>
</tr>
<tr>
<td>VIDEO IN</td>
<td>🎥 VIDEO</td>
<td>(VIDEO)</td>
</tr>
</tbody>
</table>

Name, position, and direction of terminals are vary depending on camera model. Please check user’s manual of your camera for details.
Connecting to a Wired LAN

The projector comes standard with the Ethernet/HDBaseT port (RJ-45) and the LAN port which provide a LAN connection using a LAN cable.

To use a LAN connection, you are required to set the wired LAN settings on the projector menu. Select [SETUP] → [INSTALLATION] → [NETWORK SETTINGS]. (→ page 58).

The network settings can also be selected from the APPS menu.

Example of LAN connection

Example of wired LAN connection

NOTE:

• About the projector’s Ethernet/HDBaseT and LAN ports
  The Ethernet/HDBaseT and LAN ports are the same, aside from the HDBaseT function. To connect to the LAN, use only 1 of the ports (it is not possible to connect both ports to the LAN).
  For controlling the projector by a HDBaseT transmitter whose control signal is not supported (or with which cannot connect the projector) or over the network, connect to the LAN port. At the same time, for controlling the projector over the network that is in the state of the NETWORK STANDBY On, connect to the LAN port.
Connecting to a Wireless LAN (Optional: NP05LM series)
The USB Wireless LAN Unit also provides a wireless LAN connection. To use a wireless LAN connection, you are required to assign an IP address to the projector.

Important:
- If you use the projector with the USB Wireless LAN Unit in the area where the use of wireless LAN equipment is prohibited, remove the USB Wireless LAN Unit from the projector.
- Buy the appropriate USB Wireless LAN Unit for your country or area.

NOTE:
- Your computer’s wireless LAN adapter (or unit) must be complied with Wi-Fi (IEEE802.11a/b/g/n) standard.

Attaching the USB Wireless LAN Unit

NOTE:
- The USB Wireless LAN Unit must be inserted into the USB Wireless LAN Unit port in the correct direction. It cannot be inserted in the reverse direction. If the USB Wireless LAN Unit is inserted in the reverse direction with excessive force applied, the USB port may break.
- Before touching the USB Wireless LAN Unit, touch a metallic object (such as a door knob or aluminum window frame) to discharge the static electricity from your body.
- Always insert or remove the USB Wireless LAN unit when the main power is turned off. Failure to do so may cause projector malfunction or damage to the USB wireless LAN unit. If the projector will not work correctly, turn off the projector, disconnect the power cord, and then connect it again.
- Do not insert other USB devices into the USB (wireless LAN) port in the wireless LAN cover. Do not insert the USB Wireless LAN unit into the USB port.

NOTE: When the cable cover is attached, remove it before inserting the USB Wireless LAN Unit.

Prepare a Phillips screw driver beforehand.

1. Press the POWER button to turn off the projector and set it into standby condition, and disconnect the power cord.
2. Remove the wireless LAN cover.
   Turn the wireless LAN cover fixing screw counterclockwise and then take it off from the projector.

3. Insert the wireless LAN unit into the USB (wireless LAN) port.
   NOTE: Do not force to insert the USB Wireless LAN Unit.
4. Mount the wireless LAN cover.
(1) Insert the hook on the back of the cover into the groove in the projector and close the wireless LAN cover.
(2) Turn the screw clockwise to tighten it.

* To remove the USB Wireless LAN Unit, disconnect the power cord and use the above procedure.

NOTE:
• Do not press the button on the USB Wireless LAN Unit. The button does not work with this model.
Example of wireless LAN connection

To use a LAN connection, you are required to set the Wireless LAN settings on the projector menu. Select [SETUP] → [INSTALLATION] → [NETWORK SETTINGS]. (→ page 58).

The network settings can also be selected from the APPS menu.
Connecting to a HDBaseT transmission device (sold commercially)

HDBaseT is a connection standard for home appliances that is established by the HDBaseT Alliance. Use a LAN cable sold commercially to connect the Ethernet / HDBaseT port of the projector (RJ-45) to a HDBaseT transmission device sold commercially. Control signals (serial and LAN) and remote control signals (IR commands) from an external device are only supported when the projector’s power is turned on.

Connection example

NOTE:
- Please use a shielded twisted pair (STP) cable of Category 5e or higher for the LAN cable (sold commercially).
- The maximum transmission distance over the LAN cable is 100 m.
- Please do not use other transmission devices between the projector and the HDBaseT transmission device. The picture quality may be deteriorated as a result.
- This projector is not guaranteed to work with all HDBaseT transmission devices sold commercially.
5. Installation and Connections

TIP:
- With the projector’s Ethernet/HDBaseT port, remote control is not available when the projector is in the standby mode (serial communications is not available). (Remote control becomes available when the projector’s power is on). The 2 (two) methods below can be used to turn on the projector’s power when it is in standby mode.

1. The projector can be operated by connecting the computer and projector to the network (on the projector, using the LAN port and PC Control Utility application with [STANDBY MODE] set to [NETWORK STANDBY] (→ page 101).

![Diagram of connections]

2. The projector can be operated by RS232C serial communication (On this projector, use the PC CONTROL terminal and the application software, PC Control Utility, and select [PC CONTROL] for the [SERIAL PORT]) with [STANDBY MODE] set to [NETWORK STANDBY].
6. APPS MENU

What can you do with the APPS MENU?

It becomes available to select the expansion functions indicated in below and various setting with the APPS MENU. For displaying the APPS MENU, press the APPS button on the remote or select [APPS] as the [SOURCE] on the onscreen menu.

INFORMATION
Detailed information about each function on the APPS MENU is explained on our web site. Please search it by the model name of your projector.

APPS MENU screen display

REMOTE DESKTOP CONNECTION

VIEWER

IMAGE EXPRESS UTILITY

Miracast

Current date and time
Important: Before utilizing the function of APPS MENU, set day and time.

FOCUS
Indicating the selected item.
Surrounded in a yellow square.

Wireless LAN profile selection

NETWORK SETTINGS

TOOLS

WEB SHARING SETTING/DISPLAYING ACCESS PASSWORD

NOTE:
• When this projector is not in a network, you cannot select [REMOTE DESKTOP CONNECTION], [IMAGE EXPRESS UTILITY], [Miracast], and [WEB SHARING].
VIEWER
Select the saved images/movies and project them by the projector. This function is available for explained below:
(1) Projector Memory: Images and movies temporarily saved in the projector’s built-in memory utilizing the WEB SHARING.
(2) USB Memory: Images and movies saved in the USB memory connected with the projector.
(3) Shared Folder: Images and movies saved in the shared folder in a network connected with the projector.

REMOTE DESKTOP CONNECTION
• Select the computer connected in the same network with the projector, and the projector projects the images on the computer over the network.
  A commercially available USB keyboard can be used for controlling Windows 8 and Windows 7 computers connected in the network with the projector.

IMAGE EXPRESS UTILITY
• If various terminal units such as a computer, a smartphone, and a tablet are connected with the projector in the network, it enables to transmit images saved on each terminal to the projector and to project them.
• You can connect terminal units in multiple OS (Windows, OS X, Android, and iOS) with the projector simultaneously.
• The projector receives images transmitted from multiple terminal units (Max. 50 units) and projects them on the screen dividing it (Max. 4 × 4) at the same time.

• Install the application software “Image Express Utility Lite”, included in the CD-ROM supplied with the projector on computers. (→ page 94, 97)
• For a smartphone and a tablet, download the application “Wireless Image Utility” from our web site and install it on these. (→ page 112)

Miracast
By wirelessly connecting the terminal units supporting the Miracast such as the Android with the projector, it enables the projector to project images transmitted from these terminals.
Before connecting these terminal units, set [Miracast] in the [NETWORK SETTINGS] on the projector.
WEB SERVER FUNCTION

WEB SHARING
Without using the exclusive software, it enables to share images and files among the projector and computers in the same network by accessing the web server of the projector utilizing the web browser.

IMAGE EXPRESS UTILITY LITE
It enables to control screen splitting pattern and displaying position of the images that are simultaneously transmitted from each terminal utilizing the application software, Image Express Utility Lite or Wireless Image Utility, on the computer browser screen. Precise controls as changing number of screen portions and pages to display are available.

PROJECTOR CONTROL
It enables to control the projector on the web browser screens on the computers.

HOW TO ACCESS THE WEB SERVER
Connect the projector and computers in a network and access the URL in below by the web browser of the computers.
URL: http://<IP address of the projector>

NETWORK SETTINGS
Set up below for connecting the projector with a wired/wireless LAN.

PROJECTOR NAME
Set up the projector name and host name. Serial number of the projector is set as factory default.

NETWORK INFORMATION
Indicate information when the projector has connected in a network (by a wired/wireless LAN)

WIRED LAN
Set up for connecting the projector by a wired LAN.

WIRELESS LAN
Set up for connecting the projector by a wireless LAN. At the same time, set up for the SIMPLE ACCESS POINT, Wi-Fi Direct, and Miracast.

IMAGE EXPRESS UTILITY
Set up the MODE (FREE, MANAGED) for the IMAGE EXPRESS UTILITY.

NETWORK SERVICE
Set up various setting for the AMX, HTTP server, PJLink, Alert mail and CRESTRON.
6. APPS MENU

TOOLS
Set up for various features as the mouse, program timer, day and time, administrator mode and default APP.

MOUSE
A commercially available USB mouse can be used for operating the APPS MENU. Perform the set up for using it.

PROGRAM TIMER
Once day and time is set up, changing the projector’s condition in powering ON/standby, switching input signals, and switching ECO mode can be automatically performed.

DATE AND TIME
Set up current date and time to the projector.

ADMINISTRATOR MODE
Selecting the menu mode of the projector, enable/disable to save all set up values of the projector, and set up a password for the administrator mode.

DEFAULT APP
When a terminal other than the “APPS” terminal is selected and you switch to the “APPS” terminal, the function selected as the default application is launched automatically.
When the projector is turned on in the condition of being selected the “APPS” terminal, the application selected in the [DEFAULT APP] will be started automatically.
## 7. User Supportware

### Software Included on CD-ROM

Names and Features of Bundled Software Programs

<table>
<thead>
<tr>
<th>Name of software program</th>
<th>Features</th>
</tr>
</thead>
</table>
| Image Express Utility Lite (for Mac) | • This is a software program used to project your computer’s screen over the wired/wireless network. The computer cable (VGA) is not required. (→ page 93)  
• This software program can be used to control the power ON/OFF and source selection of the projector from your computer.  
• The Geometric Correction Tool (GCT) function allows you to correct distortion of images projected on a curved wall. (→ page 98)  
• “GCT” function is not supported by Mac. |
| PC Control Utility Pro 4 | |
| PC Control Utility Pro 5 (for Mac OS) | This is a software program used to operate the projector from the computer when the computer and the projector are connected with LAN (wired or wireless) or a serial cable. (→ page 101) |
| Virtual Remote Tool (Windows only) | This is a software program used to control the power ON/OFF and source selection of the projector from your computer by using the supplied computer cable (VGA) and others. (→ page 106)  
Only via serial connection it is also used to send an image to the projector and register it as the logo data of the projector. After registering it, you can lock the logo to prevent it from changing. |

**NOTE:**
- *Image Express Utility Lite does not support “Meeting Mode” in Image Express Utility 2.0 supplied with our other models.*

### Download Service and Operating Environment

Please visit our website about operating environment and download service for each software:
Download - Projector → Software & Driver

### Name and Features of an application for Android / iOS.

Name of application:
Wireless Image Utility (Android / iOS)
Features:
By connecting the projector with a smartphone, it enables to transfer photos and documents saved on the smartphone and project these on the projector. (→ page 112)
* Wireless Image Utility is not contained in the supplied CD-ROM.
Projecting Your Computer’s Screen Image from the Projector over a LAN (Image Express Utility Lite)

Using Image Express Utility Lite contained on the supplied NEC Projector CD-ROM allows you to send the computer’s screen image to the projector over a wired or wireless LAN. Image Express Utility Lite is a program compatible with Windows. Image Express Utility Lite for Mac is a program compatible with OS X. (→ page 97)

This section will show you an outline about how to connect the projector to a LAN and to use Image Express Utility Lite. For the operation of Image Express Utility Lite, see the help of Image Express Utility Lite.

Step 1: install Image Express Utility Lite on the computer.
Step 2: Connect the projector to a LAN.
Step 3: Start Image Express Utility Lite.

TIP:
• Image Express Utility Lite (for Windows) can be started from most commercially available removable media such as USB memory devices or SD cards without the need to install on your computer. (→ page 96)

What You can Do with Image Express Utility Lite

Image transmission (for Windows and OS X)
• The screen of your computer can be sent to the projector via a wired or wireless network without a computer cable (VGA).

Audio transfer capability (for Windows only)
• Image Express Utility Lite allows you to send the computer’s screen image and audio to the projector over wired/ wireless LAN connection.
• Audio transfer capability is available only when the computer connects with the projector in peer-to-peer network.

Geometric Correction Tool [GCT] (for Windows only)
See “Projecting an Image from an Angle (Geometric Correction Tool in Image Express Utility Lite)”. (→ page 98)
Using on Windows

Step 1: install Image Express Utility Lite on the computer.

NOTE:
• To install or uninstall the program, the Windows user account must have “Administrator” privilege.
• Exit all running programs before installation. If another program is running, the installation may not be completed.
• Image Express Utility Lite will be installed to the system drive of your computer.
  If the message “There is not enough free space on destination” is displayed, free up enough space (about 100 MB) to install the program.

1. Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.
   The menu window will be displayed.

TIP:
If the menu window will not be displayed, try the following procedure.
For Windows 7:
1. Click “start” on Windows.
2. Click “All Programs” → “Accessories” → “Run”.
3. Type your CD-ROM drive name (example: “Q:\”) and “LAUNCHER.EXE” in “Name”. (example: Q:\LAUNCHER.EXE)
4. Click “OK”.
   The menu window will be displayed.

2. Click “Installing Image Express Utility Lite” on the menu window.
   The installation will start.
   “END USER LICENSE AGREEMENT” screen will be displayed.
   Read “END USER LICENSE AGREEMENT” carefully

3. If you agree, click “I agree.” and then click “Next”.
   • Follow the instructions on the installer screens to complete the installation.
   • When the installation is complete, you will return to the menu window.
   When the installation is complete, a completion message will be displayed.

4. Click “OK”.
   This completes the installation.

TIP:
• Uninstalling Image Express Utility Lite
To uninstall Image Express Utility Lite, do the same procedures stated as in “Uninstalling Virtual Remote Tool”. Read “Virtual Remote Tool” as “Image Express Utility Lite” (→ page 109)
Step 2: Connect the projector to a LAN.
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 82) and “Connecting to a Wireless LAN (Optional: NP05LM series)” (→ page 83).

Step 3: Start Image Express Utility Lite.
1. On Windows, click “Start” → “All programs” → “NEC Projector UserSupportware” → “Image Express Utility Lite” → “Image Express Utility Lite”.
   Image Express Utility Lite will start.
   The select window for network connection will be displayed
2. Select Network and click “OK”.
   The select window for destination will show a list of connectable projectors.
   • When connecting the computer directly to the projector by one-to-one, “Simple Access Point” is recommended.
   • To check for the network available for connected projectors, from the menu, select [INFO.] → [WIRELESS LAN] → [SSID].
3. Place a check mark for projectors to be connected, and then click “Connect”.
   • When one or more projectors are displayed, from the menu on the projector, select [INFO.] → [WIRELESS LAN] → [IP ADDRESS].
When connected to the projector, the Image Express Utility Lite control window appears at the top of the screen. The computer can be controlled by operating the control window.
4. Operate the control window.

(1) (Streaming) ..... This icon is not available on this projector.
(2) (Source) .......... Selects an input source of the projector.
(3) (Picture) ......... Turns on or off AV-MUTE (Picture mute), FREEZE (Freeze a picture), display, and GCT (geometric correction tool). Refer to page 98 about GCT.
(4) (Sound) .......... Turns on or off AV-MUTE (Sound mute), play the sound and control the volume.
(5) (Others) ........... Uses for “Update”, “HTTP Server”, “Settings” and “Information”.
(6) (Project) ......... Enables to change screen size for presentation, menu indication (hide/indicate), interruption prohibition/accept interruption.
   It also enables to power off the projector.
(7) (Help) ............... Displays the help of Image Express Utility Lite.

NOTE:
• When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector that is turned off will not be displayed in the select window for destination
TIP:

Viewing the “Help” file of Image Express Utility Lite

• **Displaying the Help file of Image Express Utility Lite while it is running.**
  
  Click the [?] (help) icon on the control window.
  
  The Help screen will be displayed.

• **Displaying the Help file of GCT while it is running.**
  
  Click “Help” → “Help” on the edit window.
  
  The Help screen will be displayed.

• **Displaying the help file using the Start Menu.**
  
  Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “Image Express Utility Lite” → “Image Express Utility Lite Help”.
  
  The Help screen will be displayed.

---

**Starting Image Express Utility Lite from a USB Memory or SD Card**

Image Express Utility Lite can be started from commercially available removable media such USB memory or SD cards if it is copied beforehand. This will eliminate the trouble of installing Image Express Utility Lite to your computer.

1. **Copy Image Express Utility Lite to removable media.**
   
   Copy all the folders and files (total size approx. 7 MB) from the “IEU_Lite (removable-media)” folder in the supplied NEC Projector CD-ROM to the root directory of your removable media.

2. **Insert your removable media into your computer.**
   
   The “AutoPlay” screen will be displayed on your computer.

   **TIP:**
   
   • If the “AutoPlay” screen is not displayed, open the folder from “Computer” (“My Computer” for Windows XP).

3. **Click “Open folder to view files”**
   
   The IEU_Lite.exe, other folder, and files will be displayed.

4. **Double-click the “IEU_Lite.exe” ( ) icon.**
   
   Image Express Utility Lite will start.
7. User Supportware

Using on Mac

Step 1: Install Image Express Utility Lite for Mac on the computer
1. Insert the accompanying NEC Projector CD-ROM in your Mac CD-ROM drive.
   The CD-ROM icon will be displayed on the desktop.
2. Double-click the CD-ROM icon.
   The CD-ROM window will be displayed.
3. Double-click the “Mac OS X” folder.
4. Double-click “Image Express Utility Lite.dmg”.
   The “Image Express Utility Lite” window will be displayed.
5. Drag and drop the “Image Express Utility Lite” folder to your Applications folder on OS X.

Step 2: Connect the projector to a LAN
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 82) and “Connecting to a Wireless LAN (Optional: NP05LM series)” (→ page 83).

Step 3: Start Image Express Utility Lite for Mac
1. Open your Applications folder on OS X.
2. Double-click the “Image Express Utility Lite” folder.
3. Double-click the “Image Express Utility Lite” icon.
   When Image Express Utility Lite for Mac starts, the select window for destination will be displayed.
   • At the first time of startup, “END USER LICENSE AGREEMENT” screen will be displayed before the select window for destination is displayed.
     Read “END USER LICENSE AGREEMENT” and select “I accept the terms in the license agreement”, and click “OK”.
4. Select a projector to be connected, and then click “Connect”.
   Your desktop screen will be displayed on the projector.

   Tip:
   Viewing the Help of Image Express Utility Lite for Mac
   • From the menu bar, click “Help” → “Image Express Utility Lite Help” while Image Express Utility for Mac is running.
     The Help screen will be displayed

Uninstalling a software program
1. Put the “Image Express Utility Lite” folder to the Trash icon.
2. Put the configuration file of Image Express Utility Lite for Mac to the Trash icon.
   • The configuration file of Image Express Utility Lite for Mac is located in “/Users/<your user name>/Library/Preferences/jp.necds.Image_Express_Utility_Lite.plist”.

---

97
Projecting an Image from an Angle (Geometric Correction Tool in Image Express Utility Lite)

What you can do with GCT

- The GCT feature includes the following three functions
  - **4-point Correction**: You can fit a projected image within the border of the screen easily by align the four corners of an image to the ones of the screen.
  - **Multi-point Correction**: You can correct a distorted image on the corner of a wall or irregular shaped screen by using many separated screens to correct the image as well as 4-point Correction.
  - **Parameters Correction**: You can correct a distorted image by using a combination of transformational rules prepared in advance.

This section will show an example for use with 4-point Correction.
For information about “Multi-point Correction” and “Parameters Correction”, see the help file of Image Express Utility Lite. (→ page 96, 97)

- Your correction data can be stored in the projector or your computer which can be restored when necessary.
- The GCT function is available with a wired or wireless LAN connection, and video cable.

### Projecting an Image from an Angle (GCT)

Install Image Express Utility Lite on the computer and launch it to display the control window. (→ page 94, 95)

Preparation: Adjust the projector position or the zoom so that the projected image can cover the whole screen area.

1. **Click the “Others” icon and then the “Options” button.**
   
   ![Options window](image)

   *Options window will be displayed.*

2. **Click the check box “Use the multiple connection feature” and then clear the check mark.**

   ![Options window](image)

3. **Click the “OK” button.**
4. **Click the “” (Projection) icon and then the “” (Exit) button.**

5. **Click “Yes”.**

6. **Start the Image Express Utility Lite again.**

7. **Click the “” (Picture) icon and then the “” button.**

The “4-point Correction” window will be displayed.

8. **Click the “Start Correction” button and then “Start 4-point Correction” button.**

A green frame and a mouse pointer ( ) will be displayed.

   • Four [ ] marks will be appeared at four corners of the green frame

9. **Use the mouse to click the [ ] mark of which corner you wish to move.**

   The currently selected [ ] mark will turn red.

   (In the above example, Windows screens are omitted for clarification.)
10. Drag the selected [●] mark to the point you wish to correct and drop it.
   - When you click somewhere within the project image area, the nearest [●] mark will go to the position where the mouse cursor is.

11. Repeat Step 9 and 10 to correct the distortion of the projected image.

12. After completing, right-click the mouse.
    The green frame and the mouse pointer will disappear from the projected image area. This will complete the correction.

13. Click the “X” (close) button on the “4-point Correction” window.
    The “4-point Correction” window will disappear and the 4-point correction will take effect.

14. Click the “ ” button on the control window to exit the GCT.

TIP:
- After performing the 4-point correction, you can save the 4-point correction data to the projector by clicking “File” → “Export to the projector…” on the “4-point Correction” window.
- See the Help of Image Express Utility Lite for operating “4-point Correction” window and other functions than GCT. (→ page 96, 97)
Controlling the Projector over a LAN (PC Control Utility Pro 4/Pro 5)

Using the utility software “PC Control Utility Pro 4” and “PC Control Utility Pro 5” included on the companion NEC Projector CD-ROM, the projector can be controlled from a computer over a LAN.

PC Control Utility Pro 4 is a program compatible with Windows. (→ this page)
PC Control Utility Pro 5 is a program compatible with Mac OS. (→ page 104)

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, audio mute, adjusting, error message notification, event schedule.

Screen of PC Control Utility Pro 4

This section provides an outline of preparation for use of PC Control Utility Pro 4/Pro 5. For information on how to use PC Control Utility Pro 4/Pro 5, see Help of PC Control Utility Pro 4/Pro 5. (→ page 103, 105)

Step 1: Install PC Control Utility Pro 4/Pro 5 on the computer.
Step 2: Connect the projector to a LAN.
Step 3: Start PC Control Utility Pro 4/Pro 5.

- To run PC Control Utility Pro 4 on Windows 8.1, Windows 8 and Windows XP, “Microsoft .NET Framework Version 2.0” is required. The Microsoft .NET Framework Version 2.0, 3.0 or 3.5 is available from Microsoft’s web page. Download and install it on your computer.

TIP:
- With PC Control Utility Pro 4, control is also possible by RS-232C serial communications connected to the projector’s PC CONTROL terminal.

Using on Windows

**Step 1: Install PC Control Utility Pro 4 on the computer**

**NOTE:**
- To install or uninstall the program, the Windows user account must have [Administrator] privilege.
- Exit all running programs before installation. If another program is running, the installation may not be completed.

1. Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.
   The menu window will be displayed.
TIP:
If the menu window will not be displayed, try the following procedure.

For Windows 7:
1. Click “start” on Windows.
2. Click “All Programs” → “Accessories” → “Run”.
3. Type your CD-ROM drive name (example: “Q:" ) and “LAUNCHER.EXE” in “Name”. (example: Q:\LAUNCHER.EXE)
4. Click “OK”.
   The menu window will be displayed.

2 Click “PC Control Utility Pro 4” on the menu window.
The installation will start.

When the installation is complete, the Welcome window will be displayed.

3 Click “Next”.
“END USER LICENSE AGREEMENT” screen will be displayed.

Read “END USER LICENSE AGREEMENT” carefully.

4 If you agree, click “I accept the terms in the license agreement” and then click “Next”.
   • Follow the instructions on the installer screens to complete the installation.
   • When the installation is complete, you will return to the menu window.

TIP:
• Uninstalling PC Control Utility Pro 4
To uninstall PC Control Utility Pro 4, do the same procedures stated as in “Uninstalling Virtual Remote Tool”. Read “Virtual Remote Tool” as “PC Control Utility Pro 4” (→ page 109)
Step 2: Connect the projector to a LAN.

Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 82) and “Connecting to a Wireless LAN (Optional: NP05LM series)” (→ page 83).

Step 3: Start PC Control Utility Pro 4

Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → “PC Control Utility Pro 4”.

NOTE:

• For the Schedule function of the PC Control utility Pro 4 to work, you must have your computer running and not in standby/sleep mode. Select “Power Options” from the “Control Panel” in Windows and disable its standby/sleep mode before running the scheduler.
  [Example] For Windows 7:
  Select “Control Panel” → “System and Security” → “Power Options” → “Change when the computer sleeps” → “Put the computer to sleep” → “Never”.

NOTE:

• When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network (wired LAN/wireless LAN) connection.

TIP:

Viewing the Help of PC Control Utility Pro 4

• Displaying the Help file of PC Control Utility Pro 4 while it is running.
  Click “Help (H)” → “Help (H) …” of window of PC Control Utility Pro 4 in this order.
  The pop-up menu will be displayed.

• Displaying the help file using the Start Menu.
  Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → “PC Control Utility Pro 4 Help”.
  The Help screen will be displayed.
Using on Mac

Step 1: Install PC Control Utility Pro 5 on the computer

1. Insert the accompanying NEC Projector CD-ROM in your Mac CD-ROM drive.
   The CD-ROM icon will be displayed on the desktop.

2. Double-click the CD-ROM icon.
   The CD-ROM window will be displayed.

3. Double-click the “Mac OS X” folder.

4. Double-click “PC Control Utility Pro 5.pkg”.
   The installer will start.

5. Click “Next”.
   “END USER LICENSE AGREEMENT” screen will be displayed.

6. Read “END USER LICENSE AGREEMENT” and click “Next”.
   The confirmation window will be displayed

7. Click “I accept the terms in the license agreement”.
   Follow the instructions on the installer screens to complete the installation.

Step 2: Connect the projector to a LAN

Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 82) and “Connecting to a Wireless LAN (Optional: NP05LM series)” (→ page 83).

Step 3: Start PC Control Utility Pro 5

1. Open your Applications folder in OS X.

2. Click the “PC Control Utility Pro 5” folder.

3. Click the “PC Control Utility Pro 5” icon.
   PC Control Utility Pro 5 will start.

NOTE:

- For the Schedule function of the PC Control utility Pro 5 to work, you must have your computer running and not in sleep mode. Select “Energy Saver” from the “System Preferences” in Mac and disable its sleep mode before running the scheduler.

- When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network (wired LAN/wireless LAN) connection.
**TIP:**

**Uninstalling a software program**
1. **Put the “PC Control Utility Pro 5” folder to the Trash icon.**
2. **Put the configuration file of PC Control Utility Pro 5 to the Trash icon.**
   - The configuration file of PC Control Utility Pro 5 is located in “/Users/<your user name>/Application Data/NEC Projector User Supportware/PC Control Utility Pro 5”.

**Viewing the Help of PC Control Utility Pro 5**
• Displaying the Help file of PC Control Utility Pro 5 while it is running.
  - **From the menu bar, click “Help” → “Help” in this order.**
    The Help screen will be displayed.

• Displaying the Help using the Dock
  1. **Open “Application” folder in OS X.**
  2. **Click the “PC Control Utility Pro 5” folder.**
  3. **Click the “PC Control Utility Pro 5 Help” icon.**
    The Help screen will be displayed.
Using the Computer Cable (VGA) to Operate the Projector (Virtual Remote Tool)

Using the utility software “Virtual Remote Tool” included on the companion NEC Projector CD-ROM, Virtual Remote screen (or toolbar) can be displayed on your computer screen. This will help you perform operations such as projector’s power on or off and signal selection via the computer cable (VGA), serial cable, or LAN connection. Only via serial connection it is also used to send an image to the projector and register it as the logo data of the projector. After registering it, you can lock the logo to prevent it from changing.

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, audio mute, Logo transfer to the projector, and remote control operation on your PC.

This section provides an outline of preparation for use of Virtual Remote Tool.
For information on how to use Virtual Remote Tool, see Help of Virtual Remote Tool. (→ page 111)

Step 1: Install Virtual Remote Tool on the computer. (→ page 107)
Step 2: Connect the projector to the computer. (→ page 109)
Step 3: Start Virtual Remote Tool. (→ page 110)

TIP:
• Virtual Remote Tool can be used with a LAN and a serial connection. USB connection is not supported by Virtual Remote Tool.
• For update information on Virtual Remote Tool, visit our website:
NOTE:

- When [COMPUTER] is selected from your source selection, the Virtual Remote screen or the toolbar will be displayed as well as your computer screen.
- Use the supplied computer cable (VGA) to connect the COMPUTER IN terminal directly with the monitor output terminal of the computer to use Virtual Remote Tool.

Using a switcher or other cables than the supplied computer cable (VGA) may cause failure in signal communication.

VGA cable terminal:
Pin Nos. 12 and 15 are required for DDC/CI.

- Virtual Remote Tool may not work depending on your computer's specifications and version of graphic adapters or drivers.
- To run Virtual Remote Tool on Windows 8.1 and Windows 8, “Microsoft .NET Framework Version 2.0” is required. The Microsoft .NET Framework Version 2.0, 3.0 or 3.5 is available from Microsoft's web page. Download and install it on your computer.
- Logo data (graphics) that can be sent to the projector with Virtual Remote Tool has the following restrictions:
  (Only via serial connection)
  - File size: Less than 768 KB
  - Image size (resolution):
    P502H/P452H: Horizontal 1920 × vertical 1080 dots or less
    P502W/P452W: Horizontal 1280 × vertical 800 dots or less
- To put the default “NEC logo” back in the background logo, you need to register it as the background logo by using the image file (P502H/P452H: /Logo/NEC_logo2015_1920x1080.bmp, P502W/P452W: /Logo/NEC_logo2015_1280x800.bmp) included on the supplied NEC Projector CD-ROM.

TIP:

- The projector’s COMPUTER IN terminal supports DDC/CI (Display Data Channel Command Interface). DDC/CI is a standard interface for bidirectional communication between display/projector and computer.
- With the Virtual Remote Tool, control is possible with both network (wired/wireless LAN) and serial connections.

**Step 1: Install Virtual Remote Tool on the computer**

NOTE:

- To install Virtual Remote Tool, the Windows user account must have “Administrator” privilege.
- Exit all running programs before installing Virtual Remote Tool. If another program is running, the installation may not be completed.

1. **Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.**

   The menu window will be displayed.

   TIP:
   If the menu window will not be displayed, try the following procedure.
   For Windows 7
   1. Click “start” on Windows.
   2. Click “All Programs” → “Accessories” → “Run”.
   3. Type your CD-ROM drive name (example: “Q:\”) and “LAUNCHER.EXE” in “Name”. (example: Q:\LAUNCHER.EXE)
   4. Click “OK”.

      The menu window will be displayed.
2  **Click “Install Virtual Remote Tool” on the menu window.**

The installation will start.

![Virtual Remote Tool installation window](image)

When the installation is complete, the Welcome window will be displayed.

3  **Click “Next”.**

“END USER LICENSE AGREEMENT” screen will be displayed.

![END USER LICENSE AGREEMENT screen](image)

Read “END USER LICENSE AGREEMENT” carefully.

4  **If you agree, click “I accept the terms in the license agreement” and then click “Next”.**

- Follow the instructions on the installer screens to complete the installation.
- When the installation is complete, you will return to the menu window.
7. User Supportware

TIP:

Uninstalling Virtual Remote Tool
Preparation:
Exit Virtual Remote Tool before uninstalling. To uninstall Virtual Remote Tool, the Windows user account must have “Administrator” privilege (Windows 8.1, Windows 8, Windows 7 and Windows Vista) or “Computer Administrator” privilege (Windows XP).

• For Windows 8.1, Windows 8, Windows 7 and Windows Vista
  1 Click “Start” and then “Control Panel”.
     The Control Panel window will be displayed.
  2 Click “Uninstall a program” under “Programs”
     The “Programs and Features” window will be displayed.
  3 Select Virtual Remote Tool and click it.
  4 Click “Uninstall/Change” or “Uninstall”.
     • When the “User Account Control” window is displayed, click “Continue”.
       Follow the instructions on the screens to complete the uninstallation.

Step 2: Connect the projector to the computer

1 Use the supplied computer cable (VGA) to connect the COMPUTER IN terminal of the projector directly with the monitor output terminal of the computer.

2 Connect the supplied power cord to the AC IN of the projector and the wall outlet.
   The projector is in the standby condition.

TIP:
• When Virtual Remote Tool starts for the first time, “Easy Setup” window will be displayed to navigate your connections.
7. User Supportware

Step 3: Start Virtual Remote Tool

Start using the shortcut icon
•  Double-click the shortcut icon 📲 on the Windows Desktop.

Start from the Start menu
•  Click [Start] → [All Programs] or [Programs] → [NEC Projector User Supportware] → [Virtual Remote Tool] → [Virtual Remote Tool].

When Virtual Remote Tool starts for the first time, “Easy Setup” window will be displayed.

Follow the instructions on the screens

When “Easy Setup” is completed, the Virtual Remote Tool screen will be displayed.

NOTE:
•  When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the computer cable (VGA) or network (wired LAN/wireless LAN) connection.

TIP:
•  The Virtual Remote Tool screen (or Toolbar) can be displayed without displaying “Easy Setup” window. To do so, click to place a check mark for “Do not use Easy Setup next time” on the screen at Step 6 in “Easy Setup”.
Exiting Virtual Remote Tool

1. Click the Virtual Remote Tool icon on the Taskbar.
   The pop-up menu will be displayed.

2. Click “Exit”.
   The Virtual Remote Tool will be closed.

Viewing the help file of Virtual Remote Tool

- Displaying the help file using the taskbar

1. Click the Virtual Remote Tool icon on the taskbar when Virtual Remote Tool is running.
   The pop-up menu will be displayed.

2. Click “Help”.
   The Help screen will be displayed.

- Displaying the help file using the Start Menu.

1. Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “Virtual Remote Tool” → and then “Virtual Remote Tool Help” in this order.
   The Help screen will be displayed.
6 Projecting photos or documents saved on the smartphone over a wireless LAN (Wireless Image Utility)

Utilizing the Wireless Image Utility, it enables to transfer photos and documents saved on terminals as a smartphone or a tablet to the projector via the wireless LAN and project them.

There are two kinds of Wireless Image Utility software one for Android and another for iOS that can be downloaded from Google Play or App Store.

For Android

For iOS
8. Maintenance

This section describes the simple maintenance procedures you should follow to clean the filters, the projection window, the cabinet, and to replace the lamp and the filters.

1 Cleaning the Filters

Filters are fixed at two positions on this projector.

Intake vent filter:
   - At the bottom of control panel.
   - Prevent the projector inside from dust and dirt accumulation.

Color wheel filter:
   - Fixed inside the lamp cover.
   - Prevent the color wheel from dust and dirt accumulation.

In this manual, call the intake vent filter “Filter (A)” and the color wheel filter “Filter (B)”.

If dust and dirt accumulates on the Filter (A), it may cause trouble by overheat. Clean it periodically. Cleaning is not necessary for the Filter (B).

⚠️ WARNING
- Do not use a spray containing flammable gas to get rid of accumulated dust and dirt on the filters. It may cause of fire.

NOTE: The message for filter cleaning will be displayed for one minute after the projector is turned on. When the message is displayed, clean the filter.
   To cancel the message, press any button on the projector cabinet or the remote control.

⚠️ CAUTION
- Before cleaning the filter, turn off the projector and unplug the power cord first. Wait and make sure until the unit has cooled down completely. Removing the filter cover when the unit is running could result in burns.

Turn off the projector and unplug the power cord before cleaning the cabinet or replacing the lamp.
1. Turn off the power supply and pull out the plug from the wall outlet.

2. Pinch the knob at the bottom of the filter case and pull it out.
   - If you put the projector upside down for cleaning as the illustration, please lay a mat as a cloth for protecting the cabinet top from damage.

3. Remove the Filter (A) from the filter case.

4. Vacuum all the dust on the Filter (A) and the filter case.
   - Get rid of dust accumulated on the intake vent on the projector.
   - Make sure to use a brush adaptor on the vacuum cleaner. Never apply the vacuum hose or the hard nozzle directly on the filter and filter case without fixing on a brush adaptor.
   - Pay enough attention not to damage the filter (A).
   - Do not wash the filters with soap and water. Soap and water will damage the filter membrane.
5. Set the cleaned Filter (A) onto the filter case.
   • Set the cut off part of the Filter (A) meeting with the knob part on the filter case.

6. Insert the filter case to the projector cabinet.
   Make sure that the filter case is inserted in the correct orientation.

7. Clear the filter hour meter.
   Connect the power cord plug to the wall outlet and turn on the projector. Select [CLEAR FILTER HOURS] for [RE-SET] in the onscreen menu. (→ page 68)
Cleaning the Lens

- Turn off the projector before cleaning.
- Do not scratch or mar the projection window as it is made of glass.
- Use a blower or lens paper to clean the projection window, and be careful not to scratch or mar the glass surface.
- Never use alcohol or glass lens cleaner as doing so will cause damage to the plastic lens surface.

⚠️ WARNING

- Do not use a spray containing flammable gas to get rid of accumulated dust and dirt on the projection window. It may cause fire.
8. Maintenance

3 Cleaning the Cabinet

Turn off the projector, and unplug the projector before cleaning.

- Use a dry soft cloth to wipe dust off the cabinet.
  If heavily soiled, use a mild detergent.
- Never use strong detergents or solvents such as alcohol or thinner.
- For cleaning the vents or the speaker, use a vacuum cleaner with a brush attachment. Do not apply the vacuum hose or the nozzle adaptor directly onto the vents and speaker.

Vacuum the dust off the vents.

- Clogged vents may cause a rise in the internal temperature of the projector, resulting in malfunction.
- Do not scratch or hit the cabinet with your fingers or any hard objects
- Contact your dealer for cleaning the inside of the projector.

NOTE: Do not apply volatile agent such as insecticide on the cabinet, the projection window, or the screen. Do not leave a rubber or vinyl product in prolonged contact with it. Otherwise the surface finish will be deteriorated or the coating may be stripped off.
Replacing the Lamp and the Filters

When the lamp reaches the end of its life, the LAMP indicator on the cabinet will blink red and the message “THE LAMP HAS REACHED THE END OF ITS USABLE LIFE. PLEASE REPLACE THE LAMP AND FILTER.” will appear (*). Even though the lamp may still be working, replace the lamp to maintain the optimal projector performance. After replacing the lamp, be sure to clear the lamp hour meter. (→ page 68)

⚠️ CAUTION
- DO NOT TOUCH THE LAMP immediately after it has been used. It will be extremely hot. Turn the projector off and then disconnect the power cord. Allow at least one hour for the lamp to cool before handling.

- Use the specified lamp for safety and performance.
  To order the replacement lamp, specify your lamp type.
  Replacement lamp:
  - NP39LP: P502H/P502W
  - NP38LP: P452H/P452W
  The replacement lamp comes with filters. Replace the lamp and the filters (A) (B) at the same time.

- DO NOT REMOVE ANY SCREWS except one lamp cover screw and three lamp housing screws. You could receive an electric shock.

- Do not break the glass on the lamp housing.
  Keep finger prints off the glass surface on the lamp housing. Leaving finger prints on the glass surface might cause an unwanted shadow and poor picture quality.

- The projector will turn off and go into standby mode when you continue to use the projector for another 100 hours after the lamp has reached the end of its life. If this happens, be sure to replace the lamp. If you continue to use the lamp after the lamp reaches the end of its life, the lamp bulb may shatter, and pieces of glass may be scattered in the lamp case. Do not touch them as the pieces of glass may cause injury. If this happens, contact your NEC dealer for lamp replacement.

*NOTE: This message will be displayed under the following conditions:
- for one minute after the projector has been powered on
- when the (POWER) button on the projector cabinet or the STANDBY button on the remote control is pressed

To turn off the message, press any button on the projector cabinet or the remote control.

Optional lamp and tools needed for replacement:
- Phillips screwdriver (plus-head)
- Replacement lamp

Flow of Replacing the Lamp and the Filters

**Step 1.** Replace the lamp and the Filter (B)
**Step 2.** Replace the Filter (A) (→ page 123)
**Step 3.** Clear the lamp usage hours and the filter usage hours (→ page 124)
To replace the lamp and the Filter (B):

1. **Remove the lamp cover.**
   - (1) Loosen the lamp cover screw
     - The lamp cover screw is not removable.
   - (2) Push and slide the lamp cover off.

2. **Pull out the filter case. Pinch the filter case handle and pull it in the arrow indicated direction.**

3. ** Replace the Filter (B).**
   - (1) Pull out the Filter (B) from the filter case.
8. Maintenance

(2) Vacuum off accumulated dust and dirt on inside and outside of the filter case.

(3) Fix a new Filter (B) onto the filter case.

4. Remove the lamp housing.

(1) Loosen the three screws securing the lamp housing until the phillips screwdriver goes into a freewheeling condition.
   • The three screws are not removable.

(2) Remove the lamp housing by holding it.

⚠️ CAUTION:
Make sure that the lamp housing is cool enough to before removing it.
5. Install a new lamp housing.
   (1) Insert a new lamp housing until the lamp housing is plugged into the socket.
   (2) Push the top center of the lamp housing to secure it.
   (3) Secure it in place with the three screws.
   • Be sure to tighten the screws.

6. Insert for resetting the filter case.
7. **Reattach the lamp cover.**
   (1) Slide the lamp cover back until it snaps into place.

   ![Diagram showing reattaching the lamp cover]

   (2) Tighten the screw to secure the lamp cover.
   - Be sure to tighten the screw.

This completes the lamp and Filter (B) replacement.
Go on to the Filter (A) replacement.

**NOTE:** When you continue to use the projector for another 100 hours after the lamp has reached the end of its life, the projector cannot turn on and the menu is not displayed.
If this happens, press the HELP button on the remote control for 10 seconds to reset the lamp clock back to zero.
When the lamp time clock is reset to zero, the LAMP indicator goes out.
To replace the Filter (A):

NOTE:
• Before replacing the filters, wipe off dust and dirt from the projector cabinet.
• The projector is precision equipment. Keep out dust and dirt during filter replacement.
• Do not wash the filters with soap and water. Soap and water will damage the filter membrane.
• Put filters into place. Incorrect attachment of a filter may cause dust and dirt to get into the inside of the projector.

Before replacing the Filter (A), make sure to replace the lamp and Filter (B). (→ page 119)

1. **Pinch the knob at the bottom of the filter case and pull it out.**
   • If you put the projector upside down for replacing the Filter (A) as the illustration, please lay a mat as a cloth for protecting the cabinet top from damage.

2. **Remove the Filter (A) from the filter case.**

3. **Vacuum all the dust on inside and outside of the filter case.**
   • Get rid of dust accumulated on the intake vent on the projector.
4. **Fix a new Filter (A) onto the filter case.**
   - Set the cut off part of the Filter (A) meeting with the knob part on the filter case.

5. **Insert the Filter case to the projector cabinet.**
   - Make sure that the filter case is inserted in the correct orientation.

---

This completes the filter replacement.
Go on to the clearing lamp and filter hour meters.

---

To clear the lamp usage hours and the filter usage hours:

1. **Place the projector where you use it.**
2. **Plug the power cord into the wall outlet, and then turn on the projector.**
3. **Clear the lamp usage hours and the filter usage hours.**
   1. From the menu, select [RESET] → [CLEAR LAMP HOURS] and reset the lamp usage hours.
   2. Select [CLEAR FILTER HOURS] and reset the filter usage hours. (→ page 68)
# Troubleshooting

This section helps you resolve problems you may encounter while setting up or using the projector.

## Indicator Messages

### POWER Indicator

<table>
<thead>
<tr>
<th>Indicator Condition</th>
<th>Projector Condition</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>The main power is off</td>
<td>Without connecting the power cable.</td>
</tr>
<tr>
<td>Blinking light Blue</td>
<td>0.5 sec On, 0.5 sec Off</td>
<td>The projector is getting ready to turn on. Wait for a moment</td>
</tr>
<tr>
<td>Blinking light Orange (short flashes)</td>
<td>Cooling</td>
<td></td>
</tr>
<tr>
<td>Blinking light Orange (long flashes)</td>
<td>On Timer is activated. Program timer (off time) is activated.</td>
<td>Wait for a moment</td>
</tr>
<tr>
<td>Steady light Blue</td>
<td>The projector is turned on.</td>
<td></td>
</tr>
<tr>
<td>Steady light Orange</td>
<td>Sleep mode*</td>
<td>While the STATUS Indicator lights in Green</td>
</tr>
<tr>
<td>Steady light Red</td>
<td>In Standby condition [NORMAL] is selected for [STANDBY MODE]</td>
<td></td>
</tr>
</tbody>
</table>

### STATUS Indicator

<table>
<thead>
<tr>
<th>Indicator Condition</th>
<th>Projector Condition</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Normal or Standby</td>
<td>–</td>
</tr>
<tr>
<td>Blinking light Red</td>
<td>1 cycle (0.5 sec On, 2.5 sec Off)</td>
<td>Cover error</td>
</tr>
<tr>
<td></td>
<td>2 cycle (0.5 sec On, 0.5 sec Off)</td>
<td>Temperature error</td>
</tr>
<tr>
<td></td>
<td>3 cycle (0.5 sec On, 0.5 sec Off)</td>
<td>Power error</td>
</tr>
<tr>
<td></td>
<td>4 cycle (0.5 sec On, 0.5 sec Off)</td>
<td>Fan error</td>
</tr>
<tr>
<td></td>
<td>6 cycle (0.5 sec On, 0.5 sec Off)</td>
<td>Lamp error</td>
</tr>
<tr>
<td>Orange 1 cycle (0.5 sec On, 2.5 sec Off)</td>
<td>Network conflict</td>
<td>Both the built-in wired LAN and the wireless LAN cannot be connected to the same network at the same time. To use both built-in wired LAN and wireless LAN at the same time, connect them to different networks. <em>NOTE: In the Standby condition, the status indicator on the cabinet does not blink in orange even if the network conflicts</em></td>
</tr>
<tr>
<td>Green 0.5 sec On, 0.5 sec Off</td>
<td>Re-firing the lamp (The projector is cooling down)</td>
<td>Wait for a moment</td>
</tr>
</tbody>
</table>

### LAMP Indicator

<table>
<thead>
<tr>
<th>Indicator Condition</th>
<th>Projector Condition</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Normal</td>
<td>–</td>
</tr>
<tr>
<td>Blinking light Red</td>
<td>Lamp has reached its end of life. Lamp replacement message will be displayed.</td>
<td>Replace the lamp.</td>
</tr>
<tr>
<td>Steady light Red</td>
<td>Lamp has been used beyond its limit. The projector will not turn on until the lamp is replaced.</td>
<td>Replace the lamp.</td>
</tr>
<tr>
<td>Green</td>
<td>[ECO MODE] is set to [AUTO ECO], [NORMAL] or [ECO]</td>
<td>–</td>
</tr>
</tbody>
</table>

* The sleep mode refers to the mode in which the restrictions to functions due to the [STANDBY MODE] settings have been eliminated.

125
Over-Temperature Protection

If the projector inside temperature gets too high, the lamp will be turned off automatically and the status indicator will start to blink (2-cycle On and Off). Should this happen, do the following:

• Unplug the power cord after the cooling fans stop.
• Move the projector to a cooler location if the room where you are presenting is particularly too warm.
• Clean the vents if they are clogged with dust.
• Wait about 60 minutes until the inside of the projector becomes cool enough.
## 9. Appendix

### Common Problems & Solutions

(→ “POWER/STATUS/LAMP Indicator” on page 125.)

<table>
<thead>
<tr>
<th>Problem</th>
<th>Check These Items</th>
</tr>
</thead>
</table>
| Does not turn on or shut down | • Check that the power cord is plugged in and that the power button on the projector cabinet or the remote control is on. (→ pages 11, 12)  
• Ensure that the lamp cover is installed correctly. (→ page 121)  
• Check to see if the projector has overheated. If there is insufficient ventilation around the projector or if the room where you are presenting is particularly warm, move the projector to a cooler location.  
• Check to see if you continue to use the projector for another 100 hours after the lamp has reached the end of its life. If so, replace the lamp. After replacing the lamp, reset the lamp hours used. (→ page 68)  
• The lamp may fail to light. Wait a full minute and then turn on the power again.  
• Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 4000 feet/1200 meters or higher. Using the projector at altitudes approximately 4000 feet/1200 meters or higher without setting to [HIGH ALTITUDE] can cause the projector to overheat and the projector could shut down. If this happens, wait a couple minutes and turn on the projector. (→ page 59)
If you turn on the projector immediately after the lamp is turned off, the fans run without displaying an image for some time and then the projector will display the image. Wait for a moment.  
• In case it’s hard to think the trouble is not caused on the above mentioned conditions, unplug the power cord from the outlet. Then wait 5 minutes before plugging it in again. (→ page 24) |
| Will turn off | • Ensure that the [OFF TIMER] or [AUTO POWER OFF] is off. (→ page 52, 62) |
| No picture | • Check if the appropriate input is selected. (→ page 14) If there is still no picture, press the SOURCE button or one of the source buttons again.  
• Ensure your cables are connected properly.  
• Use menus to adjust the brightness and contrast. (→ page 45)  
• Check that the AV MUTE (image off) buttons are not pressed.  
• Reset the settings or adjustments to factory preset levels using the [RESET] in the Menu. (→ page 68)  
• Enter your registered keyword if the Security function is enabled. (→ page 30)  
• If the HDMI 1 IN or the HDMI 2 IN signal cannot be displayed, try the following.  
  - Reinstall your driver for the graphics card built in your computer, or use the updated driver.  
  - For reinstalling or updating your driver, refer to the user guide accompanied with your computer or graphics card, or contact the support center for your computer manufacturer.  
  - Install the updated driver or OS on your own responsibility.  
  - We are not liable for any trouble and failure caused by this installation.  
• Signals may not be supported depending on the HDBaseT transmission device. IR and RS232C cannot be used in certain cases as well.  
• Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on the power to the notebook PC.  
• In most cases the output signal from the notebook PC is not turned on unless connected to the projector before being powered up.  
  * If the screen goes blank while using your remote control, it may be the result of the computer’s screensaver or power management software.  
  • See also the next page. |
| Picture suddenly becomes dark | • Check if the projector is in the Forced ECO mode because of too high ambient temperature. If this is the case, lower the internal temperature of the projector by selecting [HIGH] for [FAN MODE]. (→ page 59) |
| Color tone or hue is unusual | • Check if an appropriate color is selected in [WALL COLOR]. If so, select an appropriate option. (→ page 51)  
• Adjust [HUE] in [PICTURE]. (→ page 45) |
| Image isn’t square to the screen | • Reposition the projector to improve its angle to the screen. (→ page 16)  
• Use the Keystone correction function to correct the trapezoid distortion. (→ page 21) |
| Picture is blurred | • Adjust the focus. (→ page 19)  
• Reposition the projector to improve its angle to the screen. (→ page 16)  
• Ensure that the distance between the projector and screen is within the adjustment range of the lens. (→ page 69)  
• Has the lens been shifted by an amount exceeding the guaranteed range? (→ page 73)  
• Condensation may form on the lens if the projector is cold, brought into a warm place and is then turned on. Should this happen, let the projector stand until there is no condensation on the lens. |
9. Appendix

<table>
<thead>
<tr>
<th>Problem</th>
<th>Check These Items</th>
</tr>
</thead>
</table>
| Image is scrolling vertically, horizontally or both | • Check the computer's resolution and frequency. Make sure that the resolution you are trying to display is supported by the projector. (→ page 136)  
• Adjust the computer image manually with the [HORIZONTAL]/[VERTICAL] in the [IMAGE OPTIONS]. (→ page 47) |
| Remote control does not work | • Install new batteries.(→ page 9)  
• Make sure there are no obstacles between you and the projector.  
• Stand within 22 feet (7 m) of the projector. (→ page 9) |
| Indicator is lit or blinking | • See the POWER/STATUS/LAMP Indicator. (→ page 125) |
| Cross color in RGB mode | • Press the AUTO ADJ. button on the projector cabinet or the remote control. (→ page 23)  
• Adjust the computer image manually with [CLOCK]/[PHASE] in [IMAGE OPTIONS] in the menu. (→ page 46) |

For more information contact your dealer.

**If there is no picture, or the picture is not displayed correctly.**

- Power on process for the projector and the PC.  
Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on the power to the notebook PC.  
In most cases the output signal from the notebook PC is not turned on unless connected to the projector before being powered up.  

NOTE: You can check the horizontal frequency of the current signal in the projector’s menu under Information. If it reads “0kHz”, this means there is no signal being output from the computer. (→ page 67 or go to next step)

- Enabling the computer's external display.  
Displaying an image on the notebook PC's screen does not necessarily mean it outputs a signal to the projector.  
When using a PC compatible laptop, a combination of function keys will enable/disable the external display. Usually, the combination of the “Fn” key along with one of the 12 function keys gets the external display to come on or off. For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through external display selections.  

- Non-standard signal output from the computer  
If the output signal from a notebook PC is not an industry standard, the projected image may not be displayed correctly. Should this happen, deactivate the notebook PC’s LCD screen when the projector display is in use. Each notebook PC has a different way of deactivate/reactivate the local LCD screens as described in the previous step. Refer to your computer’s documentation for detailed information.  

- Image displayed is incorrect when using a Mac  
When using a Mac with the projector, set the DIPswitch of the Mac adapter (not supplied with the projector) according to your resolution. After setting, restart your Mac for the changes to take affect.  
For setting display modes other than those supported by your Mac and the projector, changing the DIP switch on a Mac adapter may bounce an image slightly or may display nothing. Should this happen, set the DIP switch to the 13" fixed mode and then restart your Mac. After that, restore the DIP switches to a displayable mode and then restart the Mac again.  

NOTE: A Video Adapter cable manufactured by Apple Inc. is needed for a MacBook which does not have a mini D-Sub 15-pin terminal.

- Mirroring on a MacBook  
* When using the projector with a MacBook, output may not be set to 1024 x 768 unless “mirroring” is off on your MacBook. Refer to owner's manual supplied with your Mac computer for mirroring.  
- Folders or icons are hidden on the Mac screen  
Folders or icons may not be seen on the screen. Should this happen, select [View] → [Arrange] from the Apple menu and arrange icons.
## Specifications

This section provides technical information about projector's performance.

<table>
<thead>
<tr>
<th>Model name</th>
<th>NP-P502H</th>
<th>NP-P502W</th>
<th>NP-P452H</th>
<th>NP-P452W</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Method</strong></td>
<td>1 Chip DLP type</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Specifications of main parts</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DMD panel</td>
<td>0.65&quot; (aspect ratio: 16:9)</td>
<td>0.65&quot; (aspect ratio: 16:9)</td>
<td>0.65&quot; (aspect ratio: 16:9)</td>
<td>0.65&quot; (aspect ratio: 16:9)</td>
</tr>
<tr>
<td>Pixels (*1)</td>
<td>2,073,600 (1920 dots × 1080 lines)</td>
<td>1,024,000 (1280 dots × 800 lines)</td>
<td>2,073,600 (1920 dots × 1080 lines)</td>
<td>1,024,000 (1280 dots × 800 lines)</td>
</tr>
<tr>
<td><strong>Projection lenses</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F = 2.0, f = 18.2–31.1 mm</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom</td>
<td>Manual (Zoom Ratio = 1.7)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Focus</td>
<td>Manual</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lens shifting</td>
<td>H: ±25%, V: +62%, −0%</td>
<td>H: ±28%, V: +59%, −0%</td>
<td>H: ±25%, V: +62%, −0%</td>
<td>H: ±28%, V: +59%, −0%</td>
</tr>
<tr>
<td><strong>Lamp</strong></td>
<td>375 W AC (299 W in NORMAL) (226 W in ECO)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Optical device</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Light output (*3) (NORMALLY)</td>
<td>5,000 lm (NORMAL: 80%, ECO: 60%)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contrast ratio (*2) (all white/all black)</td>
<td>6,000:1 with lamp control</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen size (throw distance)</td>
<td>30 to 300 inches (0.8–14.2 m)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Projection Angle</td>
<td>From 0 to 15.9 deg at 80°</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Projection Distance (From Projection Lens)</td>
<td>Wide: From 0.8 to 8.2 m, Tele: From 1.4 to 14.2 m</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Color reproducibility</strong></td>
<td>10-bit color processing (approx. 1.07 billion colors)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Scanning frequency</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Horizontal</td>
<td>Analog: 15 kHz, 24 to 100 kHz (24 kHz or greater for RGB inputs), conforming to VESA standards</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vertical</td>
<td>Digital: 15 kHz, 24 to 153 kHz, conforming to VESA standards</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Main adjustment functions</strong></td>
<td>Manual zoom, manual focus, manual lens shift. input signal switching (HDMI1/HDMI2/ COMPUTER/VIDEO/HDBaseT), auto image adjustment, picture magnification, muting (video), power on/standby, on-screen display/selection, etc.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Max. display resolution (horizontal × vertical)</strong></td>
<td>Analog: 1920 × 1200 (handled with Advanced AccuBlend) Digital: 1920 × 1080 (handled with Advanced AccuBlend)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Input signals</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>R, G, B, H, V</td>
<td>RGB: 0.7 Vp-p/75 Ω Y: 1.0 Vp-p/75 Ω (with Negative Polarity Sync) Cb, Cr (Pr, Pr): 0.7 Vp-p/75 Ω H/V Sync: 4.0 Vp-p/TTL Composite Sync: 4.0 Vp-p/TTL Sync on G: 1.0 Vp-p/75 Ω (with Sync)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Composite video</td>
<td>1.0 Vp-p/75 Ω (with Sync)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Component</td>
<td>Y: 1.0 Vp-p/75 Ω (with Sync)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DTV</td>
<td>480i, 480p, 720p, 1080i, 1080p (60 Hz) 576i, 576p, 720p, 1080i, 1080p (50 Hz)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DVD</td>
<td>Progressive signal (50/60 Hz)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Audio</strong></td>
<td>Stereo L/R: 0.5 Vrms/22 kΩ or over</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Input/output terminals</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computer/Component</td>
<td>Video input</td>
<td>Mini D-Sub 15-pin x 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video output</td>
<td>Mini D-Sub 15-pin x 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Audio input</td>
<td>RCA x 2 (For Video), Stereo mini Jack (For Computer)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Audio output</td>
<td>Stereo mini Jack (Selected from: Computer/Video/HDMI)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>HDMI</strong></td>
<td>Video input</td>
<td>HDMI® Terminal type A x 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deep Color (color depth): 8-/10-/12-bit compatible Colorimetry: RGB, YCbCr444 and YcbCr422 compatible LipSync compatible, HDCP compatible (*4), Supports 3D</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Audio input</td>
<td>HDMI: Sampling frequency – 32/44.1/48 kHz, Sampling bits – 16/20/24 bits</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
9. Appendix

<table>
<thead>
<tr>
<th>Model name</th>
<th>NP-P502H</th>
<th>NP-P502W</th>
<th>NP-P452H</th>
<th>NP-P452W</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDBaseT</td>
<td>Video input</td>
<td>Deep Color (color depth): Support 8/10/12 bits</td>
<td>Colorimetry: Support RGB, YCbCr444 and YCbCr422</td>
<td>Support LipSync, HDCP (*4), 3D</td>
</tr>
<tr>
<td>Audio input</td>
<td>Sampling frequency: 32/44.1/48 kHz</td>
<td>Sampling bit: 16/20/24 bit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Remote terminal</td>
<td>Stereo mini Jack x 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>USB port</td>
<td>Type A</td>
<td>1 for USB memory</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type B</td>
<td>1 for service</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ethernet/HDBaseT port</td>
<td>RJ-45 x 1, Supports BASE-TX</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3D SYNC output terminal</td>
<td>5 V / 10 mA, synchronized signal output for 3D use</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Control Terminals**
- RS-232C terminal (PC control) D-Sub 9-pin x 1
- Built-in Speaker 20 W (monaural)
- **Usage environment**
  - Operating temperature: 5 to 40°C (*5)
  - Operating humidity: 20 to 80% (with no condensation)
  - Storage temperature: -10 to 50°C (*5)
  - Storage humidity: 20 to 80% (with no condensation)
  - Operating altitude: 0 to 8000 feet/2400 meters
  - (Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approxi-
   mately 4000 feet/1200 meters or higher.)

**Power supply**
- 100–240 V AC, 50/60 Hz
- **Power consumption**
  - ECO MODE OFF 465 W (100-130 V) 445 W (200-240 V) 426 W (100-130 V) 416 W (200-240 V)
  - NORMAL 379 W (100-130 V) 366 W (200-240 V) 346 W (100-130 V) 340 W (200-240 V)
  - ECO 311 W (100-130 V) 305 W (200-240 V) 288 W (100-130 V) 286 W (200-240 V)
  - STANDBY MODE NETWORK 0.26 W (100-130 V)/0.33 W (200-240 V)

**Rated input current**
- 2.2 A (240 V AC) to 5.4 A (100 V AC) 2.0 A (240 V AC) to 4.9 A (100 V AC)

**External dimensions**
- 14.3" (width) × 5.1" (height) × 11.9" (depth)/
  - 362 (width) × 129 (height) × 302 (depth) mm (not including protrusions)
  - 14.3" (width) × 5.5" (height) × 12.1" (depth)/
  - 362 (width) × 139 (height) × 306 (depth) mm (including protrusions)

**Weight**
- 11.46 lbs (5.2 kg)

*1 Effective pixels are more than 99.99%.
*2 Compliance with ISO21118-2012
*3 This is the light output value (lumens) when the [PRESET] mode is set to [HIGH-BRIGHT]. If any other mode is selected as the [PRESET] mode, the light output value may drop slightly.
*4 HDMI® (Deep Color, Lip Sync) with HDCP
HDCP is an acronym for High-bandwidth Digital Content Protection. High bandwidth Digital Content Protection (HDCP) is a system for preventing illegal copying of video data sent over a High-Definition Multimedia Interface (HDMI).
If you are unable to view material via the HDMI input, this does not necessarily mean the projector is not functioning properly. With the implementation of HDCP, there may be cases in which certain content is protected with HDCP and might not be displayed due to the decision/intention of the HDCP community (Digital Content Protection, LLC).
Video: Deep Color; 8/10/12-bit, LipSync
Audio: LPCM; up to 2 ch, sample rate 32/44.1/48 KHz, sample bit; 16/20/24-bit
*5 35 to 40°C – “Forced eco mode”
• These specifications and the product’s design are subject to change without notice.

For additional information visit:
US: http://www.necdisplay.com/
Europe: http://www.nec-display-solutions.com/
For information on our optional accessories, visit our website or see our brochure.

The specifications are subject to change without notice.
3 Cabinet Dimensions

Unit: mm (inch)
Attaching the Optional Cable Cover (NP09CV)

After finishing connections, attach the supplied cable cover to properly hide the cables.

⚠️ CAUTION:
- Be sure to tighten the screws after attaching the cable cover. Failure to do so may cause the cable cover to come off and fall, resulting in injury or damage to the cable cover.
- Do not put bundled cables in the cable cover. Doing so may damage the power cord, resulting in a fire.
- Do not hold the cable cover while moving the projector or do not apply excessive force to the cable cover. Doing so may damage the cable cover, resulting in injury.

Attaching the cable cover

Tool needed:
- Phillips screwdriver (plus-head) about 12 cm/4.7 inches in length

1. **Align the left and right fixing screw holes on the cable cover and the projector, and then put screws to each hole.**

   NOTE:
   - Be careful not to get cables caught in between the cable cover and the projector.

2. **Tighten the cable cover screws.**
   - Be sure to tighten the screws.
Removing the cable cover

1. Loosen the cable cover screws until the Phillips screw-driver goes into a freewheeling condition and remove the cover.
   • When suspended from the ceiling, hold so that the cable cover does not drop.
   • The screws cannot be removed.
9. Appendix

5 Pin assignments and signal names of main terminals

COMPUTER IN Terminal (Mini D-Sub 15 Pin)

Connection and signal level of each pin

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>RGB Signal (Analog)</th>
<th>YCbCr Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Red</td>
<td>Cr</td>
</tr>
<tr>
<td>2</td>
<td>Green or Sync on Green</td>
<td>Y</td>
</tr>
<tr>
<td>3</td>
<td>Blue</td>
<td>Cb</td>
</tr>
<tr>
<td>4</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Red Ground</td>
<td>Cr Ground</td>
</tr>
<tr>
<td>7</td>
<td>Green Ground</td>
<td>Y Ground</td>
</tr>
<tr>
<td>8</td>
<td>Blue Ground</td>
<td>Cb Ground</td>
</tr>
<tr>
<td>9</td>
<td>Hot Plug</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Sync Signal Ground</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>No Connection</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Bi-directional DATA (SDA)</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Horizontal Sync or Composite Sync</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Vertical Sync</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Data Clock</td>
<td></td>
</tr>
</tbody>
</table>

Signal Level
Video signal: 0.7Vp-p (Analog)
Sync signal: TTL level

HDMI 1 IN/HDMI 2 IN Terminal (Type A)

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TMDS Data 2+</td>
<td>11</td>
<td>TMDS Clock Shield</td>
</tr>
<tr>
<td>2</td>
<td>TMDS Data 2 Shield</td>
<td>12</td>
<td>TMDS Clock−</td>
</tr>
<tr>
<td>3</td>
<td>TMDS Data 2−</td>
<td>13</td>
<td>CEC</td>
</tr>
<tr>
<td>4</td>
<td>TMDS Data 1+</td>
<td>14</td>
<td>Disconnection</td>
</tr>
<tr>
<td>5</td>
<td>TMDS Data 1 Shield</td>
<td>15</td>
<td>SCL</td>
</tr>
<tr>
<td>6</td>
<td>TMDS Data 1−</td>
<td>16</td>
<td>SDA</td>
</tr>
<tr>
<td>7</td>
<td>TMDS Data 0+</td>
<td>17</td>
<td>DDC/CEC grounding</td>
</tr>
<tr>
<td>8</td>
<td>TMDS Data 0 Shield</td>
<td>18</td>
<td>+5 V power supply</td>
</tr>
<tr>
<td>9</td>
<td>TMDS Data 0−</td>
<td>19</td>
<td>Hot plug detection</td>
</tr>
<tr>
<td>10</td>
<td>TMDS Clock +</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Ethernet/HDBaseT/LAN Port (RJ-45)

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TxD+/HDBT0+</td>
</tr>
<tr>
<td>2</td>
<td>TxD−/HDBT0−</td>
</tr>
<tr>
<td>3</td>
<td>RxD+/HDBT1+</td>
</tr>
<tr>
<td>4</td>
<td>Disconnection/HDBT2+</td>
</tr>
<tr>
<td>5</td>
<td>Disconnection/HDBT2−</td>
</tr>
<tr>
<td>6</td>
<td>RxD−/HDBT1−</td>
</tr>
<tr>
<td>7</td>
<td>Disconnection/HDBT3+</td>
</tr>
<tr>
<td>8</td>
<td>Disconnection/HDBT3−</td>
</tr>
</tbody>
</table>

USB Port (Type A)

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>VBUS</td>
</tr>
<tr>
<td>2</td>
<td>D−</td>
</tr>
<tr>
<td>3</td>
<td>D+</td>
</tr>
<tr>
<td>4</td>
<td>Grounding</td>
</tr>
</tbody>
</table>

PC CONTROL Port (D-Sub 9 Pin)

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Unused</td>
</tr>
<tr>
<td>2</td>
<td>RxD  reception data</td>
</tr>
<tr>
<td>3</td>
<td>TxD  transmission data</td>
</tr>
<tr>
<td>4</td>
<td>Unused</td>
</tr>
<tr>
<td>5</td>
<td>Grounding</td>
</tr>
<tr>
<td>6</td>
<td>Unused</td>
</tr>
<tr>
<td>7</td>
<td>RTS  transmission request</td>
</tr>
<tr>
<td>8</td>
<td>CTS  transmission allowed</td>
</tr>
<tr>
<td>9</td>
<td>Unused</td>
</tr>
</tbody>
</table>

Communications protocol
# 6 Compatible Input Signal List

## Analog RGB

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640 x 480</td>
<td>4:3</td>
<td>60/72/75/85/iMac</td>
</tr>
<tr>
<td>SVGA</td>
<td>800 x 600</td>
<td>4:3</td>
<td>56/60/72/75/85/iMac</td>
</tr>
<tr>
<td>XGA</td>
<td>1024 x 768</td>
<td>4:3</td>
<td>60/70/75/85/iMac</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 x 768 **</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1280 x 800 **</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1360 x 768 **</td>
<td>16:9 **</td>
<td>60</td>
</tr>
<tr>
<td>Quad-VGA</td>
<td>1280 x 960</td>
<td>4:3</td>
<td>60/75</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280 x 1024</td>
<td>5:4</td>
<td>60/75</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400 x 1050</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1440 x 900</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td>WXGA++</td>
<td>1600 x 900 **</td>
<td>16:9 **</td>
<td>60</td>
</tr>
<tr>
<td>UXGA</td>
<td>1600 x 1200 **</td>
<td>16:9 **</td>
<td>60</td>
</tr>
<tr>
<td>WSXGA+</td>
<td>1680 x 1050</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td>HD</td>
<td>1280 x 720</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>Full HD</td>
<td>1920 x 1080 **</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>WUXGA</td>
<td>1920 x 1200 **</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>MAC 19*</td>
<td>1024 x 768</td>
<td>4:3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 21*</td>
<td>1152 x 870</td>
<td>4:3 **</td>
<td>75</td>
</tr>
<tr>
<td>MAC 23*</td>
<td>1280 x 1024</td>
<td>5:4</td>
<td>65</td>
</tr>
</tbody>
</table>

## Component

<table>
<thead>
<tr>
<th>Signal</th>
<th>Format</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDTV (1080p)</td>
<td>1920 x 1080</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV (1080i)</td>
<td>1920 x 1080</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV (720p)</td>
<td>1280 x 720</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>SDTV (480p)</td>
<td>720 x 480</td>
<td>4:3/16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV (576p)</td>
<td>720 x 576</td>
<td>4:3/16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV (480i)</td>
<td>720 x 480</td>
<td>4:3/16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV (576i)</td>
<td>720 x 576</td>
<td>4:3/16:9</td>
<td>50</td>
</tr>
</tbody>
</table>

## Composite Video

<table>
<thead>
<tr>
<th>Signal</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>PAL</td>
<td>4:3</td>
<td>50</td>
</tr>
<tr>
<td>PAL60</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>SECAM</td>
<td>4:3</td>
<td>50</td>
</tr>
</tbody>
</table>

*1 Native resolution on 1080p model (NP-P502H/NP-P452H)
*2 Native resolution on WXGA model (NP-P502W/NP-P452W)
*3 The projector may fail to display these signals correctly when [AUTO] is selected for [ASPECT RATIO] in the on-screen menu. The factory default is [AUTO] for [ASPECT RATIO]. To display these signals, select [16:9] for [ASPECT RATIO].

## HDMI

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640 x 480</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>SVGA</td>
<td>800 x 600</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>XGA</td>
<td>1024 x 768</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 x 768 **</td>
<td>15:9</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1280 x 800 **</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td>Quad-VGA</td>
<td>1280 x 960</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280 x 1024</td>
<td>5:4</td>
<td>60</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400 x 1050</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1440 x 900</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td>WXGA++</td>
<td>1600 x 900 **</td>
<td>16:9 **</td>
<td>60</td>
</tr>
<tr>
<td>WSXGA+</td>
<td>1680 x 1050</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td>HD</td>
<td>1280 x 720</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>Full HD</td>
<td>1920 x 1080 **</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>WUXGA</td>
<td>1920 x 1200 **</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>MAC 19*</td>
<td>1024 x 768</td>
<td>4:3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 21*</td>
<td>1152 x 870</td>
<td>4:3 **</td>
<td>75</td>
</tr>
<tr>
<td>MAC 23*</td>
<td>1280 x 1024</td>
<td>5:4</td>
<td>65</td>
</tr>
</tbody>
</table>

## 3D

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
</table>
| For PC Signal
| XGA    | 1024 x 768       | 4:3          | 60/120*6 |
| HD     | 1280 x 720       | 16:9         | 60/120*6 |
| WXGA   | 1280 x 800       | 16:10        | 60/120*6 |
| HDTV (1080p) | 1920 x 1080 | 16:9 | 60 |
| For Video Signal
| SDTV (480i) | 720 x 480 | 4:3/16:9 | 60 |

## HDMI 3D

<table>
<thead>
<tr>
<th>Structure: Frame Packing</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080p</td>
</tr>
<tr>
<td>720p</td>
</tr>
<tr>
<td>Structure: Side by Side (Half)</td>
</tr>
<tr>
<td>1080i</td>
</tr>
<tr>
<td>Structure: Top and Bottom</td>
</tr>
<tr>
<td>1080p</td>
</tr>
<tr>
<td>720p</td>
</tr>
</tbody>
</table>

*4 WXGA MODE: OFF
*5 WXGA MODE: ON
*6 120Hz signals are supported for Frame Sequential only.

---

**NOTE:**
- An image with higher or lower resolution than the projector’s native resolution (1280 x 800) will be displayed with Advanced AccuBlend.
- Sync on Green and Composite sync signals are not supported.
- Signals other than those specified in the table above may not be displayed correctly. If this should happen, change the refresh rate or resolution on your PC. Refer to Display Properties help section of your PC for procedures.
### 9. Appendix

#### 7 PC Control Codes and Cable Connection

**PC Control Codes**

<table>
<thead>
<tr>
<th>Function</th>
<th>Code Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>POWER ON</td>
<td>02H 00H 00H 00H 00H 02H</td>
</tr>
<tr>
<td>POWER OFF</td>
<td>02H 01H 00H 00H 00H 03H</td>
</tr>
<tr>
<td>INPUT SELECT COMPUTER</td>
<td>02H 03H 00H 00H 02H 01H 01H 09H</td>
</tr>
<tr>
<td>INPUT SELECT HDMI1</td>
<td>02H 03H 00H 00H 02H 01H 1AH 22H</td>
</tr>
<tr>
<td>INPUT SELECT HDMI2</td>
<td>02H 03H 00H 00H 02H 01H 18H 23H</td>
</tr>
<tr>
<td>INPUT SELECT VIDEO</td>
<td>02H 03H 00H 00H 02H 01H 06H 0EH</td>
</tr>
<tr>
<td>INPUT SELECT APPS</td>
<td>02H 03H 00H 00H 02H 01H 23H 28H</td>
</tr>
<tr>
<td>INPUT SELECT HDBaseT</td>
<td>02H 03H 00H 00H 02H 01H BFH C7H</td>
</tr>
<tr>
<td>PICTURE MUTE ON</td>
<td>02H 03H 00H 00H 00H 00H 12H</td>
</tr>
<tr>
<td>PICTURE MUTE OFF</td>
<td>02H 11H 00H 00H 00H 13H</td>
</tr>
<tr>
<td>SOUND MUTE ON</td>
<td>02H 10H 00H 00H 00H 14H</td>
</tr>
<tr>
<td>SOUND MUTE OFF</td>
<td>02H 13H 00H 00H 00H 15H</td>
</tr>
</tbody>
</table>

*NOTE: Contact your local dealer for a full list of the PC Control Codes if needed.*

### Cable Connection

**Communication Protocol**
- Baud rate: 38400 bps
- Data length: 8 bits
- Parity: No parity
- Stop bit: One bit
- X on/off: None
- Communications procedure: Full duplex

*NOTE: Depending on the equipment, a lower baud rate may be recommended for long cable runs.*

#### PC Control Terminal (D-SUB 9P)

- To TxD of PC
- To RxD of PC
- To GND of PC
- To RTS of PC
- To CTS of PC

*NOTE 1: Pins 1, 4, 6 and 9 are no used.*

*NOTE 2: Jumper “Request to Send” and “Clear to Send” together on both ends of the cable to simplify cable connection.*

*NOTE 3: For long cable runs it is recommended to set communication speed within projector menus to 9600 bps.*
Update the Software

Using the web browser on a computer, download the updated software for the projector from our web site and install it on the projector by the wired LAN connection.

NOTE:

• The exclusive web browser enables to update the software is Internet Explorer 11.
• Before performing the software update, make sure to connect your computer with the projector by the LAN cable. It does not support the wireless LAN connection.
• Make sure to set [NETWORK STANDBY] as the standby mode of the projector. Factory default setting for the standby mode is [NORMAL] (→ page 61)
• The software update is enabled only when the projector is in standby condition. While performing the software update, do not power on the projector. At the same time, do not shut down the AC power.
• Never update the browser page during the software update. It disables the computer for displaying the web page correctly.

1. Access to the software download support page in our web site.

2. Check if the software installed on the projector in use is updated.
   • You can check the software version from either [VERSION(1)] or [VERSION(2)] in the onscreen menu [INFORMATION].

3. If newer software version than one on the projector in use is uploaded on our website, download and save it in an appropriate folder on your computer.

4. Turn off the power of the projector and set it in the standby condition.
   Important:
   • Software update cannot be performed when the standby mode is set at NORMAL.

5. Connect the projector with your computer by the LAN cable.

6. Start up the web browser on your computer and then input the following web address:
   URL (for the software update): http://<Projector IP address>/update.html
   The software update screen will be displayed on.

7. Click [Browse….] at the center of the screen and select the software you saved in the procedure 3.
   • Check the file name indicated on the UPDATE FILE list.

8. Click [START UPDATING] at the center of the screen.
   The screen display will change and your computer starts to update the software.
9. Appendix

NOTE:
• During the software update, pay attention to the follows:
  - Do not turn off the AC Power for the projector.
  - Do not reload or move the web page.
  - Do not close the web page.

• When software update is completed properly, the below will be displayed on:
  1. UPLOADING THE UPDATE FILE: COMPLETED
  2. CHECKING THE UPDATE FILE: COMPLETED
  3. WRITING IN THE UPDATE FILE: COMPLETED
  4. COMPLETE UPDATING: PLEASE REBOOT.

9. Click [REBOOT] at the right bottom of the screen.
   The software update is completed and the projector will go into the standby mode.

NOTE:
• If an error occurs during the software update, an error code in below will be displayed in the “UPDATING STATUS” column.
  2001: Failed to upload the file.
  2007: The uploaded file is too large.
  2011: The uploaded file is broken.
  2012: The uploaded file is broken.
  4001: Received no signal of the HTTP transmission.
   The error codes other than above may be displayed.
   If an error is found during the software update, turn on the projector and update the file again.
   When the software update is not completed properly even if you tried to update several times, please consult your dealer.
### 9 Troubleshooting Check List

Before contacting your dealer or service personnel, check the following list to be sure repairs are needed also by referring to the “Troubleshooting” section in your user’s manual. This checklist below will help us solve your problem more efficiently.

* Print this page and the next page for your check.

#### Frequency of occurrence  □ always  □ sometimes  (How often?__________)  □ other (__________)

#### Power

- No power (POWER indicator does not light blue). See also “Status Indicator (STATUS)”.
- Power cord’s plug is fully inserted into the wall outlet.
- Lamp cover is installed correctly.
- Lamp Hours Used (lamp operation hours) was cleared after lamp replacement.
- No power even though you press and hold the POWER button.
- Shut down during operation.
- Power cord’s plug is fully inserted into the wall outlet.
- Lamp cover is installed correctly.
- [AUTO POWER OFF] is turned off (only models with the [AUTO POWER OFF] function).
- [OFF TIMER] is turned off (only models with the [OFF TIMER] function).

#### Video and Audio

- No image is displayed from your PC or video equipment to the projector.
- Still no image even though you connect the projector to the PC first, then start the PC.
- Enabling your notebook PC’s signal output to the projector.
  - A combination of function keys will enable/disable the external display. Usually, the combination of the “Fn” key along with one of the 12 function keys turns the external display on or off.
- No image (blue or black background, no display).
- Still no image even though you press the AUTO ADJUST button.
- Still no image even though you carry out [RESET] in the projector’s menu.
- Signal cable’s plug is fully inserted into the input terminal.
- A message appears on the screen.
  - The source connected to the projector is active and available.
- Still no image even though you adjust the brightness and/or the contrast.
- Input source’s resolution and frequency are supported by the projector.
- Image is too dark.
- Remains unchanged even though you adjust the brightness and/or the contrast.
- Image distorted.
- Image appears to be trapezoidal (unchanged even though you carry out the [KEYSTONE] adjustment).
- Parts of the image are lost.
- Still unchanged even though you press the AUTO ADJUST button.
- Still unchanged even though you carry out [RESET] in the projector’s menu.
- Image is shifted in the vertical or horizontal direction.
- Horizontal and vertical positions are correctly adjusted on a computer signal.
- Input source’s resolution and frequency are supported by the projector.
- Some pixels are lost.
- Image is flickering.
- Still unchanged even though you press the AUTO ADJUST button.
- Still unchanged even though you carry out [RESET] in the projector’s menu.
- Image shows flickering or color drift on a computer signal.
- Still unchanged even though you change [FAN MODE] from [HIGH] to [AUTO].
- Image appears blurry or out of focus.
- Still unchanged even though you checked the signal’s resolution on PC and changed it to projector’s native resolution.
- Still unchanged even though you adjusted the focus.
- No sound.
- Audio cable is correctly connected to the audio input of the projector.
- Still unchanged even though you adjusted the volume level.
- AUDIO OUT is connected to your audio equipment (only models with the AUDIO OUT terminal).

#### Other

- Remote control does not work.
  - No obstacles between the sensor of the projector and the remote control.
  - Projector is placed near a fluorescent light that can disturb the infrared remote controls.
  - ID for the projector and for the remote are same.
- Buttons on the projector cabinet do not work (only models with the [CONTROL PANEL LOCK] function).
  - [CONTROL PANEL LOCK] is not turned on or is disabled in the menu.
  - Still unchanged even though you press and hold the SOURCE button for a minimum of 10 seconds.
In the space below please describe your problem in detail.

Information on application and environment where your projector is used

**Projector**
- Model number:
- Serial No.:
- Date of purchase:
- Lamp operating time (hours):
- **ECO MODE:** □ OFF □ AUTO ECO □ NORMAL □ ECO

**Information on input signal:**
- Horizontal synch frequency [ ] kHz
- Vertical synch frequency [ ] Hz
- Synch polarity H □ (+) □ (−) V □ (+) □ (−)
- Synch type □ Separate □ Composite □ Sync on Green

**STATUS Indicator:**
- Steady light □ Orange □ Green
- Flashing light [ ] cycles
- Remote control model number:

**Installation environment**
- Screen size: inch
- **Screen type:** □ White matte □ Beads □ Polarization □ Wide angle □ High contrast
- Throw distance: feet/inch/m
- Orientation: □ Ceiling mount □ Desktop
- **Power outlet connection:**
  - □ Connected directly to wall outlet
  - □ Connected to power cord extender or other (the number of connected equipment______________)
  - □ Connected to a power cord reel or other (the number of connected equipment______________)

**Computer**
- Manufacturer:
- Model number:
- Notebook PC □ / Desktop □
- Native resolution:
- Refresh rate:
- Video adapter:
- Other:

**Video equipment**
- VCR, DVD player, Video camera, Video game or other
- Manufacturer:
- Model number:

**Signal cable**
- NEC standard or other manufacturer’s cable?
  - Model number: Length: inch/m
- **Distribution amplifier**
  - Model number:
- **Switcher**
  - Model number:
- **Adapter**
  - Model number:
REGISTER YOUR PROJECTOR! (for residents in the United States, Canada, and Mexico)

Please take time to register your new projector. This will activate your limited parts and labor warranty and InstaCare service program. Visit our web site at www.necdisplay.com, click on support center/register product and submit your completed form online. Upon receipt, we will send a confirmation letter with all the details you will need to take advantage of fast, reliable warranty and service programs from the industry leader, NEC Display Solutions of America, Inc.